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1.1 Overview: Please read this first!

Congratulations on your purchase of the ECOTEL®! It is a
powerful device with a wide array of functions for use in many
different applications. It can be configured to suit the particular
behavior of most PBXs.

Safety instructions
You must read the safety instructions prior to using this device.
== 1.2 Safety instructions

A common manual for several device types

This manual describes how to operate the ECOTEL® VolP,
ECOTEL® ISDN2-1, and ECOTEL® ISDN2-2 devices.

In this text, we use the term ECOTEL® when we are talking about
all device types. When there are variations between the devices,
this is specified in the text, particularly if certain functions are
available only in one of the device types.

Quick Start

If you just want to quickly configure your ECOTEL®volP in order to
make calls between GSM and VolP, use our Quick Start guide. In
case of a default installation, you will find it here:

—=» C:\Program Files\VierlinglECOTEL Service Gear\Documents\VoIP\EN
\ECOTEL VolIP Quickstart EN.pdf

Installation guideline

Our detailed installation guideline will walk you through all of the
steps from installing and setting up the device to making your first
conversations.

-2 2.2 Installation guideline

We wish you much success with the ECOTEL®!
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1.2 Safety instructions

This device was tested in conformity with EN 60950-1:2001 VDE
0805 Part 1: 2003 “Information technology equipment - Safety”
and left our plant in perfect working order.

In order to maintain the device in good condition and to ensure
safe operation, the user must observe the information and
warnings that are contained in these operating instructions.

Only trained technicians working in the field of electronics may
install ECOTEL®.

Any maintenance and repair of the device when it has been
opened must be performed by a trained specialist.

Transport

As protection against jolts and impact, this device should be
transported in its original packing only.

Condensation can occur if the device is brought from a cold
environment into the room where it is to be operated. The device
must be absolutely dry prior to being operated. Accordingly, an
acclimatization period of at least two hours is required.

Setup
Protect this device from direct sunlight and heat.

The device may only be connected to the AC line by means of the
AC power adapter that was supplied or using an original
replacement unit.

Because the plug-in power unit also serves to provide isolation
from the AC line, install the terminal device so that the power
outlet will be close at hand and easily accessible.
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Connecting cables

Lay all cables in a manner that is not hazardous to pedestrian
traffic. The power cord must be unplugged from the AC line socket
in order to completely disconnect the equipment (e.g. in
emergencies).

Cables should not be connected or disconnected during
thunderstorms!

1/0 interface

For safety reasons, the 1/O interface may be connected only with
a floating contact.

Antenna input

The antenna must be protected against destruction due to
lightning. The base of the antenna must be grounded.

Damage
For safety reasons, if the device

— exhibits visible damage

— or has been exposed to moisture,

then further operation should be discontinued! In this case, please
ensure that the device is disabled so it cannot be used by anyone
else.

Ambient conditions

The device may be used only if the specified ambient conditions
are met.

-2 10.4 Specifications

Ensure that all device openings are protected from all foreign
matte, such as dust, dirt and liquids.
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Repairs

Repairs must be performed only by qualified personnel. Only use
replacement parts that comply with device safety standards.

Always unplug the AC line connector before opening the device!

Upgrades

Only install system upgrades that are specifically intended for this
device. Installing other upgrades can damage the system or
violate safety standards and radio interference regulations.

Cleaning

Before cleaning, pull the power supply plug. The housing interior
may only be cleaned by an authorized technician.

Do not use scouring powder or solvents harmful to plastics.

Do not allow liquids to penetrate into the interior of the device. A
dry cloth suffices for cleaning the housing surface. A cloth dipped
in water containing a mild detergent and then wrung out well can
be used for heavier stains.

Electromagnetic compatibility

The device fulfills the EU Directive 89/336/EEC "Electromagnetic
compatibility" and the requirements of the Low Voltage Directive
73/23/EEC.

The CE mark appears on the name plate.
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2 Getting started
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2.1 Overview: Getting ECOTEL up and running

This section is intended to help you put ECOTEL® into operation
quickly and reliably.

Due to the variety of possible functions, you will have to make a
number of decisions and settings in order to precisely configure
ECOTEL® to suit your needs. Our installation guideline should
provide the necessary orientation.
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2.2 Installation guideline

The following is a step-by-step description of the entire installation
process.

VA Y Important: If you have an ECOTEL®Ispn2-2 or
Y4 ' Y ECOTEL”IsDN2-14x, please read this section first:
4 = % == 9.6 Peculiarities of ECOTEL ISDN2-2 and other

models with a dual design

2.2.1 Determining the connection type

»  Select the ISDN connection type
(if you wish to use ISDN interfaces).
Please read:
-2 3.2 ISDN interface: Selecting the ISDN connection

type

»  Keep the configuration information and routing entries
found there handy for the later steps in this process.

»  Select the VoIP connection type
(if you wish to use the VolIP interface).
Please read:
-2 3.3 VoIP interface: Sample applications

»  Keep the configuration information and routing entries
found there handy for the later steps in this process.

Consult with the administrator for your PBX to choose the best
operating mode for your particular application. Then, the
connections from ECOTEL® to the PBX can be prepared
accordingly.

The configuration process for the software is also dependent on
the operating mode which is selected.
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2.2.2 Preparing for installation

» Make sure that you received the full content of the
package.
== 10.2 Package contents

» Obtain the necessary accessories (see below).

» Set up the antenna(s) at a location where reception is
adequate (maybe provisional, for the time being).

an Warning: Do not yet insert any SIM cards into the device!

P B
J;:f’ ' % Reason: When it is powered on, ECOTEL® will immediately
L ® 5 aftempt to log in to the network using the SIM card. Since
ECOTEL? does not yet have the valid SIM PIN, this will
fail. After two failed attempts, ECOTEL? will block any
further attempts.

You will need the following accessories (not included) to put the
device into operation:

—  SIMcard(s)
—  SIM cardholder (not for ECOTEL®isbnz-1)

— GSM antenna(s) (GSM900/1800/1900 depending on the
intended application; antennas are included with
ECOTEL®isbne-2 and ECOTEL®vorp)

—  PC (Windows 98 or higher) for configuring ECOTEL®

— RJ-45 network cable (for VolP functions or for configuration
via IP)

The following rule of thumb should work for the antenna site: If
you are able to make calls using a mobile phone and a SIM card
from the same provider, then the antenna reception will probably
be adequate.
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2.2.3 Connecting the device

» Connect the ISDN lines to ECOTEL®.
Use the jacks required by the selected ISDN connection

type.
== 3.2 ISDN interface: Selecting the ISDN connection

type

» Connect the remaining lines to ECOTEL® (if required):
Antenna(s), Ethernet (LAN), USB, serial cable.

» Connect the power supply.

l@ Note: The guarantee for ECOTEL? is nullified if you use a
power supply which is not approved by VIERLING.

The LEDs on the housing provide information about the device
and interface status.

== 9.1 Display elements on the housing
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2.2.4 Setting up the USB interface

l@g Note: These steps are necessary only if you wish to use

the USB interface to configure ECOTEL".
ECOTEL®IspN2-1 does not have a USB interface.

From the viewpoint of the configuration computer, ECOTEL® is
not connected to the USB interface as a USB device. Instead, a
COM interface is emulated which is used for access to ECOTEL®.

You will have to install a special driver.

Proceed as follows:

»

»

»

»

»

»

»

»

»

»

»

Connect the configuration computer and ECOTEL® using
the USB cable

Power up the computer and ECOTEL®
Windows should indicate that it found new hardware
Click OK to launch the hardware wizard

Follow the instructions provided by the wizard. Use the
following options:

Install hardware driver
Search for a driver for the device

To choose the source: Click on the Browse button,
select the driver file <drive>:\USB_Drivers\ftdibus.inf
on the CD drive

Finish installation
Windows should indicate again that it found new hardware

Repeat the steps listed above with the driver file
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» Open Windows device manager:
e.g. right-click on the desktop on My Computer,
Manage,
Computer Management (Local) > System Tools > Device
Manager

» Under Ports (COM & LPT), there should now be a new
entry, e.g.:
USB Serial Port (COM3), USB Serial Port (COMA4) or
something similar.

»  Write down this COM number. You will have to use it later
to select this interface during the configuration process.
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2.2.5 Installing the configuration software
» Insert the supplied CD-ROM ECOTEL®voip (oOr
ECOTEL“ispnz-1, ECOTEL®ispn2-2) into your computer.
» Inthe \Software directory, run the Setup.exe program.

» Follow the installation instructions on the screen.

The ECOTEL Service Gear configuration software will now be
installed. Once it is ready, you can launch it via Start > Programs
> ECOTEL Service Gear.

If necessary, you should now get an initial overview of the design
and operation of the configuration software.

-2 4 Usage ofthe configuration software

The following sections describe the steps needed to quickly get
ECOTEL® up and running.
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2.2.6 Configuration steps in Service Gear

»

»

»

»

Launch the configuration software:

Start — Programs — ECOTEL Service Gear
(The Service Gear module should appear.)

Create a new group:

Mark the Devices tree node

Edit > Add Group.

Give the group a name of your choice.
OK

Create ECOTEL® as a new device:

Mark a group
Edit > Add Device.
(The Properties dialog for the new device should appear.)

Edit the properties:

Give your device a Name of your choice.

Select the Device Type.

Under Access Via: Choose the interface you wish to use to
configure the device.

Fill in the remaining fields (depending on the means of
access).

Leave the Security Code field blank (factory default)

OK

l@g Note: If IP is to be used for the initial access, make sure

your computer has an IP address that matches ECOTEL®s
default settings (default IP address for configuration:
192.168.10.10, subnet mask: 255.255.255.0).

Do not confuse this IP address with the default IP address
of ECOTEL®VolP's internal SIP server (192.168.10.11)
which is used for VoIP telephony.

If you want to access ECOTEL via a different IP address,
use the USB or RS232 interface to access it for the first
time and then change the default IP settings.

—=» 2.2.8 Configuration steps in Basic Configuration
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If necessary: Create the modem

This step is necessary only if you would like to access your device
via a modem, i.e. via the GSM interface.

» Create a new modem:
Mark the Modems tree node
Edit > Add Modem.
Fill in all of the fields in the Properties dialog.
OK

» Assign the modem to the device:
Mark the device
Click on Properties (bottom right).
Choose the desired modem in the Properties dialog under
Modem.
OK

For additional information, see:

—=» 6.2 Service Gear module
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2.2.7 Configuration steps in Gateway Configuration

»  Switch to the Gateway Configuration module:
Click on the device in the tree view
(or use Tools > Start > Gateway Configuration).
Click on OK if the following message appears:
“Configuration file not found...”

» Open a new configuration file:
Choose File > New...
In the Available Versions list, choose the latest version
(unless you know that your device uses an older firmware
version; then choose the appropriate version).
A configuration file (type *.UPB) will now be created and
loaded into the display. The Device Selection page should
appeatr.

» Edit the Device page:
Choose the number of existing GSM modules

You should now see some additional configuration pages in the
tree view. You should edit or check at least the following settings.
You can leave the remaining settings as they are.

»  Enter the prefixes:
Properties >
Enter the prefixes:
International
National and
Country Code

»  Activate/deactivate the interfaces:
At the following locations, leave the default check by the
option Activate Interface or remove it, if required:
ISDN > ISDN interface 1 (or 2)
(depending on the ISDN connection type)
GSM > GSM interface 1 (or 2, 3, ...)
VoIP > VolIP interface (not with ECOTEL “ispnz-1)
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Configure the SIP outbounds: (ECOTEL®voir only)
VoIP > SIP Outbounds 1 (or 2, 3 ...)
Enter the setup data for the SIP outbounds to be used.

Enter the mobile numbers: (ECOTEL“isonz-1 only)
GSM > GSM interface 1 (2, 3, ...) > SIM properties >
Enter the numbers:
Mobile Number (telephone number of the SIM card)
Associated SMS Service Center Number.

Save the configuration file:

Choose File > Save.

Enter the file name ECOTEL (the extension .UPB will be
automatically added).

You should keep the default path.

Transmit the configuration file to your device:

Select Transmit > Save in ECOTEL...
(You can monitor the progress of the download in the
Communication window.)

For additional information, see:

-2 6.3 Gateway Configuration module
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2.2.8 Configuration steps in Basic Configuration

»

»

»

»

»

Switch to the Basic Configuration module:
Select Tools > Start > Basic Configuration.
(Click on OK if the following message appears:
“Configuration file not found...”)

Open a new configuration file:

Choose File > New...

In the Available Versions list, choose the latest version
(unless you know that your device uses an older firmware
version; then choose the appropriate version).

A configuration file (type *.BSB) will now be created and
loaded into the display.

Edit the Device page:
Choose the number of modules

ISDN settings:

On the ISDN settings page, make the settings depending
on the ISDN connection type; see the table in the
corresponding section of the manual.

IP settings:

Fill in the fields on the IP Connection page under device.
With ECOTEL Vo, fill in the fields under SIP as well, and
all other fields as required.

(DNS settings are only necessary if SIP outbounds are
used). You can obtain the necessary data from your
network provider.

l@g Note: The Device IP address must be different from the

SIP IP address! Both addresses must be valid and belong
to the same network.
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» Save the configuration file:
Choose File > Save.
Enter the file name ECOTEL (the extension .BSB will be
automatically added).
You should keep the default path.

» Transmit the configuration file to your device:
Select Transmit > Save in ECOTEL...
(You can monitor the progress of the download in the
Communication window. If the IP settings were modified,
ECOTEL® will restart.)

For additional information, see:
== 6.6 Basic Configuration module
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2.2.9 Configuration steps in User Registration

l@g Note: This section applies only to ECOTEL®VolP.

»

»

»

»

»

»

»

Switch to the User Reqistration module:
Tools > Start > User Registration.

Load the existing user table:

Upload from Ecotel.

(The user table should appear in the editing window.
The device contains a standard user table when it is
shipped from the factory).

Add new user:

Entry: New
Enter the data in the dialog.

Repeat this process for each new user.

Delete the default entry if so desired:
The default user table contains the following entry:
Domain = *, User ="*; Password = *,
This allows any user to register without a password. If this
is not desired, delete this entry:

* * *)

Select the entry (*, *,
Entry: Delete

Save the user table:

Save as...
Accept the file name USER.TXT and the suggested path.

Transmit the user table to your device:

Download to Ecotel.
(The file will be transmitted to your device.)

For additional information, see:

== 6.9 User Registration module
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2.2.10 Configuration steps in Routing Table

»

»

»

»

»

Switch to the Routing Table module:
Tools > Start > Routing Table.

Load the existing routing table:

Upload from Ecotel.

(The routing table should appear in the editing window.
The device contains a standard routing table when it is
shipped from the factory).

Edit the table entries:

Do not modify the entries of type (...) cm ... !

If necessary, replace the remaining entries with appropriate
values after consulting the information on selecting the
connection type; see also:

== 3.2 ISDN interface: Selecting the ISDN connection
type

-2 3.3 VoIP interface: Sample applications

Save the routing table:

Save as...
Accept the file name RTBL.TXT and the suggested path.

Transmit the routing table to your device:

Download to Ecotel.
(The file will be transmitted to your device.)

For additional information, see:
-2 6.4 Routing Table module
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2.2.11 Configuration steps in SIM Management

l@g Note: This section applies only to ECOTEL®voiP and

»

»

»

»

ECOTEL®ispNz-2. The corresponding configuration steps
for ECOTEL“Ispnz-1 are to be done in the Gateway
Configuration and Firmware Tools modules.

Switch to the SIM Management module:
Select Tools > Start > SIM Management.
(Click on OK if the following message appears:
“Configuration file not found...”)

Open a new configuration file:

Choose File > New...

In the Available Versions list, choose the latest version
(unless you know that your device uses an older firmware
version; then choose the appropriate version).

A configuration file (type *.SMC) will now be created and
loaded into the display.

Set SIM cardholder types:

On the SIM Cardholder page, set the cardholder types that
apply (Slot 2 above, Slot 1 below!).

(If the SIM cards are not operated in the ECOTEL®:

Select the External option and enter the IP address for the
SIM management center.)

Set SIM properties:
Page GSM 1
Select Inserted at: Location A
Enter the data belonging to the SIM card at position 1A on
SIM cardholder 7:
PIN
Mobile Number (telephone number of the SIM card)
Associated SMS Service Center Number
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Repeat these steps for the remaining SIM cards.

For the assigning of cards to GSM modules and cardholder
positions, see

= 6.8 SIM Management module

Release SIM cards:

(If there is more than one SIM card per GSM module:)
Page GSM 1 > SIM Group 1

Under Use SIM card(s), check the desired cards.
Under Switch, choose an option other than Never.

Repeat for GSM 2(, 3, ...), each with SIM Group 1.

Save the configuration file:

Choose File > Save.

Enter the file name ECOTEL (the extension .SMC will be
automatically added).

You should keep the default path.

Transmit the confiquration file to your device:

Select Transmit > Save in ECOTEL...
(You can monitor the progress of the download in the
Communication window.)

Insert the SIM cards

Please read the following information:
=2 9.5 SIM cardholder installation

For additional information, see:
== 6.8 SIM Management module
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2.2.12 Configuration steps in Firmware Tools

l@g Note: This section applies only to ECOTEL®Ispnz-1. The
corresponding configuration steps for other ECOTEL® ty-
pes are to be done in the SIM Management module.

»  Switch to the Firmware Tools module:
Tools > Start > Firmware Tools

» Remove all of the SIM cards!
(if they are inserted)

A Warning: When it is powered on and when a SIM card is
4 ' %, inserted, ECOTEL® will attempt to /og in to the network
W using the SIM card. Since ECOTEL"™ does not yet have
the valid SIM PIN, this will fail.

After two failed attempts, ECOTEL? will block any further
attempts. In order to unblock the device, insert the SIM
card into a mobile phone and type in the correct PIN. This
will reset the counter for failed attempts..

» Enter the SIM PINs:
GSM parameters > Module 1 >
Click on Enter PIN
Enter the PIN for the SIM card to be used in the relevant
module

» Repeat this procedure for each of the remaining modules

» Insert the SIM cards

For additional information, see:
== 6.5 Firmware Tools module
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2.2.13 Checking for proper operation

Once you have finished the steps described in the preceding
sections, the basic configuration process is complete. However,
you should keep the configuration software open for a while just in
case you discover you need to make some changes while you are
testing the functions.

You will be automatically returned to the Service Gear module as
soon as you close one of the other modules. You can change
between the modules at any time using the Tools menu.

Testing the field strength

Before you permanently install the antennas, a check should be
made to assure that current field strengths are sufficient. For this
purpose, you can use the page GSM Parameters Module 1 (or 2,
3, etc.) in the Firmware Tools module.

l@g Note: The field strength should be between -81 and -51
aBm.

Setting up connections

A check should be performed to ensure successful installation and
start-up by making a call from your system to a fixed network or
mobile network destination.
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2.2.14 Finishing the installation procedure

» Mechanically attach the device (if necessary)

» Permanently install the antennas

Please read the following information:
=2 9.4 Antennas

» Mechanically attach the connecting cable(s)

2.3 Getting further information

If you follow the steps outlined in the previous sections, your
ECOTEL® should now be basically ready for operation.

However, you should be aware that ECOTEL® offers a number of
additional functions. Please consult the corresponding help
sections to learn more about these functions and set them up as
required.

You can find additional information here:
== 6.4 Routing Table module

== 5.3 Strategy for the routing table

== 6.3 Gateway Configuration module
== 6.5.2 Firmware Tools: Time

== 6.5.3 Firmware Tools: Security Code
== 3.4 Additional functions

== 7 Making calls via ECOTEL
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3 Operating modes
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3.1  Overview: Using ECOTEL

ECOTEL® has interfaces to various networks: GSM, ISDN (and
also VolP with ECOTEL®volP). Its main function is to route calls
between these networks based on different parameters in a
routing table.

On the ISDN side, ECOTEL® is connected in most applications to
a PBX. ECOTEL® provides additional services to the PBX and
must be configured to work with it.

Based on this general approach, there are a number of different
connections and configurations which are possible and which are
explained in greater detail in this section.

Additional functions besides routing are also described here.

Possible applications from a user perspective

Telephone and mobile phone charges have become an important
cost factor for many companies today. The cost of connecting
fixed public network subscribers with mobile network subscribers
(as well as for making VolP calls to mobile radio subscribers) is
significant.

ECOTEL®volp establishes connections from the IP network or
ISDN fixed network to GSM mobile networks. Consequently, you
can take full advantage of the more favorable rates that are
available when your calls remain within the mobile network.

ECOTEL®volP can route incoming and outgoing GSM calls to the
Ethernet connection (VolP) as well as to the ISDN basic rate
interface (SO bus). The SIP protocol is used for calls via the IP
network (LAN or WAN).

ECOTEL®ison2-1 and ECOTEL®isone-2 lack the IP connection for
telephony and thus do not offer VolP connections. Otherwise, they
are the same as ECOTEL vorr.
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Overview of possible ISDN configurations

The ISDN basic rate interface allows the following connections:

Connection as a terminal equipment to an internal
extension of the PBX (Sy bus)

Connection to a trunk line of the PBX (S, bus)

Direct connection of an Sy bus installation for use at sites
without fixed network access

Connection to the fixed network and to the PBX. This type

of configuration routes all calls via ECOTEL®. Based on the
routing table, ECOTEL® determines whether the fixed
network or GSM network offers the most favorable rate.
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3.2 ISDN interface: Selecting the ISDN connection
type

Depending on the particular usage, ECOTEL® can be connected
to the ISDN PBX or the fixed network connection in various ways.

The following sections describe some typical variants. The tables
contain the following information:

— Jack indicates into which of the two jacks of an interface
you should plug the ISDN cable

— Activate Interface describes the setting of the control box

with the same name in the Gateway Configuration module,
page ISDN > ISDN Interface 1/2.

— The remaining settings can be made in the Basic
Configuration module.

The entries in the routing table (as shown here) are made in the
Routing Table module.

l@j Note: Some device types have only one single jack per BRI
interface instead of separate NT or TE jacks (e.g.
ECOTEL@/SDNZ-Z). You will need to use this jack
- along with a crossed cable (gray) in NT mode, or
- along with an uncrossed cable (black) in TE mode.

l@g Note: The choice of whether to use the port BRI1 or BRI2
depends on whether a terminating impedance is required:
BRI1 does not have a terminating impedance (although
one can be provided externally) while BRIZ2 is configured
with a fixed terminating impedance of 100 Ohm.
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3.2.1 Connection to the internal SO port/PTMP

1= N
Rl

NT
Antennas

Fixed ECOTEL
network

ECOTEL® can be operated as a terminal device on a PBX. To do
this, it is necessary to configure ECOTEL® as the terminal
equipment (TE). Preferably, the ISDN BRI1 port should be used.
In this case, the line is operated in PTMP mode (point-to-
multipoint).
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ISDN configuration:

BRI1 BRI2 (100 Ohm)

Jack TE -
Activate Interface Yes No
L1 mode Terminal equipment
Connection PTMP

L2 mode Terminal equipment

L3 mode Terminal equipment

Entries in the routing table:

All calls from BRI1 go to GSM
All calls from GSM go to BRI1
(ol1d™#) n G:
(oGd*#) n

—ry
oo
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3.2.2 Connection to the internal SO port/PTP

2=

Fixed ECOTEL
hetwork

ECOTEL® can be operated as a PBX direct router. To do this, it is
necessary to configure ECOTEL® as the terminal equipment (TE).
Preferably, the ISDN BRI1 port should be used. In this case, the
line is operated in the PTP mode (point-to-point).
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ISDN configuration:

BRI1 BRI2 (100 Ohm)

Jack TE

Activate Interface Yes No
L1 mode Terminal equipment
Connection PTP

L2 mode Terminal equipment

L3 mode Terminal equipment

Entries in the routing table:

All calls from BRI1 go to GSM
All calls from GSM go to BRI1
(ol1d™#) n G:
(oGd*#) n

—ry
oo
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3.2.3 Connection to the external SO port/PTMP

L,
R

TE NT
Antennas

Fixed ECOTEL
network

ECOTEL® can be operated on an external S, connection of a
PBX. Here, ECOTEL® must be configured as the network
termination (NT). Preferably, the ISDN BRI2 port should be used.
In this case, the line is operated in PTMP mode (point-to-
multipoint).
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ISDN configuration:

BRI BRI2 (100 Ohm)

Jack - NT
Activate Interface No Yes

L1 mode Network
Connection PTMP
L2 mode Network
L3 mode Network

Entries in the routing table:

All calls from BRI2 go to GSM
All calls from GSM go to BRI2

(ol2d*#)
(0Gd*#)

n
n

G:d
12:d

l@g Note: This configuration is the factory default for

ECOTEL®
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3.2.4 Connecting ISDN telephones

R

Power supply
230 VAC/
40V DC
ECOTEL  {or ISDN phones

ECOTEL® can also be connected directly to up to four ISDN
telephones. Since ECOTEL® does not supply power for
telephones, an appropriate power supply unit must be plugged
into the TE jack of the corresponding ISDN port. ECOTEL® must
be configured as the network termination (NT). Preferably, the
ISDN BRI2 port should be used. In this case, the line is operated
in PTMP mode (point-to-multipoint).
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ISDN configuration:

BRI BRI2 (100 Ohm)

Jack - NT
Activate interface No Yes

L1 mode Network
Connection PTMP
L2 mode Network
L3 mode Network

Entries in the routing table:

All calls from BRI2 go to GSM
All calls from GSM go to BRI2

(ol2d*#)
(0Gd*#)
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3.2.5 Connection to an external SO port/PTP

1= N
Rl

TE NT
Antennas
I

Synchronization
problems can
occur in this
configuration!

Fixed ECOTEL
network

ECOTEL® can be operated as the network termination (NT) in the
point-to-point mode. Preferably, the ISDN BRI2 port should be
used.
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ISDN configuration:

BRI1 BRI2 (100 Ohm)

Jack - NT
Activate interface No Yes

L1 mode Network
Connection PTP

L2 mode Network
L3 mode Network

Entries in the routing table:

All calls from BRI2 go to GSM
All calls from GSM go to BRI2

(ol2d*#) n G:d
(oGd*#) n 12:d

If the PBX has a fixed network connection in addition to
ECOTEL®, then a deviation in frequencies can occur between the
two. This causes frame slips which occasionally can cause the
port to be closed by the PBX. If problems of this sort occur, it is
necessary to use the synchronization techniques which are
described in the following sections.

== 3.2.7 Connection to an external SO port/PTP (external
synchronization)
== 3.2.8 Connection to an external S0 port/PTP (internal
synchronization)
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3.2.6 Connectionas aLCR in PTP mode

R

®
Fixed ECOTEL
network

ECOTEL® can be looped directly into the connection line. Here,
one port must be configured as the terminal equipment and the
other as the network. This configuration allows ECOTEL® to
independently route GSM calls from normal traffic into the GSM
network (Least Cost Routing = LCR). In this case, the line is
operated in the PTP mode (point-to-point).
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ISDN configuration:

BRI1 BRI2 (100 Ohm)

Jack TE NT
Activate interface Yes Yes

L1 mode Terminal equipment Network
Connection PTP PTP

L2 mode Terminal equipment Network
L3 mode Terminal equipment Network

Entries in the routing table:

All calls from BRI1 (fixed network) go to BRI2 (PBX).

Calls from BRI2 (PBX) with a destination number of 0715..., 016...
or 017... go to GSM.

All other calls from BRI2 (PBX) go to BRI1 (fixed network).

All calls from GSM go to BRI2 (PBX).

(ol1d*#) n 12:d
(012d01[5-7]*#) n G:d
(ol2d*#) n 11:d
(0Gd*#) n 12:d

The destination numbers 075..., 016... or 017... are used as an
example here. Depending on your local situation, you will have to
use other suitable criteria for routing to GSM.
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3.2.7 Connection to an external SO port/PTP (external
synchronization)

—ah
\\5.
O

| ‘ ‘ Antennas
]

Fixed ECOTEL
network

To provide synchronization, ECOTEL® can be connected to a
continually active ISDN line. This is used exclusively for accessing
the ISDN clock. Calls cannot be routed via this cable. Should the
synchronization connection fail, ECOTEL® will automatically
continue to run in crystal mode. Calls are routed via BRI2.
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ISDN configuration:

BRI BRI2 (100 Ohm)

Jack TE NT
Activate interface Yes Yes

L1 mode Terminal equipment Network
Connection PTP PTP

L2 mode Terminal equipment Network
L3 mode Terminal equipment Network
L1 clock from BRI

L1 from BRI1 Clock only

Entries in the routing table:

All calls from BRI2 go to GSM
All calls from GSM go to BRI2
BRI1 is not used for calls

(ol2d*#)
(0Gd*#)

Page 52

Edition 3.2-EN — 20060530

=)
N> 0

5
oo

ECOTEL® VolP/ISDN2-1/ISDN2-2




VIERLING

3.2.8 Connection to an external SO port/PTP (internal
synchronization)

U
LS

<HHENN-
TE NT
L1 of the PBX is ‘ ‘ Antennas
configured as

the master so

that the PBX L1 of the NT
can transmit the port is con-
fixed network figured as the
clock to slave so it can
ECOTEL. evaluate the

clock informa-
tion from the
PBX and
synchronize
itself.

Fixed ECOTEL
network

ECOTEL® can be configured as a terminal equipment on layer 1
in deviation from L2 and L3. This provides access to the clock of
the PBX. Calls are routed via the same cable. ECOTEL® is
configured as a network termination in terms of layers 2 and 3.
The prerequisite for this variant is that the relevant port of the PBX
must support the complementary (and different) settings for L1 or
L2/L3.
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ISDN configuration:

BRI1 BRI2 (100 Ohm)

Jack - NT

Activate interface No Yes

L1 mode Terminal equipment
Connection PTP

L2 mode Network

L3 mode Network

L1 clock from BRI2

L1 from BRI2 RX/TX

Entries in the routing table:

All calls from BRI2 go to GSM
All calls from GSM go to BRI2

(ol2d*#)
(0Gd*#)
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3.3 VolIP interface: Sample applications

l}@? Note: This interface is only available with ECOTEL“volP.

3.3.1 Media gateway for calls from the ISDN PBX to
VoIP and to GSM mobile radio networks

If the ISDN PBX is suitably configured, all calls to VolP or GSM
subscribers can be routed via an S, extension of the PBX to
ECOTEL®. ECOTEL® then establishes a connection directly via
the IP network or a GSM channel to the called subscriber.

Incoming VoIP or GSM calls can be forwarded directly to the
desired extension of the PBX.

P,

ISDN.
- 33".
"'"'-:-.. /
i ECOTEL® VoIP
'?l ISDN PBX

IL

SIP server
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ISDN configuration, variant 1:

As in the following ISDN example:

=2 3.2.1 Connection to the internal SO port/PTMP
(ECOTEL® on an extension of the PBX)

Entries in the routing table:

All calls from VolP go to BRI1 (PBX).

Calls from BRI1 (PBX) with a destination number of 075..., 016...
or 017... go to GSM.

All other calls from BRI1 (PBX) go to VolP.

All calls from GSM go to BRI1 (PBX).

(oVd*#) n I1:d
(ol1dO1[5-7]*#) n G:d
(ol1d™#) n V:d
(oGd*#) n I1:d

The destination numbers 075..., 016... or 017... are used as an
example here. Depending on your local situation, you will have to
use other suitable criteria for routing to GSM.

ISDN configuration, variant 2:

As in the following ISDN example:

== 3.2.3 Connection to the external SO port/PTMP
(ECOTEL® on the exchange line of the PBX)

Entries in the routing table:

All calls from VolP go to BRI2 (PBX).

Calls from BRI2 (PBX) with a destination number of 075..., 016...
or 017... go to GSM.

All other calls from BRI2 (PBX) go to VolP.

All calls from GSM go to BRI2 (PBX).
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(oVd*#) n 12:d
(012d01[5-7]*#) n G:d
(ol2d*#) n V:d
(0Gd*#) n 12:d

The destination numbers 0715..., 016... or 017... are used as an
example here. Depending on your local situation, you will have to
use other suitable criteria for routing to GSM.
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3.3.2 Call routing via the VolP port of the PBX

If the PBX has a VolP port, then it is possible, for example, to
route all GSM calls via the IP network to ECOTEL®. In its maxi-
mum configuration, ECOTEL® has eight GSM channels so that
eight simultaneous GSM connections can be routed from the PBX
directly to the mobile radio networks.

Incoming GSM calls can be forwarded, for example, using DTMF
dialing to the desired extension of the PBX.

Routing of GSM calls is handled by the PBX in this configuration.

L/ &/

‘ ‘ GSM
50‘
& " VoIP ; ECOTELEVoIP
L el ——— IP network

ISDN PBX

Entries in the routing table:

All calls from VolP go to GSM
All calls from GSM go to VolP

(oVd*#) n G:d
(oGd*#) n V:d
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3.3.3 Call routing via a SIP server (soft PBX) in the
LAN

ECOTEL® can also be used as a media gateway from an IP
network to ISDN and GSM. In this configuration, the SIP server
routes all calls to subscribers in the ISDN or GSM mobile radio
networks to ECOTEL®. ECOTEL® then establishes a connection
directly via an ISDN or GSM channel to the desired subscriber.
Incommg calls from the ISDN or GSM network are forwarded by
ECOTEL® to the corresponding IP telephone.

If it is suitably configured, the internal SIP server in ECOTEL®volp
can replace the external SIP server.

SIP phone

PN ¥
ECOTEL® "d’uIP \"/

SIP phone ISDN phone or NTEA
‘ i ¥

SIP phone , SIP server
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ISDN configuration:
As in the following ISDN example:
=2 3.2.1 Connection to the internal SO port/PTMP

Entries in the routing table:

Calls from VolP with a destination number of 0715..., 016... or
017... go to GSM.

All other calls from VolP go to BRI1 (ISDN).

All calls from BRI1 (ISDN) go to VolP.

All calls from GSM go to VolP.

(oVdO1[5-7]*#) n G:d
(oVd*#) n 11:d
(ol1d*#) n V:d
(0Gd*#) n V:id

The destination numbers 075..., 016... or 017... are used as an
example here. Depending on your local situation, you will have to
use other suitable criteria for routing to GSM.
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3.3.4 Call routing via SIP server in the IP network

You can distribute multiple ECOTEL® units throughout the IP
network. An SIP server routes the calls, e.g. as a function of the
gateway site or the installed SIM cards, to the corresponding

device.

If it is configured properly, the internal SIP server in ECOTEL®volp

can replace the external SIP server.

i . SIP server

%xGSM ?BXGSM
?BXGSM %’BHGSM

Entries in the routing table:

All calls from VolP go to GSM
All calls from GSM go to VolP

(oVd*#) n
(oGd*#) n

<O
Qg
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3.3.5 Box-to-box operation

When calls are made from a GSM network directly to another
GSM network, this generally results in higher charges than if you
call a GSM subscriber in your own GSM network. This applies
particularly to international calls which tend to result in very high
connection fees.

By using ECOTEL®, it is possible to replace the higher fees of an
international GSM call with the lower charges that arise for a
mobile phone in the same country as ECOTEL®. The connection
between the two countries is realized using VolP.

This application makes sense in the following case:
Charges C > Charges A + Charges B

C
y o)
o
A XGSM GSM f B
‘— Internet —p‘

] VolP

Entries in the routing table:

All calls from VolP go to GSM
All calls from GSM go to VolP
(oVd*#) n
(oGd*#) n

<®
Qg
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3.4 Additional functions

3.4.1 Call hold switching between GSM and ISDN
subscribers

l@ Note: This feature is currently available only with
ECOTEL®ISDN2-1.

It is possible to switch between arbitrary GSM or ISDN sub-
scribers, i.e. during a call one of the two subscribers can make a
call to a third party. The connection to the original party is held
during this time. You can then switch between the two calls.

The call hold function in ECOTEL® does not use the call hold
supplementary service provided in the GSM network or the ISDN
network. As a result, two GSM channels (ISDN B channels) are
always required in case of participation of two GSM subscribers
(ISDN subscribers). However, this means that the function works
even if the GSM call hold supplementary service is not supported
by the SIM card which is used.

For more details, see:
—= 7.4 Call hold switching between subscribers
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3.4.2 User registration

J5~  Note: This feature is only available with ECOTEL®volP.

ECOTEL®volP has an internal SIP server. Terminal devices (SIP
telephones, softphones) that want to make phone calls using the
VolP interface provided by ECOTEL® can register there. This also
applies to external SIP prOX|es or SIP providers that want to
forward calls to ECOTEL®.

The User Registration module is prowded for managing the
authorized users that are known to ECOTEL®.

== 6.9 User Registration module

A user who is known to ECOTEL® can register with ECOTEL®,
assuming the user is connected to ECOTEL® via an IP network,
for the duration of the connection. The user is considered to be
"reachable" and can make and receive calls.

User registration can take place either with or without
authentication.

When the device is shipped, any user is allowed to register
without authentication. We recommend that you keep this setting
only if you intend to use ECOTEL® exclusively in an internal
network with a secure firewall in place.
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3.4.3 SIP outbounds (SIP proxies and SIP providers)

l@g Note: These feature is only available with ECOTEL®volP.

Outgoing calls to a SIP proxy or SIP provider

Initially, ECOTEL® can route VolP calls only to subscribers that it
knows, i.e. subscribers that are registered with its own SIP server.
For calls to other subscribers, ECOTEL® needs partners that
support forwarding to other VolP networks. There are two different
cases: SIP proxies and SIP providers. This manual refers to both
together as SIP outbounds.

To make a SIP proxy or SIP provider usable for ECOTEL®, you
will need to enter certain setup data. This is handled in the
Gateway Configuration module under VolP > SIP Outbound 1 (2,
3,...).

== 6.3.10 Gateway Configuration: SIP Outbound 1..n

Differences between a SIP proxy and a SIP provider

From the viewpoint of ECOTEL®, the following distinction is
relevant:

With a SIP provider, ECOTEL® logs in like a terminal device.
Providers also generally require authentication with a user
identifier and password. You can obtain this data from your SIP
provider. The actual terminal device that is behind ECOTEL®, e.g.
a VolP telephone, is invisible to the provider.

If you are operating your own SIP server (e.g. Asterisk) in an
internal network, it should be configured as a SIP proxy from the
viewpoint of ECOTEL®. From the viewpoint of the SIP server,
ECOTEL® also behaves like a SIP proxy. ECOTEL® has to log
into the SIP proxy with the user name known there; authentication
is generally not required. For each call from a VolP terminal
device, ECOTEL® passes along its user name to the SIP proxy. In
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this case, the authentication is handled between the SIP proxy
and the caller.

If the caIIer is not a VoIP subscriber (e.g. a GSM subscriber), then
ECOTEL® will act as a terminal device itself with respect to a SIP

Proxy.

Incoming calls from a SIP Outbound

If you want ECOTEL® to also accept incoming calls from 2 SIP
outbound, it will need to be able to register with ECOTEL® as a
user. You will need to make an appropriate entry for the SIP proxy
or SIP provider in the User Registration module.

== 6.9 User Registration module

SIP outbounds and routing table

In the routing table, you can (or must) specify the SIP outbound
for routing an outgoing VolP call. The virtual port names V7,
V2, ... are used which correspond to SIP outbounds 1, 2, ... For
calls without a SIP outbound (i.e. to SIP telephones that are
registered with the SIP server provided in ECOTEL®), select the
virtual port V.
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3.4.4 SIM management

l@g Note: This feature is not available with ECOTELZISDN2-1.

ECOTEL® allows you to use multiple SIM cards for the same
GSM channel. You can specify which SIM cards to use at which
times in order to take advantage of the best rates. ECOTEL® can
automatically switch between SIM cards, e.g. when a card’s
balance runs out.

You will need to use SIM cardholders if you want to switch
between different cards.

—= 9.5 SIM cardholder installation

You can make the relevant settings in the SIM Management
module.

-2 6.8 SIM Management module

ECOTEL®voir and ECOTEL®ispn2-2 may also be operated using
an external SIM server instead of locally installed SIM cards. For
this purpose, a SIM emulation board must be installed in the
cardholder slot. This board will connect to the SIM server and
emulate the SIM cards present there with respect to ECOTEL®.
The SIM emulation board is not included with ECOTEL®.
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3.4.5 CDRsin ECOTEL

If recording of call detail records (CDR) is activated, a new CDR
file is created in ECOTEL® each day and the CDRs which occur
during the day are saved in the file.

CDR recording must be activated separately for each interface in
the Gateway Configuration module under ISDN > ISDN Inter-
face n (or GSM > GSM Interface n or VoIP > VolIP Interface) using
the Generate call records checkbox there.

The CDR for a call always contains one data set, i.e. one line for
the incoming connection and one line for the outgoing connection.
This means that the CDR for a successful call will contain at least
two lines.

Example: A call is routed to the GSM network from ISDN interface
1, B channel 2 via GSM interface 2. From the viewpoint of
ECOTEL®, this represents two connections: An incoming call on
the ISDN port and an outgoing call via the GSM module. The
following CDR is recorded for this call:

2 3 4 5 b fl8(9 (10
0| G2 | 05628142057 | 142057 | 143018 [ M23456788 (10 |3 (M2 |10
I N2 [ 05625142029 | 1427029 | 143018 (10 10

Connection direction (I = Incoming, O = Outgoing)
Interface used (I=ISDN, G=GSM, V=VoIP)

Start of call (setup)

Time point of connection (connect)

Time point of disconnection (release)

O G b W N =

Called number of calling party (for incoming connections) or
called party (for outgoing connections)

Release cause

0 ~

Charge recording (only for outgoing calls, either in units or in a
currency); see also
—=* 6.3.3 Gateway Configuration: ISDN Interface 1/2
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9 Interface used for the incoming call which was routed via
ECOTEL®

10 Telephone number of the calling subscriber who made a call via
ECOTEL®

Special case: Logging is as follows when using callback:
— The first CDR logs the incoming call from subscriber A.

— The second CDR contains the first outgoing call to A
(where A is the called party and ECOTEL® is the calling
party) with reference to the incoming call.

— The third CDR contains the second outgoing call

(B is the called party and A the calling party) with reference
to the first outgoing call.
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3.4.6 Adaptive callbacks

The Adaptive Callbacks function (rerouting) writes the phone
numbers of the calling and called subscribers into an internal list
maintained by ECOTEL® for all failed calls from the ISDN
interface to the GSM network. The validity duration for the entries
in this list can be specified by the user. If the GSM subscriber
which was not reached previously calls ECOTEL® within the set
time, he is automatically forwarded to the telephone number which
previously attempted to reach him without success.

Make the necessary settings in the Gateway Configuration
module under ISDN Interface 1 (or 2).

There are two ways to setting up the entries in the ECOTEL®:

Automatic adaptive callbacks

For automatic adaptive callbacks, the telephone number of the
calling party and the called party are automatically saved in
ECOTEL® for the time set under Automatic callbacks valid for ..

Manual adaptive callbacks

If Automatic Callbacks are deactivated, then the calling subscriber
can manually enter his telephone number and that of the called
party into the callback list. He must enter the sequence *0## on
his telephone keypad prior to hanging up. The data are then
saved for 60 minutes in the list. If another interval besides the
default value of 60 minutes is required, then you must enter the
sequence *0#time in minutes# (e.g. *0#150# for 150 minutes).
You can enter values from 0 to 1440 minutes (= 1 day). The
callback list is updated only every five minutes. You can delete
your entry with *0#0#.

— Example 1:*0#150# means that if the person who was not
reached calls back within 150 minutes, they are to be
automatically connected to the subscriber who previously
tried to call them.
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You can also set up an entry in the call list without a current call
by entering the sequence *0#Telephone number## (storage for 60
minutes) or *0#Telephone number#Time in minutes# (storage for
e.g. 150 minutes).

— Example 2: *0#0123456789#150# means that if the
subscriber with the telephone number 0123456789 calls
the GSM module of ECOTEL® within 150 minutes, he is to
be automatically connected to the subscriber who wrote
this entry into the callback list.

You can delete to an arbitrary entry from the callback list by
entering the sequence *0#Telephone number#0#

— Example 3:*0#0123456789#0# means that the entry for
the subscriber with the telephone number 0123456789 is to
be deleted from the callback list. If this subscriber calls the
GSM module of ECOTEL®, he will not be forwarded
automatically.

Handling of multiple unsuccessful calls

If multiple GSM subscribers are not reached from the same
extension, a callback entry is written into the list for each attempt.

If several different extensions call the same GSM subscriber
without reaching that person, then each new entry overwrites the
previous one. This means that only the entry representing the
most recent attempt remains in the callback list.
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3.4.7 Callback request via SMS

ECOTEL® has a function which makes it possible, in case of the
failed call from a PBX to a GSM subscriber, to automatically send
an SMS message to the subscriber. With this callback request,
the desired party receives notification that an attempt was made
to reach him and that he should return the call, for example.

Make the necessary settings in the Gateway Configuration
module under GSM Interface 1 (or 2, 3, ...) > Callback SMS.

You can enter whatever text you wish to use for the SMS
message which forms the callback request.

The %m wildcard automatically inserts the telephone number of
the SIM card via which the subscriber was called into the SMS
message. The extension of the calling subscriber can be inserted
into the SMS text with the %e wildcard.

Example: “Please call back %m or %e .”

Transmission of the SMS message can be initiated in two ways:

In the setting By request of the calling party, the SMS message is
sent only if the calling subscriber enters the character sequence
*1# using DTMF dialing. The callback request via SMS can be
entered only if the call was not successful. If the voicemail is
reached, this is considered to be a successful connection.

If the setting is Automatic for each failed call, the SMS message
with the callback request is sent automatically as soon as the call
fails.
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3.4.8 SMS functions

ECOTEL® supports transmission of SMS messages. For this
purpose, ECOTEL® provides a GSM07.07 interface for USB and
IP/Telnet (not with ECOTEL®ispn2-1) or for RS232 and IP/Telnet
(with ECOTEL ®isbnz-1).

Software is available free of charge for the RS232 interface.
Transmission, reception and storage of SMS messages can be
managed using SmeaSyPro.EXE.

Conversion of e-mail to SMS (or SMS to e-mail) can be
implemented using the application ECOTEL? SMbaSic (Mall
Manager). This program is available separately. For a detailed
description, see the documentation on the CD-ROM.

3.4.9 Dialing in via the Internet

l@ Note: This is currently possible only with ECOTEL?IspN2-1.

ECOTEL®sbn21  offers asynchronous PPP for RS232 and
IP/Telnet in order to allow dial-in via the Internet (CSD and
GPRS).

Software is available free of charge for the RS232 interface. The
driver ECI2_1Modem.inf supports multiple device drivers for the
different models.
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4 Usage of the configuration software
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4.1 Overview: How to configure ECOTEL VolP

In order to configure ECOTEL®, you will need a computer (PC,
laptop) on which the ECOTEL? Service Gear configuration
software is installed.

Accessing ECOTEL

From your computer, you have different ways of accessing
ECOTEL®:

— Via IP (Ethernet / LAN, WAN)
— Via USB
—  Via the serial interface (ECOTEL®ispn2-1 only)

— Viaa modem
The relevant details are described in the following sections.
—= 4.3 Connecting the computer and ECOTEL

Configuration files

As soon as a connection has been established between your
computer and the device (ECOTEL®), you can configure the
device by downloading a suitably prepared configuration file.

The configuration software modules automatically use the proper
file type. The following information is provided for general
orientation.
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File management

There are the following different configuration files for each
device:

— ECOTEL.UPB for the general settings

— ECOTEL.BSB for the special basic settings of the ISDN
interfaces

— ECOTEL.SMC for the SIM cards settings (not in
ECOTEL Ispne-1)

— USER.TXT as the VolIP user table (only in ECOTEL®voip)
— RTBL.TXT as the routing table

Each of these files is handled using a specific module. You can
see the assignments here:

—=» 4.2 The ECOTEL Service Gear software

The following section contains more information on processing
these files:

== 4.4 Editing the configuration files

The configuration files (and other files) for one or more devices
are managed on your computer in a directory structure which is
known as the database. There, you can save variants and backup
copies of your configurations and open and modify existing
configurations as templates. The configuration files found on the
device can be read out using an upload and then edited and
resaved.
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4.2 The ECOTEL Service Gear software

The ECOTEL? Service Gear configuration software consists of a
number of different modules (program components) which group
together related parameters and functions.

Central module Program components Created file
Service Gear LE T SR L LT ../Dev0001/ ECOTEL.UPB
Device management General settings

DataBase -
Devices I e L ../Dev0001/ RTBL.TXT
Device 1 Routing table
gev!oeg Firmware Tools
evice Remote operation
= DRy ../Dev0001/ ECOTEL.BSB
Basic interface settings
Monitor
Connection monitoring
e ../Dev0001/ ECOTEL.SMC
SIM cards management
L ./Dev0001/ USER.TXT
VolP user administration

Service Gear

This is the main module which appears first when the program is
launched. Here, the devices are managed, i.e. for each ECOTEL®
(cf. graphics example: Device 1) there are setup data which can
be displayed and edited.

For a better overview, the devices are displayed as nodes in a
tree structure and can also be grouped together hierarchically.

Besides the Devices intended for telephone traffic, the Modems
are also managed here. They are used to provide remote access
via GSM to the devices which cannot be configured via a cable
connection such as USB or IP.
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For each device, Service Gear manages a folder in the directory
structure of the configuration computer (cf. graphics example:
C:\Program Files\Vierling\ECOTEL_Service_Gear\EcotelData\Dev0001\).
There, the files are saved which are associated with each device,
i.e., the configuration files as well as other data such as CDRs or
log files. Together, all of these files are known as the Database.

Navigating between the modules

From Service Gear, you can access the other modules by marking
a device and choosing the desired module with Tools > Start > ...
Or even shorter: Double click on the device to open the Gateway
Configuration module.

The module is opened “for the selected device”, i.e. the data
associated with the device are automatically used (folder for file
storage, setup data for connecting to the device).

To go from one of the other modules to a different module, you
should also use the Tools menu.

If you exit one of these modules, you will be returned to Service
Gear.

l@g Note: When you open a module, the Service Gear window
will disappear initially. Then, it might take a little while until
the new window opens.

For historical reasons, the Gateway Configuration and
Basic Configuration modules are still labeled ECOTEL
Configuration Software in the title bar. However, you can
clearly distinguish the modules based on the entries in the
tree view.

Gateway Configuration

This module allows you to make most of the settings required by
ECOTEL®, except for only the basic settings for the ISDN
interfaces and the routing table, which are handled in separate
modules.
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All of the parameters which appear here are found in the
configuration file ECOTEL.UPB. It must be downloaded to the
device after editing in order for the changes to go into effect.

Routing Table

The routing table determines how ECOTEL® handles incoming
connection requests. Here, it is possible to distinguish between a
number of different cases depending on the interface or telephone
number group. A special syntax is used which allows a great
variety of individual settings.

All of the entries which you make here are found in the
configuration file RTBL.TXT. It must be downloaded to the device
after editing in order for the changes to go into effect.

Firmware Tools

The Firmware Tools module is used to download new firmware
and also for all other maintenance tasks which are not linked to
the configuration files.

Basic Configuration

In this module, you can make the basic settings for the two ISDN
interfaces and the VolP/LAN interface.

All of the parameters which appear here are found in the
configuration file ECOTEL.BSB. It must be downloaded to the
device after editing in order for the changes to go into effect.

Monitor

The Monitor displays information about the user connections
which are currently underway via the device. This includes data
such as the channel status, utilization statistics and current
connections.
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SIM Management (not for ECOTEL Ispnz-1)

This module handles the data for the SIM cards and determines
how to switch between multiple cards for a GSM module.

All of the parameters which appear here are found in the
configuration file ECOTEL.SMC. It must be downloaded to the
device after editing in order for the changes to go into effect.

User Registration (only with ECOTEL®voip)

You can use this module to manage VolP users of ECOTEL®.
This includes all of the subscribers who wish to use the VolP
interface provided by ECOTEL® for incoming or outgoing calls and
need to register beforehand with ECOTEL®.

All of the entries which you make here are found in the
configuration file USER.TXT. It must be downloaded to the device
after editing in order for the changes to go into effect.
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4.3 Connecting the computer and ECOTEL

In order to be able to access ECOTEL® from your configuration
computer, you first need to establish a connection between the
two. There are several possibilities here: Via USB (for
ECOTEL®vor and ECOTEL®isbnz2) or serial interface (for
ECOTEL®isbn21), via IP (LAN, WAN) or via a modem.

Enter your choice in the Service Gear module along with the
associated access data using the Properties dialog for the
relevant device.

The relevant details are described in the following sections.
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4.3.1

Connecting via IP (LAN, WAN), USB or serial
interface

l@g Note:
IP: Available with all ECOTEL? @types

»

»

»

»

USB: Not available with ECOTEL"ISDN2-1
Serial: Only available with ECOTEL“ispNz-1

Connect the computer and ECOTEL®:

(a) using a connection to a LAN or WAN (Ethernet), or
(b) with a USB cable, or

(c) with a serial cable

In the Service Gear module:

Select the device
Open the Properties dialogue

Select the desired option for Access via:
(a) IP

(b) USB

(c) RS232 (serial)

Enter the required parameters:

for (a) enter the configuration /P address of ECOTEL®
for (b) choose the COM port for the computer

for (c) choose the COM port for the computer

l@ Note: The factory default IP address of the configuration

»

»

interface of ECOTEL? is 192.168.10.10

Enter the security code that your computer must use for
authentication with ECOTEL® (factory default: empty)

OK

This information allows your computer to automatically connect to
ECOTEL® each time you execute a corresponding function.
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4.3.2 Connecting via modem

A modem is used to allow access to ECOTEL® via mobile radio.
Generally, this is also an ECOTEL® device which is used specially
for this purpose.

l@? Note: Access via modem is currently possible only with
devices having SIEMENS GSM modules.
The transmission speed is very low for modem access so
we recommend that you use one of the other connections
types whenever possible.

In order to establish a connection, you need to set up the modem
once beforehand.

Later, you need to first set up remote access from the modem to
the device. Then, your computer will be able to automatically
connect to the device via the path that was established.

The access mechanism is described below.
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Setting up the modem

»

»

»

»

»

»

Connect the computer and the modem via a serial cable or
USB cable

In the Service Gear module:
Create the new modem (if it does not yet exist) or select it
Open the Properties dialogue

Select Access via (RS232 or USB)
Select the COM port for the computer

Enter the security code for the modem which your
computer must use for authentication with the modem (not
to be confused with the security code for the device to be
accessed via the modem!).

Enter the callback number via which the device is to
callback the modem later. The modem must have an SIM
card with data capabilities and the data number must be
used.

OK

Using this information, your computer can later ask the modem to
initiate access to the device.
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Setting up the device

»

»

»

»

In the Service Gear module:

Select the device
Open the Properties dialogue

Access via: Select the Modem option
Select the desired modem

Enter the security code that your computer must use for
authentication with ECOTEL® (factory default: empty)

OK

Using this information, your computer can connect to ECOTEL® at
a later point in time when it wants to execute a function, but only if
remote access has been established (see the following section).

Setting up remote access

»

»

Switch to the Firmware Tools modules
Remote Access page (visible only if a modem is connected
to the computer).

Click on the Establish Remote Access button
(information will be displayed about the connection setup)

As soon as the connection has been established, you can perform
the desired configuration and maintenance tasks. If necessary,
navigate within the user interface.

»

To end: Click on the Disconnect button

l@g Note: If the modem access mode is set up for a device, the

Gateway Configuration and Basic Configuration modules
will be available only as long as the connection described
here exists.

ECOTEL® VolP/ISDN2-1/ISDN2-2 Edition 3.2-EN — 20060530 Page 85



VIERLING

Access mechanism

When remote access is established, the following steps are
automatically performed:

@ @

(1) The configuration computer is connected via a serial interface
or USB to the modem. It authenticates itself with the modem using
the security code for the modem and asks the modem to establish
a connection to the device.

(2) The modem calls the device via GSM and passes along the
access code and its own telephone number.

(3) Based on the access code, the device recognizes that this is
not a usual call. Instead, a data connection is being requested for
the purpose of configuration. It calls the modem back at the
specified number. This call is made in Data mode.

(4) Using the data connection that was just established, the
computer can now communicate directly with the device just like
when using the other connection techniques (IP, USB, serial),
although this will be significantly slower. Using the security code,
the computer authenticates itself with respect to the device.
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4.4 Editing the configuration files

You can manage the configuration files in general using Open —
Edit — Close.

New/Readout/Open
Here, there are three possibilities:

You can create an entirely new file. In the Gateway Configuration
and Basic Configuration modules, choose File > New or File >
Factory Default and select the firmware version for your device
(since certain parameters must be properly set in the
configuration). In this manner, you can obtain a configuration file
with the default values. For the routing table and the VolP user
table, there is no template. Here, you will start with an empty
window.

You can read out the corresponding file from ECOTEL® (menu
Transmit > Read from ECOTEL or the corresponding button). Be
aware that the file which was previously displayed will be
discarded.

You can open a file that is present on your computer (menu File >
Open or the corresponding button). This allows you to import
configurations that were created elsewhere and modify them
according to your needs.

Edit

The file which is currently loaded in the display can be edited by
changing the values in the input fields. Or, for the routing table,
you can compose the desired entries like you do with a text editor.

Furthermore you can edit the routing table using the Routing
Wizard:

== 6.4.4 The Routing Wizard

In the user table for VolP, use the Entry: New or Edit buttons to
create or edit an entry.
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Save/Download

You can save the edited file on your computer (menu File > Save,
File > Save As or by using the corresponding button).

In order to enable the changed settings on ECOTEL®, you need to
transmit the file to it (menu Transmit > Save in ECOTEL or the
button Download to ECOTEL).

Page 88

Warning: As a general rule, you should use the paths
which are suggested. If you do not, be sure you are familiar
with the basic concepts of the database.

On the actual device, the configuration files must always be
named as follows: ECOTEL.UPB, ECOTEL.BSB,
USER.TXT and RTBL.TXT. For downloads, these names
are always used.

When opening the Gateway Configuration and Basic
Configuration modules, the application automatically looks
in the database for the file associated with the device
(ECOTEL.UPB or ECOTEL.BSB) even if a file with a
different name was last edited. We suggest very strongly
that you use these names.
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4.5 Generating traces

Traces are detailed information generated by a program during its
operation if trace mode is activated.

Traces are normally switched off. However, when problems occur,
it can be useful to create and record traces for troubleshooting
purposes. This allows you to have a detailed look at what is
happening in the device.

If you contact the manufacturer’s support hotline for help with a
problem, you might be asked to generate certain traces and send
them in. The following sections describe how to activate traces as
required and save the recorded data.

Evaluation of the data is the job of the support technician since it
requires special expertise that is beyond the scope of this manual.

A brief summary of the most important information can be found
here:

-2 4.5.1 Creating traces at a glance
The remaining sections provide more of the relevant details.
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4.5.1

Creating traces at a glance

» Via Tools > Start, go to the Firmware Tools module, and
select the Trace tree node there.

“ Firmware Tools
File Toolz Help

I E3

E--@ ErcotelT ool
..... & Time Debug All on |
- #@ Security Code HWG: FF ,00,W
¢ Firmwware Download [1]:4 Debug Al off |
o i ARnouncement *ECOTEL WoIP-18x ¥3.1.1 13.02.2006 f W121
-4 CDR 114
---. G5M Parameters > Debug ISDM on |
----- # File Transfer
i Trace Debug ISDN off |
Debug GSM on |
Debug GSM off |
Long Term Traces |
ECHO on |
ECHO off |
Scroll Lock | Save Trace |
IDBG RTEL7 Send | Clear Trace Flitie: | Offline |
v Caps Lock
Devicell YoIP P [ B | Connected to device [Falder For device data: DevO011 5

» Type the following commands into the text field to the left of
the Send button.
Press the <Return> key after every command, or click on

Send.

DBG RTBL 7
DBG ICON 7
DBG DTMF 7
VOIP TRC ON

ECOTEL® will acknowledge each command with OK.
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If your support technician provides you with further
commands, enter them the same way.

Now perform the actions (e.g. calls) to be analyzed using
the traces.

In the large window, the trace output will appear.

Wait until the actions you are interested in have been
executed.

Click on Save Trace.

Select a path and file name and write them down so you
can find your trace file later.

Turn the traces back off by typing the following commands
in order:

DBG RTBL 0
DBGICONO
DBG DTMF 0
VOIP TRC OFF

Send an e-mail to
support@vierling.de
and attach the saved file,
a brief description of your problem
and your ECOTEL®'s configuration files:
ECOTEL.UPB
ECOTEL.BSB
RTBL.TXT (routing table);
additionally for ECOTEL®volp;
ECOTEL.SMC,
USER.TXT (user table).
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4.5.2 Generating traces: Explanation

To activate traces, switch to the Firmware Tools module via Tools
> Start and select the Trace tree node.

For information on individual operating elements, see:
- 6.5.9 Firmware Tools: Trace

Display and input

The large window shows all of messages and trace output from
ECOTEL®.

The text field under this is used to input your commands. Click on
the Send button or press the Return key to send the command.
ECOTEL® will confirm each command it receives with an OK
message.

Commands are always in capital letters so we suggest keeping
the Caps Lock key activated.

Different trace types

ECOTEL® contains several different software modules that can
generate traces and in some of them, different levels can be
activated. You can intentionally activate these trace types using
appropriate commands (even multiple levels simultaneously).

The main trace types and the associated commands are
described in the following section.

== 4.5.3 Generating traces: Examples

Note: The more traces you activate, the more information will be
generated. If too many traces are activated, the clarity can be
impaired along with the performance of your device.

If a support technician asks you to create traces, you will be
provided with the necessary commands.
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Starting and stopping traces

Type in the start command for the desired trace type and level
and press the Return key.

Tracing should now be activated: For each relevant event in
ECOTEL®, a line will appear in the message window.

When you no longer need tracing, you should make sure that you
switch it back off. This is important because it will prevent
unnecessary loading of the ECOTEL® and (most importantly) will
not block access via modem, which is possible only when tracing
is switched off. Enter the command used to switch off tracing and
press the Return key.

Buttons for standard trace types

To the right of the large display window are some buttons you can
use to switch the most common trace types on and off. Each
keypress is the same as entering a start (or stop) command.

Direct command entry is less convenient, but it will be required if
you want to use newer or less common trace types for which there
are not (yet) any buttons.

Saving traces

To save the trace data that is generated, click on the Save button
and enter the location for the file in the dialog that appears.

Make a note of the path and file name so you will be able to find
the trace file later and send it to the support technician if
requested.

Trace files have the extension .TRC. They are plain text files that
you can open with any text editor.

If the device is to be monitored over a longer time interval (e.g.
over night), we recommend that you activate long-term traces
using the button of the same name. ECOTEL® will then write the
trace output directly to a file. Once this is finished, don’t forget to
switch off long-term traces.
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4.5.3 Generating traces: Examples

This section describes some commonly used trace types with the
required commands.

Type the commands exactly as shown, including spaces.

Make sure to switch off any traces you enable after you are done
using them.

DBG RTBL

Shows how the routing table is implemented in ECOTEL®. The
trace output contains the dialing information that the A subscriber
sends to ECOTEL® and the number that ECOTEL® dials in the
outgoing direction.

Start with DBG RTBL 7
Stop with DBG RTBL 0 (/ast character = zero digit)

The parameter 7 represents the highest possible trace level. With
4 you will receive only the most important messages while 0 will
end the trace.

DBG LINK

Shows the events that control the call (SETUP, CONNECT, etc.)
for each interface (particularly the other interface that is connected
to).

Start with DBG LINK[n] 7
Stop with DBG LINK[n] O (last character = zero digit)
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The parameter 7 represents the highest possible trace level. With
4 you will receive only the most important messages while 0 will

end the trace.

The parameter n indicates the interface. If [n] is omitted, the
command refers to all interfaces.

n Interface n Interface n Interface
0 GSM1 6 GSM3 12 VolP 1
1 GSM2 7 GSM4 13 VolP 2
2 ISDN 1 Bf1 8 GSM5 14 VolP 3
3 ISDN1B2 9 GSM6 15 VolP 4
4 ISDN 2 Bt 10 GSM7 16 VoIP 5
5 ISDN2B2 11 GSM 8 17 VolP 6
18 VolP 7
19 VolP 8
DBG DTMF
Shows the incoming DTMF tones.
Start with DBG DTMF 7
Stop with DBG DTMF 0 (/ast character = zero digit)

The parameter 7 represents the highest possible trace level. With
4 you will receive only the most important messages while 0 will

end the trace.
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DBG VOICE

Shows the voice announcements generated by ECOTEL®.

Start with
Stop with

DBG VOICE 7
DBG VOICE 0 (/ast character = zero digit)

The parameter 7 represents the highest possible trace level. With
4 you will receive only the most important messages while 0 will

end the trace.

DBG ICON

Shows calls from ECOTEL® to the ISDN interface.

Start with
Stop with

DBG ICON[n] 7
DBG ICON[n] 0 (last character = zero digit)

The parameter 7 represents the highest possible trace level. With
4 you will receive only the most important messages while 0 will

end the trace.

The parameter n indicates the interface. If [n] is omitted, the
command refers to all interfaces.

This command |s available for the ISDN interfaces and also (only
with ECOTEL®voip) for the VolP interfaces that are handled
internally by ECOTEL® in a similar way. For the GSM interfaces,

see DBG GMAIN.

Interface

ISDN 1 B1
ISDN 1 B2
ISDN 2 B1
ISDN 2 B2

W N = O 3

N o o b~ S

Interface
VolIP 1
VolP 2
VolP 3
VolIP 4
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n Interface
8 VolP5
9 VolP6
10 VolP 7
11 VolP 8

ECOTEL® VolP/ISDN2-1/ISDN2-2



VIERLING

DBG GMAIN
This trace corresponds to DBG ICON for the GSM interfaces.

Start with DBG GMAIN[n] 7
Stop with DBG GMAIN[n] 0 (last character = zero digit)

The parameter 7 represents the highest possible trace level. With
4 you will receive only the most important messages while 0 will
end the trace.

The parameter n indicates the interface. If [n] is omitted, the
command refers to all interfaces.

n Interface n Interface

0 GSM1 4 GSM5

1 GSM2 5 GSM6

2 GSM3 6 GSM7

3 GSM4 7 GSM8
DBG VIO

Shows communication between ECOTEL® and the GSM module
(AT command set).

Vi Y Important: When traces of @type DBG VIO are enabled,
7 ' W, remote access to ECOTEL"™ via modem is not possible!

% Y Make sure you don'’t forget to switch these traces back off!

Start with DBG VIO[n] ASCII
Stop with DBG VIO[n] OFF

If you specify HEX instead of ASCII, the output will appear in
hexadecimal format (instead of text format).
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The parameter n indicates the interface. If [n] is omitted, the
command refers to all interfaces.

This command is available only for the GSM interfaces.

n Interface n Interface
1 GSM 1 5 GSM5
2 GSM2 6 GSM6
3 GSM3 7 GSM7
4 GSM4 8 GSM8

VOIP TRC (nur bei ECOTEL®Vorp)

Zeigt die Ereignisse auf der VolP-Baugruppe des ECOTEL®. Dies
ist vor allem zur Beobachtung des Bootvorgangs von Interesse.

Starten mit VOIP TRC ON
Stoppen mit VOIP TRC OFF

Querying additional information

Besides commands for traces, there are other commands that can
be used to query additional information from the device.

No stop command is required after the query is performed.

DIR Lists the files present on the ECOTEL® along with their
attributes.

SET Lists the configuration of the network parameters (IP
addresses, subnetwork masks).

VER Displays the firmware version.
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5 Introduction to the routing table
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5.1 Overview: Controlling the routing behavior of
ECOTEL

To a certain extent, the routing table represents the heart of the
ECOTEL® configuration. Here, you determine how the device
handles incoming calls.

The actual routing table is a text file with lines containing the
individual instructions. Using a special syntax, users can define
these instructions as required. This is the basis for a wide variety
of applications.

Content of the routing table

Each entry in the routing table consists of the following three
parts:

Condition / Calltype / Destination

Any call which meets the condition is connected to the specified
destination.

The following are some possible conditions: The dialed
destination number (or parts thereof); the originating number (or
parts thereof); the interface via which the call is received; the MSN
at which ECOTEL® was dialed. You can also combine several
different conditions to form a condition for an entry.

Besides the “normal call” call type, there are call types for which
ECOTEL® first calls back the caller before it connects him to the
destination. This means that the charges are incurred by
ECOTEL® and not by the caller. With another call type, it is
possible to block unwanted calls; here, there is no destination.
Management connections represent a special case in which
ECOTEL® is the actual destination. This is used for configuration
pUrposes.

The desired interface must be specified in the destination,
meaning at least the type (ISDN, GSM, VolP) and if desired, the
actual interface (BRI1, BRI2) or even a specific ISDN B channel.
The destination number which was dialed can be used
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unchanged, parts of it can be changed, or it can be replaced by
another number.

More information

First steps to create a new routing table are described here:
- 5.3 Strategy for the routing table

For a comprehensive reference to syntax elements, see:
== 6.4.3 The routing syntax

The Routing Wizard can be used to edit the routing table more
conveniently:

== 6.4.4 The Routing Wizard

The examples in this section of the manual illustrating the
organization of routing entries refer to this sample application:

—= 3.2 6 Connection as a LCR in PTP mode
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5.2 Structure of the table entries

Each entry in the routing table defines for calls which meet a
certain condition the desired termination point, i.e. the destination
to which the call is to be forwarded.

Each line is defined as follows:

(Condition1 ... Condition n) Call type Output port:Outgoing number
(0G1d01601234567) n G:d

=
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Note:

The routing table is processed from top to bottom. If an
exact entry is found, it is used and the search is
terminated.

The ? symbol substitutes for a single digit.
The * symbol substitutes for zero or more further digits.

General rule: Higher priority is given to an entry that does
not use the * wildcard. Single digits and ? have same
priority.

# marks the end of dialing.

If more than one possible entry exists after the end of
dialing, then the one listed highest in the table is executed.

If the call does not meet any of the conditions in the routing
table, it is rejected.

A # at the start of a line indicates that the whole line is a
comment. Use // to insert a comment at the end of a line.
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5.3 Strategy for the routing table

We recommend the following basic procedure for creating the
routing table:

Basic entries

For each interface which is used (V, I1, 12, G, efc.), create an
entry which covers all of the calls arriving from there and routes
them with an unmodified destination number to the desired
interface:

(oVd*#) n w-d
(ol1d*#) n X:d
(ol2d*#) n Y:d
(0Gd*#) n Z:d

Here, the wildcards W, X, Y, Z stand for interface names such as
V, I1, 12, G and so on.

The GSM interfaces can usually be grouped together, while the
ISDN interfaces are generally used differently (e.g. 11 is
connected to the fixed network, 12 to the PBX).

For the VolIP interface, you can (or must) specify for outgoing calls
whether they are to be handled via one of the configured SIP
outbounds 1 to 8 (port name V1, V2, ... in the routing entry) or
whether they should go to one of the locally managed users (port
name V). For incoming calls, there is only the common port name
V. This means that routing cannot distinguish between incoming
VolP ports.

Information about how to create basic entries can be found under
the connection types:

== 3.2 ISDN interface: Selecting the ISDN connection type
== 3.3 VOoIP interface: Sample applications
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Special cases

Next, insert the desired special cases and exceptions before the
relevant basic entry, e.g.:

(oVd*#) n 12:d
(ol1d*#) n 12:d
(012d0160*#) n G:d
(ol2d*#) n 1:d
(0Gd*#) n 12:d

For calls which arrive via 12, the following distinction is made: If
the destination number begins with 0760..., the special entry is
found first and the call is routed to GSM. In all other cases, the
basic entry applies and the call is routed to I1.

For calls via the other interfaces, the basic entry applies.

In this manner, you can gradually refine your routing tables by
inserting additional exceptions. Make certain that in each case
there is an entry for all of the “remaining” cases since a call will be
rejected if there is no relevant entry.
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5.4 Outgoing calls

The routing can be made dependent on the destination number
which the caller chooses.

A specific interface for termination can be specified by using the
originating telephone number.

However, it is also possible to specify a number which is different
than the original telephone number for termination. In this manner,
it is possible to define speed dialing numbers, for example.

The important thing is that ECOTEL® must be able to recognize
the end of a sequence of dialing digits. A fixed definition for the
number of digits can be used, or the end of dialing indicator # can
be used.
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5.4.1 Calls to an arbitrary mobile network connection

Example 1:

Dial the phone number 01601234567 in the GSM network.
Entry in the routing table:

(d01601234567) n G:d

l@ Note: The d character signifies that the number sequence
having been dialed is to be utilized as the destination
phone number.

Example 2:

Dial the phone number 0160<and exactly 7 additional digits> in
the GSM network.

Entry in the routing table:
(d0160??2?2?27) n G:d

l@ Note: The ? wildcard indicates that a single arbitrary
dialing digit follows.
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Example 3:

Dial the phone number 0160<and exactly 4 additional digits>123
in the GSM network.

Entry in the routing table:
(d0160????123) n G:d

Example 4:

Dial the phone number 0160<and at least 4 additional digits> in
the GSM network.

Entry in the routing table:
(d0160???2?2%#) n G:d

l]&? Note: If phone numbers have different lengths, then the
asterisks (*) wildcard can be used to signify either that no
dialing digits follow or that an arbitrary number of dialing
digits follow.

For such entries, the end of dialing symbol (#) is required
since the actual length of the phone number is lost in the
process. If the dialing procedure is terminated with #, then
it will be immediately executed. Otherwise, dialing will only
be executed after expiration of the dialing timeout.

This timeout can be configured in the Gateway
Configuration module under Properties.

Example 5:

When dialing the phone number 0160<and an arbitrary number of
additional digits>, dial the fixed phone number 01601234567 in
the GSM network.

Entry in the routing table:
(d0160*#) n G:01601234567
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Example 6:

When using speed dialer 10, dial the phone number 01601111111
in the GSM network; for speed dialer 12, dial the phone number
01601234567, and for speed dialer 123, dial the phone number
01607654321.

Entry in the routing table:

(d10) n G:01601111111
(d12#) n G:01601234567
(d123) n G:01607654321

l]&? Note: The ambiguity of speed dialing entries must be taken
into consideration. The general rule is: The shortest entry
will be used if other entries exist having identical starting
sequences. Accordingly, such entries require the number
symbol (#) to indicate the end of the number being dialed.

Example 7:

When dialing the phone number 01604, 01605, 01606 or
01609<and an arbitrary number of additional digits>, module 1
should be used to connect to the GSM network. For all other
phone numbers starting with 0160<and an arbitrary number of
additional digits>, module 2 should be used to connect to the
GSM network.

Entry in the routing table:

(d0160[4-69]*#) n G1:d
(d0160*#) n G2:d

l@ Note: Using entries in "[ ]", several permissible digits can
be specified at a specific position.
This can be used to keep the routing table short in case
you need to cover numbering variations.
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Example 8: Invalid entry

Dial the phone number 0160<and an arbitrary number of
additional digits>11 in the GSM network.

Entry in the routing table:
(d0160*11#) n G:d

l]ﬁ? Error: The * wildcard may not be used within a routing
entry.
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5.4.2 Calls to an arbitrary fixed network connection

Example 1:

Dial the phone number 0999123456 in the fixed network.
Entry in the routing table:

(d0999123456) n 1:d

Example 2:

Dial the phone number 0999<and exactly 6 additional digits> in
the fixed network.

Dial the phone number 0888<and exactly 3 additional digits>23 in
the fixed network.

Entry in the routing table:

(d09992?2?27?) n I1:d
(d0888???23) n I1:d
Example 3:

Dial the phone number 0999<and at least 3 additional digits> in
the fixed network.

Entry in the routing table:
(d0999?2?*#) n I1:d

Example 4:

When dialing 0999<and an arbitrary number of additional digits>,
dial the phone number 1234567 in the fixed network.

Entry in the routing table:
(d0999*#) n 11:1234567
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Example 5:

When using speed dialer 10, dial the phone number 1111111 in
the fixed network; for speed dialer 11, dial the phone number
222222 in the fixed network; and for 112, dial the emergency
number 112 in the fixed network.

Entry in the routing table:

(d10) n 1:111111
(d11#) n 11:222222
(d112) n 1:112

Example 6: Invalid entry

When dialing 0999<and an arbitrary number of additional
digits>11, dial the selected phone number in the fixed network.

Entry in the routing table:
(d0999*11#) n 1:d

l@g Error: The * wildcard may not be used within a routing
entry.
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5.4.3 Calls to a VolP connection

g Note: This capability is only available with ECOTEL“VolP.

Example 1:

Dial the phone number 032123456 in the local VoIP network.
Entry in the routing table:

(d032123456) n Vd

Example 2:

When dialing 032<and an arbitrary number of additional digits>,
dial the phone number 1234567 in the VolP network via SIP
outbound 1.

Entry in the routing table:
(d032*#) n V1:1234567

Example 3:

When using speed dialer 10, dial the phone number 1111111 in
the VolP network; for speed dialer 11, dial the phone number
222222 in the VolP network via SIP outbound 2.

Entry in the routing table:

(d10) n V2:111111
(d11#) n V2:222222
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5.4.4 Calls to an arbitrary extension

Example 1:

Dial the phone number for extension 1234.
Entry in the routing table:

(d1234) n 12:d

Example 2:

Dial the phone number for extension 1<and exactly 3 additional
digits>.

Entry in the routing table:
(d122?) n 12:d

Example 3:

Dial the phone number for extension 2<and at least 2 additional
digits>.

Entry in the routing table:
(d2?22*#) n 12:d

Example 4:

When dialing O<and an arbitrary number of additional digits>, dial
the extension 4567.

Entry in the routing table:
(dO*#) n 12:4567
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5.4.5 Forwarding special characters in the destination
number / Selective CLIR function

The special characters * and # can be used in the output string of
a routing entry.

l@ Note: In the output string, the character * must be entered
as \* while # can be used directly.

This option is useful, for example, for using the CLIR function
selectively with phone numbers.

Example 1:

Calls from BRI1 to a number 0160... are routed to GSM1 and the
CLI is transmitted.

(ol1d0160*#) n G1:\*31#d

Example 2:

Calls from BRI1 to a number 0179... are routed to GSM2 and the
CLI is not transmitted.

(ol1d0179*#) n G2:#31#d

l@ Note: CLIR can be controlled on a call by call basis using
DTMEF dialing.

*31# CLI is transmitted
#31# CLI is not transmitted

The following setting is required in ECOTEL®:

Gateway Configuration module

> GSM Interface 1 (2, 3, ...)

> CLIR (outgoing calls)

> Support depends on your service provider and is
> not used.
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5.5 Incoming calls

The routing can be also made a function of the number of the
caller.

It is also possible to use different MSNs of the ECOTEL® in order
to direct calls to different destinations. This allows the actual caller
to control the routing behavior by choosing the appropriate MSN.
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5.5.1 Calls from specific numbers

Example 1:

(Only with ECOTEL®voir:) When called by the subscriber with the
phone number 01605555555, dial the phone number 1234567 in
the local VolP network.

When called by the subscriber with the phone number 1234567,
dial the phone number 01605555555 in the GSM network.

When called by the subscriber with the phone number 98765, dial
extension 34.

Entry in the routing table:

(001605555555) n V:1234567
(01234567) n G:01605555555
(098765) n 12:34

Example 2:

When called by subscribers with the phone number 0160<and
exactly 7 additional digits>, dial the phone number 1234567 in the
fixed network.

(Only with ECOTEL®voir:) When called by subscribers with the
phone number 123<and exactly 4 additional digits>, dial the
phone number 03205555555 in the local VolP network.

Entry in the routing table:

(00160???22??2?7) n 11:1234567
(01232??27?) n V:03205555555
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Example 3:

When called by subscribers with the phone number 0160<and
exactly 4 additional digits>123, dial the phone number 1234567 in
the fixed network.

When called by subscribers with the phone number 123<and
exactly 2 additional digits>44, dial the phone number
01605555555 in the GSM network.

Entry in the routing table:

(00160????123) n 11:1234567
(0123?244) n G:01605555555
Example 4:

When called by subscribers with the phone number 0160<and at
least 4 additional digits>, dial extension 42.

(Only with ECOTEL®voir:) When called by the subscriber with the
extension 4<and at least 1 additional digit>, dial the phone
number 032123456 in the local VolP network.

Entry in the routing table:

(001602222*#) n 12:42
(0472%#) n V:032123456
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Example 5: Invalid entry

When called by subscribers with the phone number 0160<and an
arbitrary number of additional digits>11, dial the fixed phone
number 1234567 in the fixed network.

When called by subscribers with the phone number 123, dial a
phone number which is not present in the GSM network.

Entry in the routing table:

(00160*11) n 11:1234567
(0123) n G.d

l@ Error: The * wildcard may not be used within a routing
entry.

l@ Error: The d character may not be used without specifying
a destination phone number.
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5.5.2 Calls to a specified MSN

Example 1:
When dialing ECOTEL® MSN 5671234, dial extension 42.

When dialing ECOTEL® MSN 5671235, dial the phone number
01606666666 in the GSM network.

(Only with ECOTEL®voir:) When dialing ECOTEL® MSN 5671236,
dial the phone number 0321234567 in the local VolIP network.

Entry in the routing table:

(m5671234) n 12:42
(m5671235) n G:01606666666
(m5671236) n V:0321234567

l@ Note: ECOTEL? can accommodate up to 10 MSN entries
per ISDN interface. These calls can be routed to various
destinations depending upon the MSN which is dialed.
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5.6 Port-specific calls

The routing behavior can also be made a function of the interface
(= port) on which the call arrives. The outgoing port can also be
specified. With the ISDN interfaces, it is also possible to
distinguish between the B channels.
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5.6.1 Routing based on the interface

Example 1:

When called by the subscriber via any mobile radio module, dial
the phone number 1234567 in the fixed network.

When called by a fixed network subscriber, dial the phone number
01605555555 in the GSM network using any mobile radio module.

When called by a PBX subscriber, dial the phone number
01606666666 in the GSM network using mobile radio module 2.

(Only with ECOTEL®voir:) When called by a VolP network
subscriber, dial the phone number 01607777777 in the GSM
network using any mobile radio module.

Entry in the routing table:

(0G) n 11:1234567

(ol1) n G:01605555555
(ol2) n G2:01606666666
(oV) n G:01607777777
Example 2:

When called by subscribers using any mobile radio module with
the phone number 0160<and exactly 7 additional digits>, dial the
fixed phone number 1234567 in the fixed network.

Entry in the routing table:
(0G:01602?222227?) n 11:1234567
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Example 3:

When called by subscribers using mobile module 1 with the phone
number 0160<and at least 4 additional digits>, dial extension 42.

When called by a subscriber with the extension 4<and at least 1
additional digit>, dial the phone number 123456 in the fixed
network.

Entry in the routing table:

(0G1:0160??2??2*#) n 12:42
(ol2:4?*#) n 11:123456
Example 4:

(Only with ECOTEL®voir:) When called by a subscriber via the
VolIP network, dial the selected phone number of any arbitrary
length in the fixed network.

When called by a subscriber from the fixed network, dial the
selected phone number of any arbitrary length in the GSM
network via any mobile radio module.

When called by a PBX subscriber, dial the phone number
01606666666 in the GSM network using mobile radio module 2.

Entry in the routing table:

(oVd*#) n 1:d
(ol1d*#) n G:d
(ol2) n G2:01606666666
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5.6.2 B-channel routing

By indicating the input port in the condition as well as the
destination port, it is possible to distinguish the ISDN B channels.

Example 1:

Calls from B channel 1 of interface BRI1 are to be routed to GSM
interface 1.

Calls from B channel 2 of interface BRI1 are to be routed to GSM
interface 2.

Entry in the routing table:

(ol11d*#) n G1:d
(ol12d*#) n G2:d
Example 2:

Calls from GSM interface 1 are to be routed to B channel 1 of
interface BRI2.

Calls from GSM interface 2 are to be routed to B channel 2 of
interface BRI2.

Entry in the routing table:

(0G1d*#) n 121:d
(0G2d*#) n 122:d
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5.7 Blocking calls

Another possible routing behavior involves rejecting the call
instead of forwarding it to a destination. Of course, in this case the
routing entry will not contain a destination.

5.7.1 Blocking calls from specific originating humbers

Example 1:
Dialing in from the fixed network is blocked for all subscribers.

Dialing in from the GSM network is blocked for subscribers with
phone numbers 0160<and any arbitrary number of additional
digits>.

Entry in the routing table:

(ol1) b
(0G:0160%) b

5.7.2 Blocking calls to specific destination numbers

Example 1:

Dialing 0190<and any number of additional digits> is blocked for
all subscribers.

Dialing 0160<and any number of additional digits> is blocked for
all extension subscribers.

Dialing international subscribers starting with 00<and any number
of additional digits> is blocked for all GSM network subscribers.

Entry in the routing table:

(d0190%)
(ol2d0160*)
(0Gd00*)

OUTUT
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5.8 Date- and time-dependent routing

The validity of routing entries can be limited in terms of time. The
condition must be extended as follows:

Example 1:
The first routing entry is valid only from Monday to Wednesday.

The second routing entry is valid on Monday and also from Friday
to Sunday.

Entry in the routing table:

(-..w1-3)
(...w15-7)

5~ Note: The w character can be used to indicate that the
routing entry is to be valid only on certain days of the week.

Days of the week are entered as numbers:
1=Monday ... 7=Sunday
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Example 2:

The first routing entry is valid from December 31, 2004 to January
7, 2005.

The second routing entry is valid each year on December 31.

The third routing entry is valid from January 1, 2004 to September
30, 2004.

Entry in the routing table:

(...c04/12/31-05/01/07)
(...c*112/31-*/12/31)
(...c04/01/01-04/0?/30)

l@ Note: The ¢ character can be used to indicate that the
routing entry is valid only on certain days of the year.

The date format is yy/mm/dd.
You can also use the * and ? wildcards.

Example 3:

The first routing entry is valid daily from 00:00:00 to 12:00:00.
The second routing entry is valid daily from 00:00:00 to 09:00:00.
Entry in the routing table:

(...t00:00:00-12:00:00)
(...t00:00-9:00)

l@g Note: The t character can be used to indicate that the
routing entry is to be valid only at certain times of day.

The time of day format is hh:mm:ss.
Seconds and leading zeros may be omitted.
You can also use the * and ? wildcards.
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Example 4:

The routing entry is valid for calls which arrive from interface BRI1
and which have as their destination the speed dial number 78 but
only Monday through Friday or Sunday, and only from March 1 to
December 31, 2004, in each case between midnight and noon.

Entry in the routing table:
(ol1d78w1-57c04/03/01-04/12/31100:00-12:00)

l@g Note: You can combine the various types of conditions
(origin, destination, time, etc.) in various ways. An AND
operation is used, i.e. each and every condition must be
fulfilled for routing based on the entry to be performed.
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5.9 Automatic callbacks

Sometimes it is desirable to exchange the roles of the calling party
and the called party so that the called party can bear the cost of
the call, for example.

For this purpose, ECOTEL® can, instead of immediately
forwarding a call to a destination, first establish a connection back
to the caller and then connect the caller to the actual destination
via this connection.

A callback is made when the original call fulfills a condition which
is defined in the routing table as a callback trigger. This can be the
dialed destination number (dialing callback) or the originating
number from which the call comes (non-dialing callback).

First, the original call must be terminated either automatically by
ECOTEL® (with disconnect, meaning: by ECOTEL®) or by the
caller so that he himself can control the disconnect time point
(without disconnect).

After a delay of 10 seconds, ECOTEL® initiates the callback to the
number provided in the routing table (for example, you can
indicate that the calling number is to be used). Once the callback
has been established, the caller can dial the actual desired
destination number (e.g. an extension). ECOTEL® then connects
the caller to this number.

Besides lower rates, this technique is used typically for
management connections to ECOTEL® (the called party must
have a SIM card which is capable of handling data).
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5.9.1 Dialing callback with disconnect

The caller dials ECOTEL® and is connected to ECOTEL®. He
dials a number which is defined in the routing table as an

automatic callback. Then, the connection is disconnected by
ECOTEL®.

In about 10 seconds, ECOTEL® calls back the defined number.
The delay is necessary in order to allow the caller to hang up.

The caller answers the callback and is connected to ECOTEL®.
Any number that is defined in the routing table can now be dialed
by the caller.

Example 1:

The caller dials the number 123 and is disconnected immediately.
The call is returned over the same port under the number
01601234567.

Entry in the routing table:
(d123) c &:01601234567

l@ Note: The & sign signifies that the same port is to be used
for callback.

Example 2:

The caller dials the number 123 and is disconnected immediately.
The call is returned using mobile radio module 2 in the GSM
network under the number 01601234567 .

Entry in the routing table:
(d123) c G2:01601234567
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Example 3: Invalid entry

The caller dials the number 123 and is disconnected immediately.
The call is returned in the GSM network over mobile radio module
2 under a phone number which is not available.

Entry in the routing table:
(d123) c G:d

J &~  Note: Avalid callback number must be specified in
ECOTEL®.
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5.9.2 Dialing callback without disconnect

The caller dials ECOTEL® and is connected to ECOTEL®. He
dials a number which is defined in the routing table as an
automatic callback. After that, the caller hangs up.

In about 10 seconds, ECOTEL® calls back the defined number.
The delay is necessary in order to allow the caller to hang up.

The caller answers the callback and is connected to ECOTEL®.
Any number that is defined in the routing table can now be dialed
by the caller.

Example 1:

The caller dials the number 123, disconnects and is called back
over the same port under the number 01601234567

Entry in the routing table:
(d123) P &:01601234567

Example 2:

The caller dials the number 123, disconnects and is called back in
the GSM network using mobile radio module 2 under the number
01601234567 .

Entry in the routing table:
(d123) P G2:01601234567
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5.9.3 Non-dialing callback with disconnect

If an immediate callback has been defined for a caller, then
ECOTEL® disconnects immediately so the call never goes
through.

In approximately 10 seconds, ECOTEL® then calls back the
number that is defined in the routing table.

The caller answers the callback and is connected to ECOTEL®.
Any number that is defined in the routing table can now be dialed
by the caller.

Example 1:

The caller with the number 01601234567 is immediately
disconnected and is called back over the same port.

Entry in the routing table:
(001601234567) i &:0

l@ Note: The o character indicates that the number of the
originating subscriber is to be used as the destination
phone number.

Example 2:

Callers with the number 0160<and an arbitrary number of
additional digits> are disconnected immediately and a callback is
made in the GSM network using mobile radio module 2 under the
number 01601234567

Entry in the routing table:
(00160%) i G2: 01601234567

s~  Note: The phone number that is calling ECOTEL® must
not be suppressed (CLIR).
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5.9.4 Non-dialing callback without disconnect

If a non-dialing callback without disconnect is defined for a caller,
then the caller hears the ring tone until he hangs up and the call
never goes through. In approximately 10 seconds, ECOTEL® then
calls back the number that is defined in the routing table.

The caller answers the callback and is connected to ECOTEL®.
Any number that is defined in the routing table can now be dialed
by the caller.

Example 1:

The caller with the number 01601234567 is called back over the
same port as soon as he disconnects the call.

Entry in the routing table:
(001601234567) d &:0

Example 2:

As soon as they disconnect the call, callers with the number
0160<and any number of additional digits> are called back in the
GSM network over mobile radio module 2.

Entry in the routing table:
(00160%) d G2:.0

l@ Note: The phone number that is calling ECOTEL? must
not be suppressed (CLIR).
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5.10 Remote configuration via GSM

For remote configuration via GSM, data calls must be established
between the calling and called devices. The called device needs a
SIM card which is capable of handling data.

If it is certain that the device to be configured has such a card, the
management call can be made directly. Otherwise, a callback
technique is needed for access from a device that has data
capabilities.

Example 1:

The caller with the number 01601234567 directly establishes a
remote configuration call.

Entry in the routing table:
(001601234567) n M

Example 2:

The caller with the number 01601234567 is disconnected
immediately and a remote configuration call is set up using mobile
radio module 2 under the number 01602222222.

Entry in the routing table:
(001601234567) im G2:01602222222

Example 3:

The caller with the number 01601234567 dials the number 5555,
is disconnected immediately and a remote configuration call is
made using the same radio module to the number 01601234567

Entry in the routing table:
(0G:01601234567d5555) cm &:0
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5.11 Default configuration

The default routing table is as follows It corresponds to the sample
application:

—=» 3.2.6 Connection as a LCR in PTP mode

(oVd*#) n G:d
(oGd*) n 12:d
(ol2d*#) n G:d
(ol1d*) n 12:d
(oG1d<Access code>*#) cm G1:*

(0G2d<Access code>*#) cm G2:*

l@g Note: The first entry (0V...) ... ... only appears for
ECOTEL®Vorp.
VA Y Warning: The last two entries of type (...) cm ... are

_;:f" ' “‘x*.;.‘_ required for remote access via modem. Think twice before
4 @ % you delete them!

Explanation of the default routing entries

When subscribers dial in via the VolP network, the dialed number
of any arbitrary length is dialed via any radio module. (This entry
is only used with ECOTEL®volp.)

When subscribers dial in via any radio module, the dialed number
of any arbitrary length for an extension is dialed.

When subscribers dial in from an extension, the dialed number of
any arbitrary length is dialed via any radio module.

When subscribers dial in via the fixed network, the dialed number
of any arbitrary length for an extension is dialed.

When subscribers dial in via radio module 1, an immediate
disconnect occurs following input of the access code for the
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module (8-digit number consisting of the first 2 and the last 6
digits of the IMEI) followed by the callback number. Then, a
remote configuration call is made via radio module 1 under the
callback number.

When subscribers dial in via radio module 2, an immediate
disconnect occurs following input of the access code for the
module (8-digit number consisting of the first 2 and the last 6
digits of the IMEI) followed by the callback number. Then, a
remote configuration call is made via radio module 2 under the
callback number.
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5.12 User scenario

A typical user scenario is described below which should be self-
explanatory.

International emergency number authorized for everyone via the
GSM network

(d112) n G:d
Numbers starting with 0190 blocked for everyone
(d0190%) b

Numbers dialed from any extension,
Starting with 0160 always via GSM network 1

(012d016022272*#) n G1:d

Numbers dialed from any extension,
starting with 0161 always via GSM network 2

(012d01612222*#) n G2:d

Numbers dialed from extension 10,
starting with 00 always via the fixed network

(012:10d00*#) n 1:d

Numbers dialed from any extension,

starting with 00 blocked for everyone;

Allowed only for extension 10 since the previous condition was
fulfilled

(ol2d00*#) b

Numbers dialed from any extension,
starting with 0 always via the fixed network

(ol2d0*#) n I1:d

Numbers dialed from the fixed network with 2 or more digits,
to the corresponding extension

(ol1d??*#) n 12:d
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For the caller with the phone number 01601234567, an automatic
callback is set up via GSM network 1

(001601234567) i G1:d
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6 Reference: Operating elements of the
configuration software
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6.1 Overview: The operating elements

This section contains a description of all the operating elements
including the menu items, input fields and buttons. The help texts
are arranged according to their location in the user interface.

Please be aware that this manual always refers to the latest
interface version for each module. Older interface versions can
differ from what is described here. For more details about
interface versions, see:

== 8.2 Interpretation of the interface version

Page 140 Edition 3.2-EN — 20060530 ECOTEL® VolP/ISDN2-1/ISDN2-2



VIERLING

6.2 Service Gear module

The Service Gear module is the first to appear after the program
is launched. From there, you can access the other modules.

Using ECOTEL® Service Gear, you can configure and administer
any number of devices of different tgpes. These devices are
typically GSM gateways (e. g. ECOTEL®volp, ECOTEL®isDN2-1).

You can also manage modems here. These are also devices
which are used specifically as an access portal for remote
configuration of the “devices” described above.

For each device or modem, a data set is created which describes
the device and its configuration interface.

Database

The database uses a directory structure on the computer in which
the configuration data sets are stored for all of the devices and
modems. The folders are located in the installation directory of the
Service Gear software in the EcotelData subdirectory.

Devices/modems

You can create objects to be managed under the devices or
modems nodes. For each physical device or modem which is to
be managed and configured using the Service Gear software, a
device or modem data set must exist in the database.

Devices are the gateways which are used for the actual telephone
traffic.

As a general rule, a modem is a gateway which is used to set up a
connection to the device to be configured via GSM and transmit
its configuration data.

Groups

Devices (but not modems) are grouped together to form a node in
the tree. Using a group name, you can group together, e.g. all of
the devices at a particular location, for a particular operator or
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having the same properties (SIM cards from the same provider,
etc.). Groups can also be arranged hierarchically within other
groups.

See also the following sections for information about the operating
elements in the main window and the individual dialog windows.
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6.2.1 Service Gear: Main window

Call: Launch using Start > Programs> ECOTEL Service Gear.
The Service Gear main window will appear also if you are inside
another module and you close it.

The left half of the start window shows all of the relevant devices
and modems in a tree structure. You can group together several
devices, e.g. devices at a common location or for a common user.
Groups can also be arranged hierarchically within other groups. At
least one group level must exist.

You can add new devices and modify or delete the data for
existing devices. The detailed data for the currently selected
device are shown in the right half of the window.

You can open the form for editing the configuration data by
clicking on the Properties button.

From Service Gear, you can access the various modules for
configuring or administering the currently selected gateway (Tools
> Start...).

File
Close Ends the application.
Edit
Add Group Adds a new group below the selected group.
Add Device Add a new device to the selected group. At
least one group must exist below the devices
node.
Add Modem Adds a new modem.
Cut, Copy, Paste = These are the usual Windows functions.
Delete Removes the selected element from the
database.
Properties Opens a dialog for editing the properties for the

selected element.
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Tools
Debug...

Language...

Start

=

Help
Contents...
Info...

Print...
(Tree view)

(Properties window)

Properties

(Status line)

(1st field)
(2nd field)

=

Opens an additional Debug Info window with
detailed information about the communication
between ECOTEL® and your configuraton
computer.

Allows you to select the language for the user
interface.

Changes to another module within the ECOTEL
configuration software (selected in the
submenu)

Note: You can also switch to Gateway
Configuration by double-clicking on the desired
gateway.

Opens the content page for the online help.

Shows information about the product version
and manufacturer.

Opens a PDF version of the help pages which
you can print.

Shows all of devices and modems which are
available for a data set.

Shows the properties for the selected element.
For more information about the individual fields,
see also the description of the Properties
dialogs in the following sections.

Opens a dialog for editing the properties.

The status line at the bottom edge of the
window provides additional information:

Reference to the selected tree node

Directory in which the files for the selected
device are saved (with the default program
installation, this will be
C:\Programme\Vierling\ECOTEL_Service _Gear
\EcotelData)

Note: Many of these functions can also be
accessed using the context menu (right mouse
click on an element in the tree view).
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6.2.2 Service Gear: Properties Group

Call: In the Service Gear start window, select a group in the tree
view and click on the Properties button.

Group name A user-selectable name for the group.
OK / Cancel Closes the dialog with or without accepting the
changes.
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6.2.3 Service Gear: Properties Device

Call: In the Service Gear start window, select a device in the tree
view and click on the Properties button.

Before they are stored, the entries are checked to make sure they
are within the permissible range of values. If there are any errors,
an error message is displayed and the first field with an invalid
entry is highlighted.

Device name User-selectable name for the gateway.

Device type Type of deV|ce to be man 8ed e.g.
ECOTEL®VolP or ECOTEL"ISDN2-1.

Access via Interface which provides access to the device
for configuration purposes.

s Note: Usage of the Modem interface has
certain peculiarities compared to the other
interfaces.
== 4.3.2 Connecting via modem

'&9 Note: The RS232 interface (serial) can be used

only with ECOTEL®ISDN2-1 and the USB
interface not with ECOTEL®ISDN2-1.

COM port Number of the serial or USB interface of the PC
via which the gateway is to be configured. This
field is activated only if USB or RS232 is
selected as the interface.

l@ Note: The USB interface must be provided with
a driver to emulate a COM port. For more
information, see

- 2.2.4 Setting up the USB interface

Select the appropriate COM number here
(generally, COM3 or COM4).

IP address IP address of the gateway via which it can be
accessed in the LAN by Service Gear for
configuration purposes. This field is activated
only if IPis selected as the interface.
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Security code A secret code which is sent when accessing the
selected configuration interface. Enter the
security code for ECOTEL® into this field.

You can enter or modify the security code
stored in ECOTEL® under Tools > Start >
Firmware Tools > Security Code.

The usage of a security code is optional. If you
leave the Security Code field blank, the security
code will be queried each time you access the
configuration interface of ECOTEL®.

Call number for Number which the gateway calls back for

remote access remote configuration via GSM. The callback is
initiated by a modem call and transfer of the
access code for remote access. This field is
activated only if Modem is selected as the
interface.

Access code The access code for remote access is needed
for remote configuration via GSM. Remote
configuration of a gateway via GSM is initiated
by a call from a modem to the corresponding
gateway. An access code for remote access is
transmitted to the gateway and the connection
is terminated. If this access code for remote
access is identical to the access code stored in
the gateway, the gateway to be configured
begins a callback to the modem so that the
configuration data can be exchanged. This field
is activated only if Modem is selected as the
interface.

Modem Here, you can select a modem stored in the
database for remote configuration. This field is
activated only if Modem is selected as the
interface.

OK / Cancel Closes the dialog with or without accepting the
changes.

For additional information about remote access via modem:
== 4.3.2 Connecting via modem
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6.2.4 Service Gear: Properties Modem

Call: In the Service Gear start window, select a modem in the tree
view and click on the Properties button.

Before they are stored, the entries are checked to make sure they
are within the permissible range of values. If there are any errors,
an error message is displayed and the first field with an invalid
entry is highlighted.

Modem name User-selectable name for the modem.
Device type Type of gateway to be managed wh|ch will be
used as a modem, e.g. ECOTEL® or
ECOTEL®ISDN.
Access via Interface which provides access to the modem
for configuration purposes.
l]@? Note: The RS232 interface (serial) can be used

only with ECOTEL®ISDN2-1 and the USB
interface not with ECOTEL®ISDN2-1.

COM port Number of the serial or USB interface of the PC
via which the modem is to be configured.
Activated only if USB or RS232is selected as
the interface.

IP address IP address of the modem via which it can be
accessed in the LAN by Service Gear for
configuration purposes. This field is activated
only if IPis selected as the interface.

Security code A secret code which is used when accessing
the selected configuration interface. The usage
of a security code is optional.

Callback number Telephone number at which the modem can be

(Data mode) reached by the gateway which calls it back.
Data service must be enabled for this number.

OK / Cancel Closes the dialog with or without accepting the
changes.
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6.3 Gateway Configuration module

In the Gateway Configuration module, the data relating to the
hardware of the selected device are displayed. Depending on the
device type, the parameters for each GSM module, each ISDN
channel and the VolIP interface might be displayed, for example.

When the software is launched, the most recently saved configu-
ration of the device is displayed. If the configuration file for the
device has not yet been created, a message is displayed when
the Gateway Configuration module is opened along with a request
to create a new file.

You can either create a new configuration with the menu item File
> New... or read the configuration data from the connected
gateway.

When opening a new configuration file, a window opens in which
you must select the currently installed firmware configuration in
ECOTEL®. Based on this selection, the corresponding configu-
ration fields are displayed for the functions available in this
firmware version. You can then save the configuration. You
should use the suggested default directory. As the filename for
the configuration file, we recommend that you use ECOTEL.UPB
so that the configuration file will be automatically displayed the
next time you launch the software.

See also the following sections for information about the operating
elements in the main window and the individual configuration
pages.

ECOTEL® VolP/ISDN2-1/ISDN2-2 Edition 3.2-EN — 20060530 Page 149



VIERLING

6.3.1 Gateway Configuration: Main window

Note: The main window is labeled ECOTEL Configuration
Software in the title bar. It is distinguished from the main window
of the Basic Configuration module by the different tree view.

Call: From any of the modules, using Tools > Start > Gateway
Configuration. From the Service Gear module also by double
clicking on the corresponding device in the tree view.

l@ Note: If access via the Modem interface is configured for
the device, you need to set up a remote access connection
before you can call up the Gateway Configuration module.

In the left half of the Gateway Configuration module window, all of
the elements to be configured are shown as separate nodes in a
tree view. From many of the elements (e.g. GSM, ISDN or VolP),
it is possible to access lower levels which group together special
parameters.

In the right half of the window, the parameters are displayed for
the selected tree node. Before they are stored, all of your changes
are checked to make sure they are within the permissible range of
values. Errors are indicated by an exclamation point in a red
circle. If you move the mouse pointer over the exclamation point,
the expected range of values will be displayed.

(Title bar) Next to the title (ECOTEL Configuration
Software), the name of the currently opened
configuration file might be displayed (file type
*UPB,).

File

Default... Opens a new configuration file with the original
values when the device was shipped from the
factory. This also corresponds to the menu item
File > New.
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New...

Open...

Save
-

Save As...

=

Exit

Transfer

Save in ECOTEL...

@
=

Read from
ECOTEL...

g
=

VIERLING

Opens a new configuration file with standard
values. In a dialog window, you must select the
firmware version for the configuration.
Depending on the selected version, the relevant
parameters are enabled in the user interface
and written into the configuration file.

Displays an Open File dialog so you can search
for an existing configuration file. This looks for
files of type *.UPB in the folder which is linked
to the current device in the Service Gear
database.

Saves the configuration file which is currently
open.

Displays the Windows Save File dialog for
saving the current configuration file under a
different name.

Note: When you open the Gateway
Configuration module, the software
automatically looks for configuration file named
ECOTEL.UPB and opens it if it exists. We
recommend that you use this file name since
otherwise you will have to manually open the
configuration file each time.

Exits the Gateway Configuration module and
returns to the Service Gear module.

Transmits the current configuration file to
ECOTEL®.

Note: The transmitted file is always saved on
ECOTEL? under the name ECOTEL.UPB.

Loads the configuration file ECOTEL.UPB from
ECOTEL® and displays the values it contains.

Note: When reading from ECOTEL@, the
configuration file which is currently open is
discarded and the changes are not saved.

The file which is read in is unnamed at first; you
have to enter a file name when you save it.

ECOTEL® VolP/ISDN2-1/ISDN2-2 Edition 3.2-EN — 20060530 Page 151



VIERLING

Reboot

G,

Preferences

Preferences...

Help
Contents...
Print...

About...

Tools
Start

(Tree view)
(Detail window)

Page 152
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Causes ECOTEL® to restart.

Warning: A restart will interrupt all of the
telephone connections which are currently
running via ECOTEL®)

Opens the Preferences dialog (required only for
internal use)

Opens the content page for the online help.

Opens a PDF version of the help pages which
you can print.

Shows information about the product version
and manufacturer.

Changes to another module in the ECOTEL
configuration software (selected in the
submenu)

Displays the available configuration pages.

Displays detailed information about the selected
configuration page. For more information about
the individual fields, see also the description of
the configuration pages in the following
sections.
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6.3.2 Gateway Configuration: Properties

Call: In a Gateway Configuration main window, select the

Properties tree node.

Codes
International

National

Country code

Device properties
Daily reset at

Timeout first digit

The sequence of numbers which must be dialed
prior to the country code in order to access a
foreign network from the local telephone
network (default: 00).

Digit which must be dialed prior to the actual
number of the subscriber in order to access
another region outside of the local region
(default: 0). In certain countries, the national
prefix is not necessary for international calls.

Code for the country in which ECOTEL® is
located (e.g. Germany: 49).

This allows ECOTEL®, for example, to properly
identify domestic numbers regardless of
whether they are transmitted with 0049, +49 or
without a prefix.

Time of day at which the device is to be
restarted daily. This should be entered in the
format hours : minutes.

If the control box is deactivated, there is no
restart.

If no further digits are dialed within the time
which is set here following the entry of the first
digit of a number, then ECOTEL® will begin to
dial the number. You can skip the timeout by
pressing the # key after the last digit. ECOTEL®
will immediately begin your call.

ECOTEL® VolP/ISDN2-1/ISDN2-2 Edition 3.2-EN — 20060530 Page 153



VIERLING

Timeout further If no further digits are dialed within the time

digits which is set here following the entry of each
additional digit of a number, then ECOTEL® wiill
begin to dial the number. You can skip the
timeout b% pressing the # key after the last digit.
ECOTEL" will immediately begin your call.
A telephone number can have a maximum of
20 digits. After entry of the 20th digit, the
ECOTEL® will automatically begin the call. Any
further digits are ignored.

Speech This setting determines in what phase of call
connection on setup the speech channels are switched
through in ECOTEL®.
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6.3.3 Gateway Configuration: ISDN Interface 1/2

Call: In the Gateway Configuration main window below the ISDN
node, select the tree node ISDN Interface 1 or 2 (for interface BRI

1 or BRI 2).

Options
Activate interface

Generate call
records

Automatic
rerouting valid
for ...

Dial-in
Mode

Activates or deactivates (blocks) the relevant
interface (BRI 1 or BRI 2).

If this is selected, for each call via the relevant
ISDN interface, a data set is stored in the CDR
file.

Activates or deactivates the Adaptive Callbacks
function and determines the validity duration
(input in minutes). For more information about
this feature, see below.

This setting has an effect only if the ISDN
interface is in TE mode.

In DD/ mode, the ECOTEL® checks each
incoming telephone number to see whether it
begins with one of the numbers entered in the
fields MSN 1 -10. If there is a match, this part is
removed from the number and the remaining
number is dialed. As a general rule, DDI is used
on an ISDN point-to-point connection in order to
allow direct dialing to an extension. In the MSN
field, you must enter the number of the point-to-
point connection.

In MSN mode, every call is accepted regardless
of the dialed MSN as long as no telephone
numbers are entered in the fields MSN 1-10.

If one or more MSNs are entered, only calls
going to these MSNs are accepted. All other
calls will be ignored by ECOTEL®.
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Number forwarding

Allow forwarding  Determines whether the telephone number
supplied in an incoming GSM connection is to
be transmitted via the ISDN interface to the
called subscriber.

Extended display Activates or deactivates extended number
display, i.e. the number in the national format
has the country code prefixed to it before it is
forwarded.

Example: 0123456789 is forwarded as
0049123456789.

This is available only if Allow forwarding is
activated

MSN1to 5 In these fields, telephone numbers or parts
MSN 6 to 10 thereof can be entered which are to be handled
as described under Dial-in Mode.

Charging Determines how charge information is passed
information to the ISDN side. The options correspond to the
usual ISDN charging options.

Transmit charging Possible values: None, End of call (= AOCE),
During call (= AOCD)

Charging type Charge information in the form of Units or
Currency.

Currency The currency designation which is passed
along.

Charge units Here, a fraction of the currency unit can be

specified as an invoicing unit.

Explanation: The Adaptive Callbacks function (rerouting) writes
the phone numbers of the calling and called subscribers into an
internal list maintained by ECOTEL® for all failed calls from the
ISDN interface to the GSM network. If the GSM subscriber which
was not reached previously calls ECOTEL® within a set time, he is
automatically forwarded to the telephone number which previously
attempted to reach him without success.

-2 3.4.6 Adaptive callbacks
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6.3.4 Gateway Configuration: ISDN Interface 1/2:
Enhancements

Call: In the Gateway Configuration main window below the ISDN
node and below ISDN Interface 1 or 2, select the Enhancements
tree node.

These options allow experienced users to adapt ECOTEL® to the
particular behavior of their own PBX or international networks. As
long as no problems occur, you should retain the default settings.

Behavior on events
from near end side

Towards ISDN Determines what message ECOTEL® uses to

answer SETUP respond on the ISDN interface to a SETUP

with message from the ISDN. Possible settings:
SETUP_ACK or CONNECT

Send towards Determines which message ECOTEL® uses to

ISDN after end of respond on the ISDN interface to the end of

dialing dialing. Possible settings:

PROCEEDING is the default setting. The

A subscriber does not hear a ringing tone until
the connection has been established from
ECOTEL® to the called party.

ALERT means that the A subscriber will
immediately hear a ringing tone.

Behavior on events
from far end side

Towards ISDN Determines what message ECOTEL® uses to
answer ALERT respond to an ALERT signal. Possible settings:
with ALERT, PROGRESS or CONNECT

and use Determines which PROGRESS ID is sent along
PROGRESS ID in the response.

Available only for ALERT and PROGRESS.
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Translate bearer Determines the bearer capability (BC) with
capability of GSM which a call is to be forwarded from the GSM

calls into network to the ISDN network. Possible settings:
90 (= 3.1 kHz Audio) or 80 (= Speech)
Remapping of There are a number of causes for the
release cause termination of a connection or a call setup. The
values release cause values are supplied by the

network. Telephone systems can be configured
to respond differently to different situations
depending on the release cause, e.g. with
different rerouting.

ECOTEL® is capable of remapping a maximum
of six different incoming release causes to a
different value in order to trigger the desired
response on the part of the telephone system.

Incoming release In the left column, choose the values to be
cause from far replaced.
end side

Outgoing release In the right column, insert the corresponding
cause to near end replacement value.

side In order to delete an entry, choose the Unused
option.
l]&? Note: Avoid having the same value occur

multiple times in the left column since only the
first entry which occurs will be valid.
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6.3.5 Gateway Configuration: GSM Interface 1..n

Call: In the Gateway Configuration main window under the GSM
node, mark the tree node GSM Interface 1 (2, 3, etc.).

Options
Activate interface

Generate call
records

Release on
completed

Release on busy

Activates or deactivates (blocks) the relevant
interface (GSM 1, GSM 2, etc.).

If this is selected, for each call via the relevant
GSM channel, a data set is stored in the CDR
file.

If a GSM subscriber calls an extension in the
PBX via the GSM channel of ECOTEL®, if this
option is activated, the GSM connection
between the GSM subscriber and ECOTEL®
will be terminated immediately when the called
subscriber hangs up his extension.

If there is no check by this function, the GSM
connection between ECOTEL® and the calling
GSM subscriber will be maintained.

This allows the GSM subscriber to call another
extension in the PBX without having to call
ECOTEL® again.

If a GSM subscriber calls an extension in the
PBX via the GSM channel of ECOTEL®, if this
option is activated, the GSM connection
between the GSM subscriber and ECOTEL®
will be terminated immediately if the called
subscriber’s extension is busy.

If there is no check by this function, the GSM
connection between ECOTEL® and the calling
GSM subscriber will be maintained.

This allows the GSM subscriber to call another
extension in the PBX without having to call
ECOTEL® again.

ECOTEL® VolP/ISDN2-1/ISDN2-2 Edition 3.2-EN — 20060530 Page 159



VIERLING

Number forwarding
(outgoing calls)

Support depends
on your service
provider and is

used on single
number base, as
specified in
routing (call
interrupt allowed)

always used (call
interrupt allowed)

used if possible
(avoid call
interrupt)

Activate
restriction

Calltime limit
(outgoing calls)

The display (CLIP: Calling Line Identification
Presentation) or blocking (CLIR: Calling Line
Identification Restriction) of the telephone
number of the calling subscriber is a function
provided by the GSM network. Depending on
the GSM network operator, this function will be
implemented or not Depending on the GSM
network, ECOTEL® can block forwarding of the
telephone number.

In this settmg depending on the CLI settings
predefined in the routing, ECOTEL® attempts to
activate or suppress display of the telephone
number to the called subscriber. If CLI is not
supported by the GSM network, the call is
interrupted.

With this setting, ECOTEL® will always attempt
to activate display of the telephone number to
the called subscriber regardless of the CLI
settings predefined in the routing. If CLIP is not
supported by the GSM network, the call is
interrupted.

This is the default setting. In this setting,
ECOTEL® attempts as a general rule to activate
display of the telephone number to the called
party regardless of how CLI was defined in the
routing settings. If CLIP is not supported by the
GSM network, the call is made anyway.

If the CLI setting always used or used if
possible is selected, ECOTEL® attempts to
activate display of the telephone number to the
called subscriber (CLIP).

Activate restriction causes ECOTEL® to attempt
instead to activate suppression of the telephone
number (CLIR) to the called subscriber.
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Each call is
limited to ...

Signal quality

Register if signal
strength is above
...dB

Start searching
for better signal
quality if signal
strength is below
...dB
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The maximum connection duration for outgoing
GSM calls in ECOTEL®. After this time elapses,
the GSM connection is automatically
interrupted.

If activated, ECOTEL® will register only if the
received signal strength is above the specified
threshold.

Possible values: -113 dB to -51 dB

If activated, ECOTEL® will attempt to register
with a base station with better reception as
soon as the received signal drops below the
specified field strength.

Possible values: Like in the field above, but you
should select a value that is less than the above
value.

The CLIR also be used selectively for certain calls. For more

details, see:

-2 5.4.5 Forwarding special characters in the destination number
/ Selective CLIR function
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6.3.6 Gateway Configuration: GSM Interface 1..n:
Audio Functionality

Call: In the Gateway Configuration main window under the GSM
node and under GSM Interface 1 (2, 3, etc.), mark the tree node
Audio Functionality.

Audio parameters

Volume to GSM For calls between GSM and ISDN, ECOTEL®
side can set the volume in the direction of the GSM
subscriber for each GSM channel.

Volume to ISDN For calls between GSM and ISDN, ECOTEL®
side can set the volume in the direction of the ISDN
subscriber for each GSM channel.

Echo cancellation Echo cancellation is implemented in the
ECOTEL® using software. You can either
activate or deactivate this function.
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6.3.7 Gateway Configuration: GSM Interface 1..n: SIM

Properties

l@g Note: This feature is only available with ECOTEL”ISDN2-1.
The corresponding settings for other ECOTEL® types are
fo be done in the SIM Management module.

Call: In the Gateway Configuration main window under the GSM
node and under GSM Interface 1 (2, 3, etc.), mark the tree node

SIM Properties.

Mobile number

Service center
number

Clock model in
seconds

Lock to preferred
LAIN

LAIN

Telephone number of the SIM card which is
installed in the GSM module.

Number of the SMS service center for the SIM
card which is installed. This number is needed
so that ECOTEL® can send SMS messages.

Here, you should enter the charge timing for the
rate model for the installed SIM card. This value
is used to compute when the call time limit is
reached (see below). The first entry indicates
the duration of the first charge pulse in seconds
and the second entry indicates the spacing
between all subsequent pulses.

Example: 60/ 1 means that for the first pulse,
the charges are computed for 60 seconds,
while for each further pulse the charges are
computed for one second.

Here, you should enter the LAIN (Location Area
Identification Number) of the GSM network in
which the installed SIM card should register.

If no LAIN is entered, the SIM card will register
in the network with the best reception.
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Roaming allowed

Overall calltime
limit

Use limit of ...
minutes

per ...

starting

(dd.mm.yyyy) ...
Charging
information

t1

x1
t2
X2

You can get more details about the network
operators which are available locally in the
Firmware Tools module on the GSM
parameters page.

If roaming is allowed, a SIM card can also
register in an outside GSM network if
registration fails under the specified LAIN.

If roaming is not allowed, the SIM card may
only register under the specified LAIN.

You can set a maximum for the total duration of
all calls via this SIM card. If this limit is reached,
ECOTEL® will not route any more calls via this
GSM channel.

This allotment is applicable to a certain time
period, e.g. per month. After this, the counter is
reset and the allotment is available again.

If no specific GSM module is specified in the
routing for an outgoing call, the GSM module
with the lowest utilization is chosen.

Call time permitted per interval

Length of the standard interval

Start of the first interval (at 00:00 on the
specified day)

This determines for incoming calls from the
GSM side what charging information should be
made available to the outgoing side. Possible
values:

Generate none, or Generate in ECOTEL.

Forwarding of charging information from the
GSM network is not possible currently since
GSM networks do not send this information.

The following parameters control the generation
of charge units by ECOTEL®:

Duration of the first charging interval
Transferred units for the first charging interval
Duration of each additional charging interval

Transmitted units for each additional charging
interval
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l@ Note: The extent to which this information on
the ISDN side is forwarded to the called
subscriber depends on the settings for the
ISDN interface!

—=2* 6.3.3 Gateway Configuration: ISDN
Interface 1/2
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6.3.8 Gateway Configuration: GSM Interface 1..n:
Callback SMS

Call: In the Gateway Configuration main window under the GSM
node and under GSM Interface 1 (2, 3, etc.), mark the tree node

Callback SMS.

Callback request via
SMS

Text to be sent

Sending condition

In case of a failed call from an extension to a
GSM subscriber, an SMS message is
automatically sent to the subscriber (e.g. with a
callback request).

Text of the SMS message. You can use the
following wildcards:

%m for the telephone number of the SIM card
via which the subscriber was called.
%e for the extension of the calling subscriber.

Example: “Please call back %m or %e .”

Warning: By inserting the telephone numbers,
the SMS message which is actually sent will
have more characters than are displayed here.
Only the first 160 characters are sent; the rest
are truncated!

Possible settings:

When user requested.

The SMS message is sent only if the calling
subscriber enters the character sequence *1#
before a connection is made (if a voicemail is
reached, this is considered to be a successful
connection).

Automated after every failed call:
The SMS message is sent automatically as
soon as the call fails.

For more information, see:
- 3.4.7 Callback request via SMS
-2 3.4.8 SMS functions
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6.3.9 Gateway Configuration: VolP Interface

Call: In the Gateway Configuration main window, select the VolP
> VoIP Interface tree node.

@ Note: This interface is only available with ECOTEL“volp.

Options
Activate interface

Generate call
records

Behavior on events
from far end side

Towards near end
side answer
ALERT with

Activates or deactivates (blocks) the VolP
interface. Deactivation applies to all VolP
channel simultaneously.

If this is selected, for each call via the VolP
interface, a data set is stored in the CDR file.

Determines for calls from the VolP interface to
the GSM interface which message ECOTEL®
will send in response to an ALERT message
from the GSM end to the VolP end. This is a
way of controlling when the connection is
connected through on the VolP end.

ALERT will result in the VoIP end not being
connected through until after the CONNECT on
the GSM end. In some cases, this will cause a
few fractions of a second of the call to be lost.

With CONNECT, the call is connected through
on the VolP end prior to the CONNECT on the
GSM end. VolIP charges can accrue from this
point. The ringing tone from the GSM end is
passed through. The complete call is
transmitted from the GSM end from the
beginning.
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6.3.10 Gateway Configuration: SIP Outbound 1..n

Call: In the Gateway Configuration main window, select the VolP
> SIP QOutbound 1 (2, 3, ...) tree node.

@ Note: This capability is only available with ECOTEL“Voip.

Here, you can enter the SIP outbounds (SIP proxies or SIP
providers) that ECOTEL® should use. The outbounds 1..8 defined
here correspond to ports V1..V8in the routing table.

Proxy or provider n

connected with an
outbound proxy

connected with an
external provider

not connected

=

Outbound device

=

Select this option if you want to be able to make
outgoing calls via a SIP proxy (e.g. via an
Asterisk in your Intranet)

Select this option if you want to be able to make
outgoing calls via a SIP provider (e.g. Sipgate,
T-Online)

Select this option to deactivate usage of this
outbound.

Note: For information about the distinction
between "SIP proxy" and "SIP provider", see:

== 3.4.3 SIP outbounds (SIP proxies and SIP
providers)

Note: The SIP outbound function can be
realized by one or more computers. This should
be transparent to the user. What is important is
the address (name or IP address) at which the
function can be reached.

In many cases, this will be only a single
address (domain address). However, some
providers use separate addresses for certain
subfunctions (proxy, registrar).
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(1st line:
Domain data)

The domain receives all SIP-related queries
from ECOTEL? for which neither the proxy or

Use fix IP address

Domain
IP address

Domain name

registrar is responsible.

Determines whether the domain is to be
addressed with an IP address. Otherwise, a
name is used.

The IP address of the domain
(If the option Use fix IP address is activated)

The name of the domain
(e.g. myprovider.corp)

(If the option Use fix IP address is deactivated)

Port The standard port is 5060. You should enter
something different here only if your provider
specifically says to do so.

(2nd line: The proxy is responsible for the signaling, i.e.
Proxy data) for setting up a connection to the desired

Use fix IP address

subscriber.

In most cases, enter the same data here as for
the domain. However, if your provider specifies
other data, enter it here.

Determines whether the proxy is to be
addressed with an IP address. Otherwise, a
name is used.

Proxy The IP address of the proxy
IP address (If the option Use fix IP address is activated)
Proxy name The name of the proxy
(e.g. proxy.myprovider.corp)
(If the option Use fix IP address is deactivated)
Port The standard port is 5060. You should enter
something different here only if your provider
specifically says to do so.
Copy Domain Copies the domain data (/P address or domain

ECOTEL® VolP/ISDN2-1/ISDN2-2

name, port) into the corresponding fields for the
proxy.
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(3rd line: The registrar is responsible for user registration,
Registrar data) i.e. for the information about which user can
currently be reached where.

In most cases, enter the same data here as for
the proxy. However, if your provider specifies
other data, enter it here.

Use fix IP address Determines whether the registrar is to be
addressed with an IP address. Otherwise, a
name is used.

Registrar The IP address of the registrar

IP address (If the option Use fix IP address is activated)

Registrar name The name of the registrar
(e.g. registrar.myprovider.corp)

(If the option Use fix IP address is deactivated)

Port The standard port is 5060. You should enter
something different here only if your provider
specifically says to do so.

Copy Proxy Copies the proxy data (/P address or proxy
name, port) into the corresponding fields for the
registrar.

Enable STUN Determines whether a STUN server is to be
used.

For this to work properly, a STUN server must
be set up and activated:

—=2* 6.6.3 Basic Configuration: IP Connection

Registration

Activate Select this option if ECOTEL® needs to register
with the SIP outbound.
Username The user name with which ECOTEL® registers

with the SIP outbound.

ECOTEL® needs to have an account with the
relevant SIP proxy or SIP provider.

Renew Determines at what interval ECOTEL® renews
registration every its registration with the SIP outbound.
... Seconds
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Authentication

Activate Select this option if ECOTEL® must undergo
authentication with respect to the SIP outbound.

SIP providers generally require authentication
while plain SIP proxies do not.

Identifier The user identifier under which ECOTEL®
needs to undergo authentication with respect to
the SIP outbound.

The identifier is usually identical to the
Username for registration. However, if your
provider uses a separate user identifier for
authentication, enter it here.

Copy Username Copies the content of the Username field from
the Registration area into the Identifier field.

Password The password associated with the Identifier
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6.3.11 Gateway Configuration: Announcements

Call: In the Gateway Configuration main window, select the
Announcements tree node.

ECOTEL® can be controlled by your voice. The various
announcements are available in different languages. The
ECOTEL administrator can set the desired language.

Announcements You can activate or deactivate the various

and signal tones announcements individually. Depending on the
language which is set, country specific tones
can be included in the speech packet for
controlling call setup.

Language Here, you can select the language you desire.
Ay Warning: Users will hear the voice
Y4 ' AN announcements only if the required WAVE files
AR are present on ECOTEL®!

Please make sure of this. To do this, go to the
Voice Announcements configuration page in the
ECOTEL Firmware Tools module. There, you
can see if ECOTEL? already has the WAVE
files you need or you can download more
WAVE files.

A list of the WAVE files with the file names and contents can be
found elsewhere:

== 10.1 Wave files for speech announcements
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6.3.12 Gateway Configuration: Management

Call: In the Gateway Configuration main window, select the
Management tree node.

Call detail records

CDRs realtime via
serial interface

Size of file

Validity

If this is activated, the CDRs are also inserted
individually after each call or call attempt into
the trace messages which are output via the
serial interface of ECOTEL® (see also Firmware
Tools > Monitor).

Using this entry, you can set the maximum
memory space available for CDR files. If the
specified file size is reached, the oldest file is
overwritten when a new CDR file is created.

Every da)é at midnight, all of the CDR files in
ECOTEL"™ are deleted which are older than the
time set here (in days).

Additional information about CDRs:
—=» 3.4.5 CDRs in ECOTEL
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6.3.13 Gateway Configuration: Device

Call: In the Gateway Configuration main window, select the
Device tree node.

Please select a Possible values: ECOTEL ISDN2 -1, ECOTEL

device ISDN2-2, or ECOTEL VolP

Please select the After you select a device, additional options will

number of GSM appear here so that you can enter the number

modules of available GSM modules.

Type Displays the device type of ECOTEL®.

Firmware version Displays the firmware version of ECOTEL®.

Interface version Displays the version of the template on WhICh
the configuration files present in ECOTEL® are
based.

You can Juse the ECOTEL® configuration software for various
ECOTEL® types. When you are opening a new configuration file
(using File > New...), you have to select the ECOTEL® type for
which the file is to be used.

However, you can also modify the device type for an existing
configuration file. For example, you can convert a proven
conflguratlon file for ECOTEL®ISDN into a configuration file for
ECOTEL®ison. You should then save this mOdIerd configuration
file under a new file name and load it into ECOTEL®. Now, all you
have to do is reset the VolP-specific parameters.

You can load and edit the device parameters from ECOTEL® or a
configuration file. You can then save the modified settings as a file
or write them back to ECOTEL®.

Besides influencing the configuration file, the device type also
determines which parameters are displayed in the user interface.
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6.4 Routing Table module

You can program the call routing in the gateways to meet your
needs. For this purpose, a table with routing entries is created in
the Routing Table module. Each entry in this routing table
determines the channel type and number via which calls may be
made (depending on parameters such as the telephone number of
the calling party, the channel type or number of the incoming call,
the dialed number, the length of the dialed number, etc.).

You can load and edit the routing table from ECOTEL® or from a
file. You can then save the modified table as a file or write it back
to ECOTEL®,

When you exit the Routing Table window, you will be
automatically returned to Service Gear.
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6.4.1 Routing Table: Main window

Call: From any of the modules, using Tools > Start > Routing

Table.
File
Close

Tools
Debug...

Language...

Start

Help

Contents...

Info...
Print...

(Tree view)

Green
Red
Gray

(Detail window)

Page 176

Exits the Routing Table module and returns to
the Service Gear module.

Opens an additional Debug Info window with
detailed information about the communication
between ECOTEL® and your configuraton
computer.

Allows you to select the language for the user
interface.

Changes to another module in the ECOTEL
configuration software (selected in the
submenu)

Opens the content page for the online help.

Shows information about the product version
and manufacturer.

Opens a PDF version of the help pages which
you can print.

Displays all of the function areas (here only:
routing). Routing).

The color coding is as follows:
Available

Available + Selected

Not available

Shows the configuration page for the selected
function area. For more information about the
individual fields, see also the description of the
configuration pages in the following sections.

Edition 3.2-EN — 20060530 ECOTEL® VolP/ISDN2-1/ISDN2-2



(Status line)
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(3rd field)

(4th field)
(5th field)
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The status line at the bottom edge of the
window provides additional information:

Name of the device currently being edited

Type of interface via which the configuration
computer is connected to ECOTEL® (USB, IP,
COM or Modem)

Address data for the interface (e.g. USB port
number, IP address for IP)

Additional information (e.g. connection status)

Directory in which the files for the selected
device are saved (with the default program
installation, this will be
C:\Programme\Vierling\ECOTEL_Service _Gear
\EcotelData)

ECOTEL® VolP/ISDN2-1/ISDN2-2 Edition 3.2-EN — 20060530 Page 177



VIERLING

6.4.2 Routing Table: Routing

Call: In the Routing Table main window, mark the Routing tree

node.

(Routing table)

(Information:
Routing Syntax)

Upload from Ecotel

Download to Ecotel

=

Open...
Save As...

Routing Wizard...

In the left half of the window, you can edit the
routing table.

In the right half of the window, a help text
explains how entries in the routing table are
structured.

Reads the current routing table from ECOTEL®
and displays it the left half of the window.

Note: The file which is read out always has the
name RTBL TXT. The read operation from
ECOTEL? causes the routing table which was
previously open to be discarded and the
existing file RTBL.TXT is overwritten on the
configuration computer (after asking for
confirmation).

Transm|ts the displayed routing table to
ECOTEL® where it immediately goes into effect
after transmission.

Note: The transmitted file is always saved on
ECOTEL? under the name RTBL.TXT.

Displays an Open File dialog which can be
used to select a routing table saved on the
computer.

Displays a Save File dialog which can be used
to save the displayed routing table on the
configuration computer.

Opens the Routing Wizard which simplifies
dealing with routing tables. The routing table
which is open is used by the wizard.

For information on how to format the routing entries, see the

separate section.

== 5 Introduction to the routing table
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For a comprehensive reference to syntax elements, see:
== 6.4.3 The routing syntax
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6.4.3 The routing syntax

This section lists all of the possible elements of a routing entry.

Any valid entry in the routing table will have the following format:
<Condition part><Spacing><Call type><Spacing><Destination part>

<Spacing> An arbitrary number of spaces and/or tab
characters.
To enter tabs: Alt+009

<Condition part> Mandatory. Can contain multiple conditions of
different types in any arbitrary order.

(<Cond1><Cond2> All conditions should be in parentheses without

...) any spaces or tab characters.
The following condition types are possible:
o<Port> Condition based on the interface of origin
<Port> Interface via which the call is received. Possible
values:
\" VolP interface (local or via any SIP outbound)
| Any ISDN interface
1,12 ISDN interface 1 or 2
11,112,121,122 Additional indication of the B channel
G Any GSM interface
G1, G2, ... GSM interface 1 (or 2, ...)
o<Dialing string> Condition based on the originating phone
number

<Dialing string>  Number of the calling subscriber; can contain
digits and the following characters:

+ Symbol for the international prefix (e.g. when
calling from Germany: 00). This is replaced by
the prefix entered under Basic Configuration >
Properties.

? Wildcard for exactly 1 digit

Page 180 Edition 3.2-EN — 20060530 ECOTEL® VolP/ISDN2-1/ISDN2-2



[<List of digits>]

#

o<Port>:<Dialing
string>

d<Dialing string>
<Dialing string>

m<MSN>
<MSN>

w<List of digits>
<List of digits>

c<Date>
<Date>

t<Time of day>
<Time of day>

<Call type>
n
b

ECOTEL® VolP/ISDN2-1/ISDN2-2

VIERLING

Multiple permissible digits for a position. Lists
without commas or spaces, ranges with
hyphen, e.g. [4-69] means 4, 5, 6, or 9

Wildcard for an arbitrary number of digits; may
not be followed by any additional digits.

End of dialing indicator

Combination: Both conditions must be fulfilled
(alternate form for o<Port>0<Dialing string>)

Condition based on dialed destination number
Same as condition type o

Condition based on dialed MSN

One of the MSNs belonging to ECOTEL®
Condition based on day of the week

Indication of permissible days of the week as
digits: 1=Monday ... 7=Sunday.

Lists without commas or spaces, ranges with
hyphen, e.g. w15-7

Condition based on day of year
Indication of the permissible date range (start-
end).

Format yy/mm/dd-yy/mm/dd.
The * and ? wildcards are permissible.

Condition based on time of day

Indication of the permissible time range (start-
end).

Format hh:mm:ss-hh:mm:ss.

Seconds and leading zeros may be omitted.
The * and ? wildcards are permissible.

Mandatory. One of the following types:
Normal call

Call block, i.e. calls which fulfill the condition
are blocked.
There is no destination part for this call type.

Dialing callback with release.
The condition part must contain type d.
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cm, im

<Destination part>

<Port>:<Call
destination>

<Port>
,LI1,G,G2,..

V'
V1, V2, ...
&

Dialing callback without release.
The condition part must contain type d.

Non-dialing callback with release.
The condition part must contain type o.

Non-dialing callback without release.
The condition part must contain type o.

Dialing callback: ECOTEL? detects the
callback request based on the dialed
destination number.

Non-dialing callback: ECOTEL? detects the
callback request based on the phone number of
the calling party (who does not have to enter a
destination number).

Callback with/without release: ECOTEL”
hangs up or waits until the calling party hangs
up.

Note: For the "callback” call types, the

destination part of the routing entry refers to the
callback destination, i.e. the actual caller.

After the callback is made, the number of the
desired destination can be dialed. A suitable
routing entry must exist for this number.

Callback like ¢, i (but with ECOTEL® as the
called subscriber for management
connections).

Mandatory except for call type b.

The destination part contains a port and a call
destination, separated by a colon, without any
spaces or tab characters.

The interface via which the call is to be routed.

Possible values like for condition type o, and
with different meaning or additionally:

VolP-interface, local users only
VolP-Interface, via SIP outbound 1, 2, ...
The originating port
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G[<List of GSM
port numbers>]

<Call
destination>

(Sequence of
digits)

+

\*, #

Comments
#<Text>
... lI<Text>
(blank line)

VIERLING

ECOTEL® itself as the destination for
management connections. Requires a data-
enabled SIM card in ECOTEL®.

Usage with call type n; in this case, the
destination part consists only of the character
M.

Note: Multiple ports can also be specified in the
destination part, e.g. G2G112. ECOTEL? first
attempts to make the call via the first port which
is named. If this is not possible (port busy,
disrupted), the next port is used and so on.

Multiple GSM ports are not used in the listed
order, but in order of usage (least used port
first), e.g. G[123]

The number which ECOTEL® dials for
forwarding. Possible formats:

Call to a fixed number

The sequence of digits can contain the symbol
for the international prefix (e.g. when calling
from Germany: 00). It is replaced by the prefix
entered under Basic Configuration > Properties.

The sequence of digits can contain the special
characters * and #. You must write * as \*.

The destination number originally dialed by the
calling party.

The number of the calling party. Permissible
only for call types ¢, p, i, d (callback).
CLIR is not allowed.

Comment on a complete line
Comment following a routing entry
Blank lines can be used for clarity.
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Additional rules

— The routing table is processed from top to bottom. If an
exact match entry is found, the search is terminated and
the entry is executed.

— As a general rule, entries without the * wildcard have higher
priority. Single digits and ? have the same priority.

— If there is more than one possible entry at the end of
dialing, the topmost entry is used.

— If a call does not fulfill any of the conditions in the routing
table, it is rejected.

For more details and examples, see:
== 5 [ntroduction to the routing table
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6.4.4 The Routing Wizard

Call: Routing Table module > Routing tree node > Wizard button.

This wizard helps you to work with routing tables. You can select
the elements of a routing entry using plain text: The wizard will
then translate your entries into proper routing syntax and insert
the entry into the table. You can “back translate” existing entries to
analyze their content. You can also switch to expert mode at any
time to make changes by hand.

Although the wizard does make it a lot simpler to translate
between plain text and routing syntax, you should still become
familiar with the basic concepts behind the routing table. For more
details, see:

== 5 [ntroduction to the routing table

It is possible that new features of the routing syntax will not be
immediately supported by the wizard. However, you can still use
expert mode to manually enter them at any time. For details about
the syntax, see:

== 6.4.3 The routing syntax

Table

New Opens a new (blank) routing table

Open... Displays an Open File dialog which can be
used to select a routing table saved on the
computer.

Save Saves the routing table

Save as... Displays a Save File dialog which can be used
to save the displayed routing table on the
configuration computer

Exit Terminates the routing wizard and returns to

the Routing Table module
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Help
Contents...
Info...

Print...
Entry mask

Action
Comment only
Route a call

Block a call

Create a
callback

Create a
configuration
callback

Set time
conditions...

(time conditions)

From port
(possible ports)

BlE

Opens the content page for the online help

Shows information about the product version
and manufacturer

Opens a PDF version of the help pages which
you can print

This area is the entry mask for new routing
entries

Specifies the type of routing entry:
Comment only (line begins with #)

Normal call: Routing to a destination number
(call type n)

Call block, i.e. calls which fulfill the condition
are blocked (call type b)

Callback (call type ¢, p, i or d), depending on
the further settings:

If the field with dialed number is filled in, a
dialing callback will result (c or p); otherwise a
non-dialing callback (i or d).

If the automatic release option is checked, a
callback with release will occur (c or i);
otherwise without release (p or d)

Callback like with Create a callback; but where
ECOTEL® itself is the called subscriber; this is
for management connections (call type cm or
im)

Opens the Set time conditions dialog in which
you can configure conditions such as day of
week, date and time of day (see below)

Time conditions in the routing syntax. If you use
the Set time conditions dialog, the result will
appear here.

List of possible originating ports

Moves the marked list element between fields.
Alternatively, you can double-click on the
desired element
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from
subscriber

with dialed
number

with sending
complete

automatic
release

Towards port
(possible ports)

BlE

(selected ports)

s
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The originating port to which the routing entry
applies (condition type o<Port>)

The number of the originating subscriber as a
condition (condition type o<Dialing string>).
You can use the wildcards * and ? for multiple
digits or for exactly 1 digit respectively, or + as
a symbol for the international prefix

The destination number dialed by the
originating subscriber as a condition (condition
type d<Dialing string>).

You can use the wildcards * and ? for multiple
digits or for exactly 1 digit respectively, or + as
a symbol for the international prefix

Appends the end of dialing sign # to the dialed
number

(only for callback connections:)

If activated: ECOTEL® automatically hangs up
after the call

If deactivated: ECOTEL® waits until the calling
party hangs up.

List of possible destination ports

Moves the marked list element between fields.
Alternatively, you can double-click on the
desired element

The port(s) via which the call is to be routed.
(same as input corresponds to destination port
&)

Note: Multiple ports can also be indicated in the
destination part. ECOTEL? first attempts to
make the call via the first port which is named.
If this is not possible (port busy, disrupted), the
next port is used and so on (destination port
e.g. G1G2G3).

If several GSM ports are involved, their usage
order can be modified by the GSM load
balancing option (see further below).

Moves the marked list element up or down
within the list
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towards dialed ECOTEL® should use the originally dialed
number destination number for further dialing (call
destination d)

towards (Only for callback connections:)

originating ECOTEL® should call back the calling number
number (call destination o)

towards The number ECOTEL® should dial for routing.
specified The sequence of digits can contain the + sign
number as a substitute for the international prefix as

well as the special characters * and #. You
must write * as \*

GSM load (Only if several GSM destination ports are
balancing selected:)

If activated: ECOTEL® first attempts to make
the call via the port that has been least used so
far. If this is not possible (port busy, disrupted),
the next port (according to usage order) is used
and so on (destination port e.g. G[123]).

This will result in a better load balance among
the corresponding SIM cards.

If deactivated: Ports will be used in the given
order (destination port e.g. G1G2G3).

Comment Comment to be inserted.
If Commentis chosen as the Action, this
comment will appear in a separate line with #
before it.
Otherwise, the comment is appended to the
routing entry with // before it.

Reset entry mask Resets all of the fields in the entry mask to their
default values

Add new line Inserts a new routing entry into the routing table
depending on the data in the entry mask. If a
line is marked in the table, the new entry will be
inserted directly below it, or otherwise at the
end of the table.

Replace selected Replaces the marked table entry with an entry
line corresponding to the data in the entry mask

Copy selected line  Analyzes the marked table entry and copies its
contents to the entry mask.
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s Note: You can also just double-click on the
table entry.

l@ Note: You can use this function to translate
routing entries into plain text or to copy and
modify entries.

Routing Table Displays the routing table which is currently

open. If a routing table is already open when
the wizard is invoked, it will be automatically
used here.

Deletes the entire routing table (all contents will
be lost!)

Deletes the marked entry

» X |4

Moves the marked entry to the start or end of
the table

1+ 1 Moves the marked entry by one line up or down

ot
W

Expert mode Activates expert mode in which you can directly
modify the routing table like in a text editor

l]@ja Note: If you need to enter a tab, use the key
combination Alt+009

Dialog Set time conditions
Call: Set time conditions button

The Set time conditions dialog has the following operating
elements:

Active week days Here, you can select the days of the week on
which the routing entry is to be active (condition
type w)
Select All Selects all week days
Deselect All Deselects all week days
Active date If so desired, enter a start and end date for the

validity of the routing entry (condition type c).
You can use the * and ? wildcards to stand for
several digits or for exactly 1 digit
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Active time If so desired, enter a start and end time of day
for the validity of the routing entry (condition
type t).
You can use the * and ? wildcards to stand for
several digits or for exactly 1 digit

OK Closes the dialog and transfers the changes to
the window which called it

Cancel Closes the dialog and discards the changes

Reset Resets the entry fields to their default values
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6.4.5 Routing Table: Remote Connection

Call: In the Routing Table main window, mark the Remote
Connection tree node.

The structure and function of this page corresponds to that of the
page with the same name in the Firmware Tools module (see
there).

It is available only for remote access via modem.
== 6.5.10 Firmware Tools: Remote Connection
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6.5 Firmware Tools module

The Firmware Tools allow you to set and modify the time of day,
exchange files with ECOTEL® (new firmware versions or voice
announcements, etc.) and provide support when correcting
problems or troubleshooting the device (reading out online traces,
log files, GSM parameters). Communication with ECOTEL® takes
place exclusively via its serial interface.

When opening the Firmware Tools module, an attempt is made to
access ECOTEL® via the serial interface in order to load the
current data. If no ECOTEL® is connected, then a message
window is displayed once a certain time elapses and the
corresponding parameter fields are displayed empty. The
individual Firmware Tools are listed in the left half of the software
interface and can be launched by clicking on them.

When you exit the Firmware Tools window, you will be
automatically returned to Service Gear.
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6.5.1 Firmware Tools: Main window

Call: From any of the modules, using Tools > Start > Firmware
Tools.

The structure and functioning of the operating elements corre-
sponds to the main window in the Routing Table module; see
there.

The elements of the tree view and the corresponding detail win-
dows which are described in the following sections are different.
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6.5.2 Firmware Tools: Time

Call: In the Firmware Tools main window, mark the Time tree
node.

Set Clock Resets the internal clock of the ECOTEL®
based on the current time of day on the
computer which is used to configure ECOTEL®.

Get Clock Reads and displays the internal time of day in
the ECOTEL®.
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6.5.3 Firmware Tools: Security Code

Call: In the Firmware Tools main window, mark the Security Code

tree node.

ECOTEL Security
Code

Change Code

ECOTEL PUK
(Security Code 2)

Change Code

For each access to ECOTEL® (upload or
download), it asks for the security code in order
to prevent unauthorized persons from
accessing it and possibly modifying the data.

The security code with which the configuration
computer responds during access in order to
authenticate itself is entered in the Service
Gear module in the Properties dialog for the
relevant ECOTEL®. It must match the security
code which is defined here.

The usage of a security code is optional.

A security code stored in the ECOTEL® can be
deleted by leaving the input fields blank when
you change the code.

Opens the Change security code dialog.

Enter the new security code. You have to enter
it twice to avoid problems with typographical
errors. Click on OKto accept the changes.

The PUK ( = Personal Unblocking Key) is used
as an extra means of access in case you forget
the usual security code.

When necessary, it is used in place of the main
security code.

Opens the Change ECOTEL PUK dialog.

Enter the old PUK followed by the new one.
You have to enter it twice to avoid problems
with typographical errors. Click on OKto accept
the changes.
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Note: PUK (Security code 2) is as follows when
the device is shipped: PUK 84375464

(with a space character; this number reads
“VIERLING” on a telephone keypad)

You should modify the PUK when you first set
up the device.

Warning: If you lose the security code and the
PUK;, not even the manufacturer (Vierling) will
be able to access the device remotely. You will
have to send it back to the manufacturer to be
reset.
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6.5.4 Firmware Tools: Firmware Download

Call: In the Firmware Tools main window, mark the Firmware
Download tree node.

You can use this tool to load new firmware on ECOTEL®. A
firmware download is necessary, for example, when new functions
are implemented.

AN Warning: It is not possible to perform a firmware download
i ' % via the USB interface! Use the IP interface instead.
P
Selected Version Displays the firmware versions which can be
selected.

Download Firmware Transmits the selected firmware to ECOTEL®.
The device is then rebooted automatically.

Factory setting Resets the device to the factory default setting,
i.e. the latest firmware version, the default
configuration files, the default routing table and
the default speech files are downloaded and the
user table, all saved CDRs, trace and monitor
files, etc. are deleted.

l@ Note: With ECOTEL®volp, this function is
unavailable in case of access via the USB
interface due to the huge amount of data to be
transferred.
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6.5.5 Firmware Tools: Announcement

Call: In the Firmware Tools main window, mark the Announce-

ment tree node.

Ecotel

(File list)

Select All

Delete on ECOTEL
Path

(Drive)
(Directory)

s

Existing Wave Files

Select All
Listening Test

Download to
ECOTEL

The left column applies to files on the
ECOTEL®.

Displays all of the WAVE files present on the
ECOTEL®. You can select one or more files
using the normal Windows methods.

Selects all of the files in the list.
Deletes the selected files on ECOTEL®.

Select the drive which contains the WAVE files.

Select the directory which contains the WAVE
files.

Normally, these files should be located below
the ECOTEL installation directory in
\Wave\<CountryCode>\A_Law!|

Notes: Files that are common to all languages
(tones, pauses, music) have the SYS prefix
instead of the country code.

Displays all of the WAVE files present in the
selected path. You can select one or more files
using the normal Windows methods.

Selects all of the files in the list.

Plays back the selected WAVE file. Your
computer needs a loudspeaker to play back the
file.

Transmits the selected files from the computer
to the ECOTEL®.

A list of the WAVE files with the file names and contents can be

found elsewhere:

—= 10 Technical Details
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6.5.6 Firmware Tools: CDR

Call: In the Firmware Tools main window, mark the CDR tree
node.

This page is used to manage the call detail record (CDRs) which
the ECOTEL® can generate for each call. You can transmit the
CDRs to the configuration computer for archlval purposes and for
freeing up memory space on the ECOTEL®. There, they are
stored in the database.

The database uses normal Windows folders for each of the
ECOTEL® devices. The status bar shows the directory which
belongs to the device which is currently being processed. In the
DataBase window, the CDR files from the \CDR subdirectory
appear.

For additional information about CDRs, see:
—=» 3.4.5 CDRs in ECOTEL

l]ﬁja Note: CDRs are generated on the ECOTEL? only if the
option “Generate Call Records” is activated for the relevant
interface (ISDN, GSM, VolIP).

ECOTEL The left half of the window applies to the data
sets on ECOTEL®.
(CDR List) Displays aII of the data sets (CDRs) present on

ECOTEL®. You can select one or more data
sets using the normal Windows methods.

Select All Selects all of the data sets in the CDR list.

Delete Deletes the selected data sets on the
ECOTEL®.

Delete Transferred |f this is selected, after the upload the

Files transmitted files are deleted on the ECOTEL®.
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Upload from Transmits the selected data sets from the

ECOTEL ECOTEL® to the database. All filenames
automatically have Copy of... appended to
them in order to avoid overwriting existing files
with the same name.

DataBase The right half of the window concerns the data
sets in the database, i.e. in the directory
structure on the configuration computer.

(CDR List)

Show... Displays the content of the selected data set (or
the first data set which is selected).

Delete Deletes the selected data sets from the
database.

Select All Selects all of the data sets in the CDR list.

Download to Transmits the selected data sets from the

ECOTEL database to the ECOTEL®.
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6.5.7 Firmware Tools: GSM Parameters: Module 1..n

Call: In the Firmware Tools main window, mark the GSM
Parameters tree node and under that Module 1 (Module 2, etc.).

IMEI
IMSI
Active Cell

Neighboring Cells

Current Service
Provider

Access List

List of Service
Providers

Field Strength
Update

Enter PIN

=

Displays the IMEI of the relevant GSM module.
Displays the IMSI of the relevant GSM module.

Displays data for the GSM base cell where the
GSM module is currently registered.

Displays data for additional base cells in the
same network for which adequate receiving
conditions also exist.

Displays the service provider who operates the
network in which the GSM module is currently
registered.

Fetches the List Of Service Providers. Since
this procedure can take a while, it is not
executed automatically and requires a special
request.

Displays all the service providers whose
networks currently offer adequate receiving
conditions.

Displays the received field strength on a scale
or as a numerical value in dBm.

Rereads all of the data except for the List Of
Service Providers.

Opens the dialog for inputting a PIN. The PIN is
used by ECOTEL® for authentication with
respect to the SIM card.

Note: This button and the assoaated dialog are
available only in ECOTEL ISDN2-1.

In other ECOTEL? types, the SIM Management
moaule is available instead.
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_,;:1'*“-“-‘:5‘ Warning: Always modify this pin when the SIM
Y 4 ' AN card is removed since otherwise access
P problems and blockage of the card can possibly
result.

The sequence is as follows:

— Remove the old SIM card (if necessary)
— Enter the new PIN in the dialog

— Insert the new SIM card

l@g Note: To change the PIN on the actual card,
insert it into a mobile phone and perform the
procedure required there. You cannot make
such a change using ECOTEL?®.

Polling Regularly performs the function of the Refresh
button.
Polling Interval Polling is repeated at this interval. Polling which

is currently in progress is displayed through
movement of the adjacent icon.
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6.5.8 Firmware Tools: File Transfer

Call: In the Firmware Tools main window, mark the File Transfer
tree node.

This page is used to manage the files on ECOTEL®, particularly
the trace files which are generated on the ECOTEL® during
various actions. You can transmit the trace files to the
configuration computer for archival purposes and for freeing up
memory space on the ECOTEL®. There, they are stored in the
database.

The database uses normal Windows folders for each of the
ECOTEL® devices. The status bar shows the directory which
belongs to the device which is currently being processed. In the
DataBase window, files from the \Trace subdirectory appear.

Besides the trace files, other files of various types are also
managed here, e.g. the configuration files of ECOTEL®.

ECOTEL The left half of the window applies to files on
ECOTEL®.
(File list) Displays all of the trace files present on

ECOTEL®. You can select one or more files
using the normal Windows methods.

Select All Selects all of the files in the list.
Delete Deletes the selected files on ECOTEL®.
Delete Transferred |f this is selected, after the upload the
Files transmitted files are deleted on the ECOTEL®.
Upload from Transmits the selected files from ECOTEL® to
ECOTEL the database.

DataBase The right half of the window concerns the files

in the database, i.e. in the directory structure on
the configuration computer.

(File list)
Show... Displays the content of the selected file.
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Delete Deletes the selected files from the database.
Ay Warning: Do not delete any files unless you
Y4 ' AN are certain that they are unneeded! Deleting
P certain fi/%s (e.g.. *.TGZ_, *.AFX) can cause
ECOTEL™ to quit working.
Select All Selects all of the files in the list.
Insert... Opens an Open File dialog which you can use

to select any file and copy it to the database
(\Trace subdirectory of the device directory)

Download to Transmits the selected files from the database
ECOTEL to ECOTEL®.
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6.5.9 Firmware Tools: Trace

Call: In the Firmware Tools main window, mark the Trace tree
node.

Here, you can see the trace output which is generated by the
software components of ECOTEL". You can switch traces for the
interface components on or off.

At a command prompt, you can send commands directly to
ECOTEL® in order to influence the tracing behavior.

(Trace window) Displays a list of the traces.
Debug All On Switches on tracing for all of the interfaces.
Debug All Off Switches off tracing for all of the interfaces.
Debug ISDN On Switches on tracing for the ISDN interfaces.
Debug ISDN Off Switches off tracing for the ISDN interfaces.
Debug GSM On Switches on tracing for the GSM interfaces.
Debug GSM Off Switches off tracing for the GSM interfaces.
A Warning: Remote access to ECOTEL? via
Y4 '“}i*.;.\_ modem (GSM) functions only while the GSM
A traces (Debug GSM) are switched off.

Since the debug settings (On/Off) remain in
effect even after you close this window, you
should always execute the command Debug
GSM Off beforehand.

Long-Term Traces Opens the Long-Term Traces dialog.

Here, you can choose to record the same
information which appears in the monitor on the
ECOTEL®in afile.

Use On/ Offto activate or deactivate the
function. In the File Name field, enter the name
under which you wish to save the file. The .TRC
extension will be automatically appended.

In order to read the file out of the ECOTEL®,
use Firmware Tools > File Transfer.
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ECHO On
ECHO Off
Scroll Lock
Save Trace

(Input field)

=

Send

Clear Trace
Online

Offline

Caps Lock

Page 206
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Switches on display of the transmitted
commands.

Switches off display of the transmitted
commands.

Halts scrolling of the window content or restarts
it.

Opens a save file dialog for saving the window
content in a file (file type * TRC).

For experienced users: Here, you can send
commands directly to the ECOTEL®. The
available commands and their syntax depend
on the propnetary communication protocol used
by ECOTEL®.

Note: All commands sent to ECOTEL? must be
in capital letters. We suggest that you activate
the Caps Lock key.

Exception: For file names, you need to
distinguish between uppercase and lowercase.

Transmlts the command you just entered to the
ECOTEL®.

Deletes the window content.

Estabhshes a connection from your computer to
ECOTEL®.

Interrupts the connection from your computer to
ECOTEL®.

Converts all of the characters typed in the input
field to uppercase (see the note above).
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6.5.10 Firmware Tools: Remote Connection

Call: In the Firmware Tools main window, mark the Remote

Connection tree node.

This page is available only if the modem interface is configured for

accessing the device.

Ecotel Data
Call Number
Access Code

Security Code

Modem Data
Callback Nr (Data)

Security Code

Status of Remote
Connection

(Gray)
(Green)

Trace of Remote
Connection

Connect
Disconnect

Download
Configuration

ECOTEL® VolP/ISDN2-1/ISDN2-2

Displays the configuration data for the current
device as entered in the Service Gear module.

Telephone number at which the device can be
reached by the modem.

An additional code which the modem transmits
during remote access via GSM.

Security code for ECOTEL® which the party
performing the configuration (here: the modem)
uses to identify itself to ECOTEL®.

Displays the configuration data for the current
modem as entered in the Service Gear module.

Callback number which the called device
should use for calling back the modem.

Security code for the modem which the
configuration computer uses to identify itself to
the modem.

Displays the progress of the call setup based
on individual steps:

Still in progress
OK

Displays detailed trace information which is
generated during call setup by the modem.

Initiates a new remote connection.
Interrupts the existing remote connection.

Transmits all of the configuration files to the
ECOTEL® (ECOTEL.UPB, ECOTEL.BSB and
RTBL.TXT).
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Upload Reads all of the configuration files from the

Configuration ECOTEL® (ECOTEL.UPB, ECOTEL.BSB and
RTBL.TXT) and then switches to the Clock
configuration page.

l@a Note: Using this download or upload function,
you can perform downloads and uploads in a
single step from:

- Gateway Configuration
- Basic Configuration and
- Routing Table
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6.6 Basic Configuration module

The Basic Configuration module is generally used only once after
gateway installation in order to enter the settings for the ISDN
interfaces (TE or NT mode, PTP or PTMP, etc.) and the IP
addresses for the LAN interface. Afterwards, you do not need to
modify these parameters anymore.
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6.6.1 Basic Configuration: Main window

Note: The main window is labeled ECOTEL Configuration
Software in the title bar. It is distinguished from the main window
of the Gateway Configuration module by a different tree view.

Call: From any of the modules, using Tools > Start > Basic
Configuration.

l@ Note: If access via the Modem interface is configured for
the device, you need to set up a remote access connection
before you can call the Basic Configuration module.

Operating elements

The operating elements are the same as the ones used in the
Gateway Configuration main window (see there).

The main difference is that here in Basic Configuration,
configuration files of type *BSB are processed which contain
basic settings for the ISDN interfaces.

The information under Gateway Configuration about the
peculiarities of the file name ECOTEL.UPB also apply to the file
name ECOTEL.BSB.

== 6.3.1 Gateway Configuration: Main window
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6.6.2 Basic Configuration: ISDN Interfaces

Call: In Basic Configuration main window, select the ISDN
Interfaces tree node.

Here, you can make the basic settings for the two ISDN
interfaces. The best settings will depend on the operating mode
and the connection type. You can find more information under the
description of the individual connection types.

== 3.2 ISDN interface: Selecting the ISDN connection type
For retrofitting of BRI 1 with terminating impedances:
== 9.3.1 BRI1 connection

ISDN interface BRI 1

L1 Mode Determines whether layer 1 of this interface is
operated in terminal or network mode.
Connection Determines whether this interface is operated

using the point-to-multipoint protocol (PTMP) or
the point-to-point protocol (PMP).

Termination Interface BRI 1 does not have a terminating
impedance. If one is required, you should use
BRI 2. If necessary, however, it is also possible
to retrofit BRI 1 with terminating impedances.

L2 Mode Determines whether layer 2 of this interface is
operated in terminal or network mode.
L3 Mode Determines whether layer 3 of this interface is

operated in terminal or network mode.
ISDN interface BRI 2

L1 Mode Determines whether layer 1 of this interface is
operated in terminal or network mode.
Connection Determines whether this interface is operated

using the point-to-multipoint protocol (PTMP) or
the point-to-point protocol (PMP).

Termination Interface BRI 2 has a fixed terminating
impedance of 100 Ohm. If none is required, you
should use BRI 1.
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L2 Mode

L3 Mode

=

Basic settings
L1 Clock

L1 from BRI 1/2

Coding

Determines whether layer 2 of this interface is
operated in terminal or network mode.

Determines whether layer 3 of this interface is
operated in terminal or network mode.

Note: In general, the same setting will make
sense for layers 1, 2 and 3 of an interface, see
the connection option which is in the same line
(e.g. Terminal device - PTMP).

Any deviations will be necessary only for the
very particular connection types.

If both interfaces are configured as a terminal,
this determines which one ECOTEL®
synchronizes itself to, i.e. where it gets its clock.

Otherwise, the device synchronizes itself to the
network clock, i.e. to the interface configured as
the network. If it does not find a clock there, it
generates one itself.

In the Clock Only setting, ECOTEL® obtains
only the clock from the interface, but it does not
transmit anything itself. Calls are not possible
via this interface.

In the RX/TX setting, the receive and transmit
directions are fully available, and calls are
possible (along with clock synchronization).

Currently, only A Law coding is available.
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6.6.3 Basic Configuration: IP Connection

Call: In Basic Configuration main window, select the [P

Connection tree node.

@ Note: Only ECOTEL®voiP has all of the described settings
available. The remaining types only have the parameters
found under Device.

If you are using an ECOTEL%Ispnz-1 with a firmware
version prior to 3.0, make these settings in the Firmware
Tools module under |P address.

ECOTEL® uses two different IP addresses to configure the device
parameters and for IP telephony.

Device
IP address

Subnetmask

Standard gateway

The IP address for ECOTEL® which you should
obtain from your network administrator.

This IP address is needed to be able to
configure ECOTEL® via the IP interface.
When the device is shipped from the factory, it
is as follows: 192.168.10.10

The subnetwork mask which you should obtain
from your network administrator.

Along with the IP address, this number
indicates the network to which your computer
belongs.

The IP address of the standard gateway which
you may wish to add. You can also obtain this
address from your network administrator.

The standard gateway routes the data traffic to
destinations outside the local area network.
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SIP
IP address

DNS

IP address
(preferred)

IP address
(alternative)

STUN
Activate

Use fix IP address

IP address
(preferred)

Domain name
(preferred)

Port

IP address
(alternative)

The IP address at which the internal SIP server
in ECOTEL® can be reached. It must be
different than the IP address in the Device field,
but it must belong to the same network and be
valid.

When the device is shipped from the factory, it
is as follows: 192.168.10.11

The IP address of the preferred domain name
server (DNS). You can also obtain this address
from your network administrator.

ECOTEL® needs a DNS to resolve the domain
names of the SIP outbounds.

The IP address of an alternative domain name
server.

You can specify here whether a STUN server is
to be used.

It is used to allow VolP connections across a
firewall.

Determines whether the STUN server should
be addressed directly using its IP address.
Otherwise, the domain name is used.

The IP address of the preferred STUN server.
You can also obtain this address from your
network administrator.

(Visible only if the option Fix |P address is
activated)

The domain name of the preferred STUN
server. You can also obtain this address from
your network administrator.

(Visible only if Fix IP address is deactivated)

The standard port is 3478. Enter a different
value only if your STUN administrator
specifically indicates a different value.

The IP address of an alternative STUN server.
(Visible only if Fix IP address is activated)
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Domain name The domain name of an alternative STUN
(alternative) server.

(Visible only if Fix IP address is deactivated)
Port The standard port is 3478. Enter a different

value only if your STUN administrator
specifically indicates a different value.

Send NAT 'keep Determines the interval at which ECOTEL® logs
alive’' every ... into the STUN server in order to maintain the
seconds STUN function even when there is no call.
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6.6.4 Basic Configuration: Device

Call: In the Basic Configuration main window, select the Device
tree node.

The structure and function of this page corresponds to that of the
page with the same name in the Gateway Configuration module
(see there).

-2 6.3.13 Gateway Configuration: Device
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6.7 Monitor module

& Note: This module is not available with ECOTEL”ISDN2-1.

The Monitor module is used to display the status of each channel
of a gateway (ECOTEL®). It is also possible to generate statistics,
e.g. about the utilization of individual channels or the complete
gateway. The data are called up by the gateway at an adjustable
time interval and displayed in the software interface.

l@ Note: To allow access to the monitoring information on the
computer, the Activate online monitoring box must be
checked in the Gateway Configuration module under
Maintenance.

When you exit the Monitor window, you will be automatically
returned to Service Gear.

ECOTEL® VolP/ISDN2-1/ISDN2-2 Edition 3.2-EN — 20060530 Page 217



VIERLING

6.7.1 Monitor: Main window

Call: From all modules via Tools > Start > Monitor.

The structure and functioning of the operating elements corre-
sponds to the main window in the Routing Table module; see
there.

The elements of the tree view and the corresponding detail win-
dows which are described in the following sections are different.
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6.7.2 Monitor: Channels

Call: In the Monitor main window, mark the Channels tree node.

This displays all of the channels which are supported by the
hardware along with their status.

Channel

Type
State
(Green icon)

(Yellow icon)

(Blue icon)
(Red icon)
IMSI

IMEI

Name of the channel:
G1.n;11,12;V0, V1.n

(V 0: via internal SIP server;
V1, V2 ..:via external SIP outbound 1, 2, ...)

Interface type: GSM, ISDN or VolP
Availability of the channel:

Channel is ready
(or special case: roaming, low funds)

Channel has been deactivated; or, in case of a
VolP channel, the corresponding SIP outbound
is not configured

Channel is being prepared (wait for ready)
(or more specific: searching, reboot)

Channel has encountered an error
(or more specific error cause)

(Only with GSM channels:) IMSI of the GSM
module

(Only with GSM channels:) IMEI of the GSM
module
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6.7.3 Monitor: Statistics

Call: In the Monitor main window, mark the Statistics tree node.

Statistical data are displayed about the calls that were made.

The data are from the file ECOTEL.mon on the device. These
data are retained even when the firmware is updated.

Channel

Incoming
Outgoing
Connections

APartner disc.

BPartner busy

Local busy

ASR 1

ASR 2

Name of the channel:
G1.n;11,12;V0,V1.n

(V 0: via internal SIP server;
V1, V2, ..:via external SIP outbound 1, 2, ...)

Number of incoming calls (in the direction of
ECOTEL®)

Number of outgoing calls (routed along by
ECOTEL®)

Number of calls for which a connection to the B
subscriber was made

Number of calls which were disconnected by
the A subscriber before the call could go
through

Number of calls for which the B subscriber was
busy

Number of calls for which the outgoing port of
ECOTEL® or the network between ECOTEL®
and the B subscriber was blocked

(Average Seizure Ratio 1):

Percentage of calls for which a connection was
made, including calls disconnected by the A
subscriber;

= (Outgoing — local busy) / Outgoing * 100

(Average Seizure Ratio 2):
Percentage of calls for which a connection was
made, without the calls disconnected by the A
subscriber;
= (Outgoing — local busy — APartner disc.)

/ Qutgoing * 100
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Avg duration [s] Average connection duration (in seconds);
= Duration / Connections

Duration [s] Total duration of all calls with a completed
connection (in seconds)

Clear Statistics Deletes all of the existing statistical data

ECOTEL® VolP/ISDN2-1/ISDN2-2 Edition 3.2-EN — 20060530 Page 221



VIERLING

6.7.4 Monitor: Connections

Call: In the Monitor main window, mark the Connections tree

node.

This page displays online all of the connections which are passing

via ECOTEL®.

l@? Note: To allow access to the monitoring information on the
computer, the Activate Online Monitoring box must be
checked in the Gateway Configuration module under
Maintenance.

Terminated connections remain in the list (indicated using a red
font) until the set time duration has elapsed or the window is

closed.

Port In
Calling Party
Port Out
Called Party
Status
Setup
Alert
Connect
Release
Call Duration [s]

Display options

Remove released
connections after

Input channel on ECOTEL®

Number of the calling party

Output channel on ECOTEL®

Number of the called party

Status of the connection. Possible values:
Connection being established

B subscriber being alerted

Connected

Connection terminated

Connection length (in seconds)

Terminated connections are deleted from the
list after the set time duration (in seconds).
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6.7.5 Monitor: SIM Statistics

Call: In the Monitor main window, mark the SIM Statistics tree

node.

Here, you will see information on using the individual SIM cards.

Module
GSM1 (2, ...)

Time
Limit

Charged

Used

Location A (B, ...)
Total

Reset SIM counters
of

Module

Single card

All

This line shows the SIM cards that belong to
GSM module 1 (or 2, ...).

Maximum permissible call duration for the
relevant SIM card (can be set in the SIM
Management module under GSM 1 (2, ...))

The call duration charged by the provider. The
entire interval is counted for charge intervals
that are begun.

The actual call duration without taking into
account the charge intervals

Card position (slot) on the SIM cardholder

This column shows the totals for Limit,
Charged, Used for all of the SIM cards in a
GSM module.

Resets the Charged and Used values to zero.
The Limit value is not modified.

You can use this function after exchanging SIM
cards, for example (there is no automatic reset).

The reset applies to all of the SIM cards in a
module. Select a module beforehand by clicking
on the GSM 1 (2, ...) button.

The reset applies to only a single SIM card.
Select a SIM card beforehand by clicking on
one of the three number fields for the card.

The reset applies to all of the SIM cards in
ECOTEL®.
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Display options

h:mm:ss Switches the time format (display in hours,
m:ss minutes or seconds).

s

Show index Displays the absolute index for each SIM card.

This number is used (instead of the module no.
+ location no.) to designate the card, e.g. in
trace reports.
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6.8 SIM Management module

l]&? Note: This module is not available with ECOTEL®ISDN2-1.

The SIM Management module has two functions: On the one
hand, setup data (mobile radio numbers, etc.) for the SIM cards
are managed here. On the other hand, you can control the
switching here, i.e. automatic switching between SIM cards.

Assigning SIM cards to GSM channels

Each GSM module in your ECOTEL® corresponds to a GSM
channel which can be used to make calls. You can assign multiple
SIM cards to each GSM channel (2, 4 or 8 SIM cards depending
on the type of SIM cardholder you are using).

Each SIM card has a fixed assignment to a GSM channel, i.e. the
card can be used only for this one channel.

On the SIM cardholder, the slots for the individual cards are
labeled as 1A, 1B, ... 2A, 2B, ... They are related as follows:

GSM channel 1 Cardholder in SIM slot 1 Cards 1A, 1B, ...
GSM channel 2  Cardholder in SIM slot 1 Cards 2A, 2B, ...
GSM channel 3  Cardholder in SIM slot 1 Cards 3A, 3B, ...
GSM channel 4  Cardholder in SIM slot 1 Cards 4A, 4B, ...

GSM channel 5 Cardholder in SIM slot 2 Cards 1A, 1B, ...
GSM channel 6  Cardholder in SIM slot 2 Cards 2A, 2B, ...
GSM channel 7  Cardholder in SIM slot 2 Cards 3A, 3B, ...
GSM channel 8  Cardholder in SIM slot 2 Cards 4A, 4B, ...

When it is clear which GSM channel we mean, we sometimes use
card A, B, ... for short.
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Groups of SIM cards

The SIM cards belonging to a GSM channel can be divided into
groups. Switching always occurs within a group. You can specify
when each group is valid.

This makes it possible, for example, to use cards for provider X at
certain times and cards for provider Y the rest of the time in order
to take advantage of the best rates.

For each GSM channel, up to 10 groups can be used. The
settings are made in windows SIM Group 1 to SIM Group 10
underneath the appropriate tree node GSM 1 (2, 3, ...).

-2 6.8.4 SIM Management: GSM 1..n: SIM Group 1..10

For each GSM channel, at least one group with associated SIM
cards must exist in order to allow outgoing calls via this channel. A
SIM card must be associated with at least one group in order to
be used.

When the device is shipped from the factory, (only) the SIM card
in slot 1A is assigned to SIM Group 1 and this group is activated
for the entire time. All calls take place via this single SIM card.

You can also assign a card to multiple groups. ECOTEL® inter-
prets this as follows: If an outgoing call is to be set up via a GSM
channel, ECOTEL® checks the associated groups in order starting
with group 1. If a group is found which is currently valid and con-
tains at least one usable card, its settings are used and the
following groups are ignored. If ECOTEL® does not find a usable
group (time condition not fulfiled anywhere, cards expired, etc.),
the call is not made.

,;:F""rr;,l Warning: Make sure that your group settings are
_;::'-’ ' W, compatible with the entries in the routing table!

% % Forexample, if the routing table stipulates that a call is to
be routed via GSM port x but no SIM card group is
currently valid for GSM x at this time, the call will not be
made. The same thing will happen if SIM cards are
enabled via the group but the routing table does not allow
the call.
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6.8.1 SIM Management: Main window

Note: The main window is labeled ECOTEL Configuration
Software in the title bar. It is distinguished from the main window
of the Gateway Configuration module by a different tree view.

Call: From any of the modules, using Tools > Start > SIM
Management.

Operating elements

The operating elements are the same as the ones used in the
Gateway Configuration main window (see there).

The main difference is that here in Basic Configuration, configu-
ration files of type *.SMC are processed which contain settings for
the administration of SIM cards.

The information under Gateway Configuration about the peculi-
arities of the file name ECOTEL.UPB also apply to the file name
ECOTEL.SMC.

-2 6.3.1 Gateway Configuration: Main window
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6.8.2 SIM Management: SIM Cardholder

Call: In the SIM Management main window, mark the SIM
Cardholder tree node.

SIM management

center
External Management of the SIM cards via an external
(connected via IP) SIM management center
IP address IP address of the external SIM management
center

If the SIM emulation board is selected under
SIM slot 1 or 2, enter the |P address of the SIM
server on which the cards are located.

Local SIM Management of the SIM cards locally in
configuration ECOTEL®; settings are made in the SIM
Management module
SIM slot 2 Indicate here the type of SIM cardholder in slot
2 (for GSM modules 5-8)
SIM slot 1 Indicate here the type of SIM cardholder in slot

1 (for GSM modules 1-4)
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6.8.3 SIM Management: GSM 1..n

Call: In the SIM Management main window, mark the GSM 1 (2,

3, ...) tree node.

GSM module n -
available SIM cards

Inserted at

Use data of first
card at all cards of
this module

L,

i
Al by

P

Copy PIN

Copy clock
model

Copy LAIN
condition

Copy calltime
limit

Copy service
center number
Copy all

Properties
PIN

Lists the available SIM cards for this GSM
module. How many depends on the setting
under SIM cardholder.

Select here the SIM card you wish to edit. The
data for the relevant card are displayed in the
Properties field.

You may use the buttons of this group for
easier editing if SIM properties are the same for
all SIM cards belonging to this module.

Warning: By using the copying functions, all
previous data will be overwritten without
warning!

Copies the PIN of SIM card A to SIM cards B,
C, etc.

Copies the properties under Clock model in
seconds of SIM card A to SIM cards B, C, etc.

Copies the properties under Lock to preferred
LAIN of SIM card A to SIM cards B, C, etc.

Copies the properties under Calltime limit for
each SIM card of SIM card A to SIM cards B, C,
etc.

Copies the Service center number of SIM card
Ato SIM cards B, C, etc.

Copies all of the above properties of SIM card A
to SIM cards B, C, etc.
The Mobile number is not copied.

Enter the PIN for the SIM card here. The PIN is
used by ECOTEL® for authentication with
respect to the SIM card.

The PIN is transmitted to ECOTEL®.when the
configuration file is downloaded.
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Clock model in
seconds

Lock to preferred
LAIN

LAIN

Warning: Do not insert SIM cards into the
device before configuring the correct PINs and
only modify a PIN when the SIM card is
removed since otherwise access problems and
blockage of the card can possibly result.

The sequence is as follows:

— Remove the old SIM card(s) (if necessary)
— Enter the new PIN(s)

— Transmit the configuration to ECOTEL®

— Insert the new SIM card(s)

Note: To change the PIN on the actual card,
insert it into a mobile phone and perform the
procedure required there. You cannot make
such a change using ECOTEL?®.

Here, you should enter the charge timing for the
rate model for the installed SIM card. This value
is used to compute when the call time limit is
reached (see below). The first entry indicates
the duration of the first charge pulse in seconds
and the second entry indicates the spacing
between all subsequent pulses.

Example: 60/ 1 means that for the first pulse,
the charges are computed for 60 seconds,
while for each further pulse the charges are
computed for one second.

Here, you should enter the LAIN (Location Area
Identification Number) of the GSM network in
which the installed SIM card should register.

If no LAIN is entered, the SIM card will register
in the network with the best reception.

You can get more details about the network
operators which are available locally in the
Firmware Tools module on the GSM
parameters page.
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allowed

Overall calltime
limit

Use limit of ...
minutes

per ...
starting

(dd.mm.yyyy) ...

Mobile number

Service center
number

Info
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If roaming is allowed, a SIM card can also
register in an outside GSM network if
registration fails under the specified LAIN.

If roaming is not allowed, the SIM card may
only register under the specified LAIN.

You can set a maximum for the total duration of
all calls via this SIM card. If this limit is reached,
ECOTEL® will not use this SIM card any longer.

This allotment is applicable to a certain time
period, e.g. per month. After this, the counter is
reset and the allotment is available again.

Call time permitted per interval

Length of the standard interval

Start of the first interval (at 00:00 on the
specified day)

Telephone number of the SIM card which is
installed in the GSM module.

Number of the SMS service center for the SIM
card which is installed. This number is needed
so that ECOTEL® can send SMS messages.

Enter your notes here (deactivated in the
present version)
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6.8.4 SIM Management: GSM 1..n: SIM Group 1..10

Call: In the SIM Management main window under the GSM 1 (2,
3, ...) node, mark the tree node SIM Group 1 (2, 3, ...).

For more details about using the groups, see:
== 6.8 SIM Management module

Usage
On ...

from ... to ...
use SIM card(s) ...
Switch card:

Never

When 'time
registered’
exceeds ...

When ‘active call
time' exceeds ...

When 'outgoing
calls' exceed ...

(limit)
Execute switching:

Immediately

When active call
has been
released

... but at least
after ... seconds

Days of the week on which the group is to be
used

Start and end of the time of day interval during
which the group is to be used (hours : minutes)

SIM cards (for the selected GSM channel)
which should belong to the group

Determines when to switch to another SIM
card:

Never; always use card A

When the total time during which the card was
registered exceeds the limit

When the total duration of calls made exceeds
the limit

When the number of outgoing calls exceeds the
limit
Entry field for the limit

Determines how to handle calls which are
underway at the switching time:

Switch immediately and interrupt call
Switch after call is complete

ECOTEL® first waits for the "natural” end of the
call, but after the set time interval it interrupts
the call and makes the switch.
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'‘Round Robin'
(use next card)

Take 'least used'’
card

Take 'least used'
card, but
different from
last

Charging
information

t1

x1
t2
x2

VIERLING

Determines which card is next in line

The cards are used in order and the last card is
followed by the first card

The least used card, i.e. the one with the least
active call time, is used next

As before, but the last card used is excluded

This determines for incoming calls from the
GSM side what charging information should be
made available to the ISDN side. Possible
values:

Generate none, or Generate in ECOTEL.

Forwarding of charging information from the
GSM network is not possible currently since
GSM networks do not send this information.

The following parameters control the generation
of charge units by ECOTEL®:

Duration of the first charging interval
Transferred units for the first charging interval
Duration of each additional charging interval

Transmitted units for each additional charging
interval

Note: The extent to which this information on
the ISDN side is forwarded to the called
subscriber depends on the settings for the
ISDN interface!

—=2* 6.3.3 Gateway Configuration: ISDN
Interface 1/2
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6.8.5 SIM Management: Device

Call: In the SIM Management main window, select the Device tree
node.

The structure and function of this page corresponds to that of the
page with the same name in the Gateway Configuration module
(see there).

-2 6.3.13 Gateway Configuration: Device
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6.9 User Registration module

The User Registration module is used to manage VolP users of
ECOTEL®. On the one hand, you can determine the parties that
ECOTEL® will accept incoming calls from via the VolIP interface.
On the other hand, you can list the users that can be reached via
ECOTEL®'s internal SIP server as VolP call destinations.

J 5~ Note: This module is only available with ECOTEL®volP.

When you exit the User Registration window, you will be
automatically returned to Service Gear.
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6.9.1 User Registration: Main window

Call: From all modules via Tools > Start > User Registration.

The structure and functioning of the operating elements corre-
sponds to the main window in the Routing Table module; see
there.

The elements of the tree view and the corresponding detail win-
dows which are described in the following sections are different.
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6.9.2 User Registration: Allowed Users

Call: In the User Registration main window, mark the Allowed

Users tree node.

(User table)

Domain

User

Password

Authentication Id

Comment
Entry

=

New...

Shows all authorized users of ECOTEL®, i.e.
the users that may register with the device. This
includes users that can be reached as a call
destination via ECOTEL®'s internal SIP server
as well as callers (including SIP outbounds) on
the VolP interface from whom calls are to be
accepted.

The domain name of the user.

If " is entered, ECOTEL® will accept any user.
This is valid only if "*" is also entered as a user.

The user name.

If "*" is entered, ECOTEL® will accept any user
from the domain. In this case, the password is
ignored.

The related password.

It can be "*" if the user is also "*". Otherwise, a
password must be entered.

Separate user identifier for authentication, if
required

Enter any comment about the user table.

Note: The functions New, Edit and Delete are
also accessible via context menu (right mouse-
click).

Double-click on an empty table row has the
same effect as New.

Double-click on the desired table row has the
same effect as Edit.

Opens the User Registration edit dialog to add
a new table entry.
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Edit...
Delete

] 4]
=

File

Upload from
Ecotel

Download to
Ecotel

=

=

New

Open...

Save As...
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Opens the User Registration edit dialog to edit
the selected table entry.

Deletes the marked table entries.

Moves the marked table entry up or down within
the list.

Reads the current user table from ECOTEL®
and displays it the left half of the window.

Note: The file which is read out always has the
name USER.TXT. The read operation from
ECOTEL? causes the user table which was
previously open to be discarded and the
existing file USER.TXT is overwritten on the
configuration computer (after asking for
confirmation).

Transmits the displayed user table to ECOTEL®
where it immediately goes into effect after
transmission.

Note: No check is made to see whether the
entries in the user table have logical values
(similar to the routing table). Please be sure to
follow the instructions given above!

Note: The transmitted file is always saved on
ECOTEL? under the name USER.TXT.

Discards the previously opened user table and
creates a new one.

Displays an Open File dialog which can be
used to select a user table saved on the
computer.

Displays a Save File dialog which can be used
to save the displayed user table on the
configuration computer.
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7 Making calls via ECOTEL
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7.1  Overview: What ECOTEL users must know

During call setup with ECOTEL®, users should be aware of two
peculiarities compared to the usual call procedure:

With some connection types (but not in LCR mode, for example),
the user must dial ECOTEL® first, i.e. the number of one of the
interfaces via which ECOTEL® can be reached (e.g. its extension
number or mobile radio number). Of course, the user will ideally
choose the number which can be accessed the easiest or the
most cost-effectively from his own telephone. ECOTEL® will
respond with a voice announcement. Now, the user can dial the
actual telephone number (no need to wait for the end of the voice
announcement) and is then connected by ECOTEL® to that
number.

The second peculiarity concerns the end of dialing: With the
destination phone number, ECOTEL® must recognize whether it is
already complete or whether there are further digits to follow. For
this purpose, it is possible to define fixed phone number lengths in
the routing table for specific destinations (e.g. this would make
sense for mobile radio or extension numbers). In the remaining
cases, the sequence of digits must be terminated with the number
sign #. ECOTEL® interprets a pause greater than 10 seconds as
the end of dialing.

Calls are routed by ECOTEL® depending upon the destination
number, the originating number or the redirecting number using
defined ports (111, 112, 121, 122, G1, G2, V, V1, V2), port groups (|,
G, 11, 12) or port lists.

The routing is stored in the RTBL.TXT file. You can edit this
routing table in the Routing Table module. See the separate
section for information about the routing options along with some
sample settings.

== 5 Introduction to the routing table

The examples given in the following sections relate to connections
between the ISDN fixed network and the mobile radio network.
However, they can also the applied to connections between the
VolIP network and the mobile radio network.
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7.2 Outgoing calls

7.2.1 Calls to an arbitrary mobile network subscriber

Operational sequences are different depending upon the type of
connection that has been selected for ECOTEL®. The caller will
be supported with appropriate voice messages and/or tone
signals in each instance.

When ECOTEL® is used as a terminal device on an internal
extension (in a multi-device configuration), the following
procedure applies:

» Select the ECOTEL® extension.

» ECOTEL® should respond with the following
announcement: "Mobile phone connection here."

»  Dial the phone number of the desired mobile phone
subscriber. It is not necessary to wait until the voice
announcement is completed.

l@ Note: £FCOTFL”'s factory default setting is set for a dialing
length of 11 digits for national traffic and 14 digits for
special services. Exceptions to the pre-defined lengths of
phone numbers must be entered in the routing table.
Dialing should be completed by inputting a # (number sign)
for telephone numbers with less digits.

» ECOTEL® confirms reception of the number to be dialed
with the voice announcement: "The call is being set up.
Please walit."”

»  Wait until the connection has been established and then
complete the call.
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For all other applications, these steps are not required. Instead,
the following numbers should be dialed directly:

Connection as a terminal device with point-to-point
connection (Terminal Equipment = TE, point-to-point
connection):

»  Only the number of the mobile network subscriber should
be dialed.

(It is assumed that the PBX routes all calls made to
destinations in the mobile network to ECOTEL®'s
extension.)

Connection on the exchange side to a PBX (Network
Termination = NT, point-to-point connection):

» The sequence should be dialed consisting of ECOTEL®’s

exchange code + telephone number of the desired mobile
phone connection.

Direct SO bus connection (Network Termination = NT, point-
to-multipoint connection, power supply unit may be
necessary):

»  Only the telephone number of the desired mobile network
connection should be dialed.

iy Warning: A dialing pause of 10 seconds between digits is
4 %, interpreted as the end of a telephone number. If the #
& " (number) key is pressed after the last digit, dialing is
E_® B immediately executed (applies only to DTMF dialing in the
voice channel). The timeout can be reduced in the

configuration.

e
+
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7.2.2 Calls using speed dialing

ECOTEL® is capable of completing telephone numbers with the
routing table. This function can be used to define speed-dialing
numbers.

Example:

By dialing 123, the telephone number 01701234567 is dialed, and
by dialing 56, the telephone number 01701111111 is dialed:

Entry in the routing table:

#Speed-dial list
(d123) n G:01701234567
(d56) n G:01701111111
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7.2.3 Setting up fixed connections

(Call forwarding to a mobile phone)

When required instead of manual destination dialing, ECOTEL®
can be set so that a call will be made to a pre-determined
telephone number in the mobile network.

This function is controlled using entries in the routing table.
Example:

Extension 123 should always be connected to the telephone
number 01701234567 .

Entry in the routing table:

#Fixed connection
(0123) n G:01701234567
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7.3 Incoming calls

7.3.1 Dialing an extension by the caller

(if your terminal device supports DTMF)

First, the caller dials ECOTEL®s mobile network number. After the
call has been successfully set up, ECOTEL® makes the voice
announcement: “Mobile radio connection here. Please input the
extension number."

The caller inputs the extension number and completes the
sequence with # (number sign). It is not necessary to wait until the
voice announcement is completed:

0171 XXXXXXX XXX#
Radio network number Extension number

'&9 Note: If you have defined the number of digits for the local
extension in the routing table, it is not necessary to input
the # in order to mark the end of the extension telephone
number.

== 5.4.4 Calls to an arbitrary extension (Example 2)
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7.3.2 Routing calls to a fixed extension

An option is available to route all calls to a predetermined
extension of your PBX. All necessary information must be entered
into the routing table.

The caller only has to dial the ECOTEL®s mobile network number.
The caller incurs costs only when the fixed extension responds.

ECOTEL® also offers the option of reaching several extensions
that have been predetermined. This is dependent upon the caller's
telephone number.

Example:

All incoming calls from the mobile network (starting with 01) are to
be routed to extension 100 (the telephone exchange).

Entry in the routing table:

#Incoming calls to extension 100
(o01) n 11:100
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7.3.3 Redialing or new dialing

If the desired subscriber number is occupied, if no one picks up or
if several calls are to be made, then new dialing can be performed
within a PBX. This eliminates the need to make a new call each
time over the mobile network.

If an extension is erroneously dialed, then new dialing allows a
correction. If required, new dialing can be used repeatedly during
a call.

If the subscriber is busy, the caller hears either a busy signal or a
voice announcement. If the number is busy, 10 seconds are
available in which to begin dialing a new number.

l@ Note: To be able to use new dialing, the options Release
on completed or Release on busy (Gateway Configuration
module > GSM Interface 1..n) must be deactivated so that
ECOTEL? does not interrupt the connection to the calling

party.

New dialing within a PBX
»  Without hanging-up, dial:
*XXX#

After entering "#" at the end of the procedure, entering the
extension number is regarded as complete, and the connection
will be set up. See also the following section:

== 7.3.1 Dialing an extension by the caller
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7.3.4 Call forwarding

During a call, the called subscriber B can connect the calling
subscriber A to a third subscriber C.

»  Dial without first hanging up:
* 2 # <Telephone number for C> #

Since subscriber A is still the calling party, the forwarding must be
permissible in compliance with the routing table.
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7.4 Call hold switching between subscribers

l@g Note: This feature is currently available only with
ECOTEL®ISDN2-1.

Initiating call hold

If there is already a connection between a calling subscriber A
and a called subscriber B, either of these two parties can initiate
call hold, i.e. make an additional call to subscriber C.

»  Without hanging up beforehand, dial:
* 3 # <Telephone number for C> #

l@ Note: A separate GSM channel (i.e. a separate SIM card)
must be available for each GSM subscriber.

If the additional called subscriber C does not answer, the
subscriber who initiated the procedure can restore the old
connection as follows:

» Dial the key combination * 3 #

If the called subscriber C is busy or there is not a free GSM or
ISDN channel in ECOTEL®, then the old connection will be
automatically restored.

If the new call is successful, the existing called party of the
subscriber who is carrying out this procedure will be put on hold,
i.e. the party will hear a hold announcement or music until the
other party switches back.
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Switching between the different calls

Once the call is connected to C, the subscriber who initiated the
call hold procedure can switch between the two calls:

» Dial the key combination * 3 #

Forwarding a call

The subscriber who initiated the call hold procedure can connect
the other two parties. He or she will be disconnected:

» Dial the key combination * 4 #

Ending call hold

Call hold ends when one of the parties hangs up. The subsequent
connection status depends on which party hung up:

— If the original calling subscriber A initiated the call hold
procedure and hangs up, all of the connections will end.

— If the original called subscriber B initiated the call hold
procedure and hangs up, A and C will be connected.
(B can achieve the same effect by forwarding the call with
4 4)

— If the currently held subscriber hangs up, the remaining
active connection will be maintained. If the subscriber who
initiated the call hold procedure later attempts to switch
back to the subscriber who was on hold, he or she will hear
an announcement that this party is no longer available.

— If the currently active subscriber (who did not initiate call
hold) hangs up, the connection will be reconnected
between the party who initiated call hold and the party on
hold.

Once one party to a call initiates a call hold procedure, the other
two parties cannot initiate a call hold procedure themselves.

If the call hold procedure is terminated by one of the subscribers
hanging up and the connection remains between the other two
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subscribers, at this point either of these two subscribers can
initiate a call hold procedure if desired.
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8 Additional topics and background
information
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8.1 Overview: Gaining a better understanding of
ECOTEL

This section includes some additional background information.
You can refer to this section when you want to get a better grasp
of the basic concepts behind ECOTEL®.

ECOTEL® VolP/ISDN2-1/ISDN2-2 Edition 3.2-EN — 20060530 Page 253



VIERLING

8.2 Interpretation of the interface version

The following modules in Service Gear are used to process
configuration files for ECOTEL®: Gateway Configuration, Basic
Configuration and SIM Management.

If new features are added to ECOTEL® as part of the product
development process, it is possible that parameters will be added
to the configuration files or modified. However, it should still be
possible to manage devices with older software versions using
Service Gear.

Accordingly, these modules use what is known as interface
versions. This means that the user interface of the module is
available in different versions. The versions differ in terms of the
parameters that can be viewed by the user and the parameters
that are contained in the configuration files that are generated.

You can specify the interface version by accessing the menu item
File > New... and selecting a version in the dialog that follows. The
version must agree with the firmware version used in ECOTEL®.
This is selected separately in each of the modules listed above.

You can view the selected interface version later at any time on
the page Device in the relevant module.

Please be aware that this manual always describes the latest
interface version for these modules. Older interface versions can
differ from what is described here.

The interface version is not relevant in the other modules.
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8.3 ECOTEL Glossary

This section explains some of the terms WhICh in some cases
have a specific meaning in relation to ECOTEL® when compared
to everyday usage.

Access code

This is used during — Remote access by the —Modem in order to
authenticate itself to ECOTEL®. This also allows ECOTEL®
recognize the remote access procedure (as opposed to a normal
call).

Do not confuse the — Access code with the — Security code.

Configuration computer
The computer (PC, laptop) which is used to configure ECOTEL®.

Direct access
See — Remote access

Download
In ECOTEL® Data transmission from the configuration computer

to ECOTEL®.

ECOTEL code
An older term for — PUK

Incoming (arriving) call
See — Qutgoing call
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Modem

In everyday terms, this is a device which is used in data trans-
mission to convert data between different interface types, e.g.
from a serial computer interface to an analog telephone line.

In ECOTEL®: A device which enables access by the configuration
computer to an ECOTEL® via its GSM interface. Here, an
ECOTEL® is also used typically. For more information, see the
following section:

== 4.3.2 Connecting via modem

Outgoing call

In ECOTEL®: A call in which an extension of the PBX calls via
ECOTEL® an “external” destination in the fixed network, GSM
network or VolP network.

An incoming (arriving) call takes place in the opposite direction.

Together, ECOTEL® and the PBX with its extensions are
considered as "here".

(If we consider ECOTEL® alone, all calls are "transient", meaning
they arrive via some interface and leave via some other interface.)

PUK

In general terms: Personal unblocking key (a code which is
entered to unblock a device).

In ECOTEL®: An additional security code (also known as — Secu-
rity code 2).

If the normal — Security code is incorrectly entered multiple times,
it is automatically blocked. To unblock it, it is necessary to use the
PUK instead of the normal security code.

== 6.5.3 Firmware Tools: Security Code
Remote access, remote connection

A technique which the — Configuration computer uses to access a
remote ECOTEL®.
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Using a —Modem, a connection is established to ECOTEL® via
GSM. The transmission path from the computer via the modem to
ECOTEL® is referred to as the Remote access or Remote
connection. For more information, see the following section:

== 4.3.2 Connecting via modem

The other possibility is Direct access by the computer to
ECOTEL® via IP, USB or serial cable.

Security code

The code which the — Configuration computer uses to identify
itself to ECOTEL® (authentification).

During — Remote access, besides the security code for the
ECOTEL® to be configured, the security code for the — Modem is
also important since the configuration computer must also
authenticate itself to the modem.

See also the — Access code.

Security code 2
Same as —PUK.

SIM PIN

The personal identification number (PIN) which is needed to log
into a mobile radio network with a SIM card.

With a mobile phone, the user types in the PIN. With ECOTEL®,
the SIM PINs for all of the SIM cards are saved in the device and
are passed to the relevant GSM module when needed.

SMC
Abbreviation for SIM Management Center.

Upload

In ECOTEL®: Data transmission from ECOTEL® to the configu-
ration computer.
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8.4 General information about VolP

& Note: This section is relevant only for ECOTELVolp.

With voice over IP (VolP), speech data do not travel over a tele-
phone line. Instead, they are transmitted in packets, i.e. no line is
connected from the caller to the called party. Speech information
is transmitted in packets via the Internet to the destination
address. The individual speech packets can follow different paths
through the Internet and sometimes overlap one another. This
means that packets which were sent later can arrive at the
destination earlier than others. At the destination, it is necessary
to put these speech packets back in the proper sequence and
convert them into an analog speech signal.

Similar to ISDN, Internet telephony has a signaling channel for
controlling the connection and a data channel for the speech
information. ECOTEL® uses SIP (session initiation protocol) for
controlling the connection. For use in transporting speech data,
RTP (real-time transport protocol) is used.
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8.4.1 Explanation of VoIP terms

IP address

An |P address consists of four numbers from 0 to 255 which are
separated from one another by periods. Such an address
identifies a computer in the Internet.

Subnet mask

Along with the IP address, this number indicates the network to
which your computer belongs.

A subnet mask has the same format as an IP address. It is
conventional to only use 0 or 255 as values (e.g. 255.255.255.0).
owever, other values can also occur. They indicate that
subnetworks are used in a particular TCP/IP network.

Standard gateway

This is used to supplement the IP address of a computer. It is the
address of a local IP router which is located in the same network
as the relevant computer (here: ECOTEL®) and which is used to
forward data traffic to destinations outside of the local area
network. The value in this field must be in the range from 0 to 255.

A gateway is the connection or exchange via which IP networks
are interconnected. For example, local area networks (LANS)
often need a gateway in order to connect to a wide area network
(WAN) or to the Internet.

User agent (UA)

In the context of VoIP, a user agent is a piece of hardware or
software for SIP-based communication which offers the functions
normally provided by conventional telephones (dialing, ringing,
microphone, loudspeaker, etc.). A UA can act as a user agent
client (UAC) or as a user agent server (UAS). A UAC is the
initiator of a SIP communication (calling party, A subscriber). The
UAS (called party, B subscriber) responds to the request of the
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UAC. As a general rule, in a VolP telephone (hardware or
software) both a UAC and a UAS are implemented. Depending on
its role, a VolP telephone can alternate between serving as a UAC
and a UAS in the communication process.

Proxy server

A proxy server acts as a way station on the path from the calling
UAC to the called UAS. In this configuration, the UAC does not
send its messages (e.g. INVITE) directly to the UAS. Instead, it
uses a proxy server. The proxy server forwards the message (e.g.
INVITE) to the UAS and sends its response (e.g. 100-Trying or
180-Ringing) back to the UAC. In many cases, the proxy server is
combined with a registrar.

Registrar

Any UA can register with the registrar server using the REGISTER
message. The registrar then saves the current IP address and SIP
address (SIP-URI) of the user. If necessary, other SIP elements,
e.g., a proxy server, can access this information.

Redirector

A redirector (redirect server) saves information about the possible
location of a user. Upon request, it passes this information back to
the querying UA. However, the redirector does not actively
attempt to find the user (unlike a proxy server). Instead, the
querying UA must send a new request to the address(es)
obtained from the redirector.

SIP server

A SIP server generally combines the proxy server, registrar and
redirector components. Common synonyms for SIP server are soft
PBX or IP PBX.

NAT

In computer networks, network address translation (NAT) is a
technique for replacing an IP address in a data packet with a
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different IP. This is commonly used to map private |IP addresses
on public IP addresses.

NAT is required mainly because public IP addresses are
becoming scarcer and private IP addresses can be used as
needed in an internal (private) network. To allow communication
over the Internet, the internal private addresses must be
translated into public addresses at the gateway to the Internet (or
to another public network).

Normally, NAT is performed at the interconnection between two
networks. An NAT device can be a router or a firewall, for
example.

STUN

STUN (Simple Traversal of UDP Over NATS) is a simple network
protocol for detecting the presence and type of firewalls and NAT
routers and for circumventing them. It is intended to enable
straightforward usage of devices (e.g. SIP telephones) in home
networks which wish to receive data from the Internet.

Using STUN, the current public IP address of the connection can
also be determined. For example, this allows a SIP telephone
behind a DSL router to determine its currently valid public IP
address. The B subscriber is informed of this address and can
now send response packets to this address.
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8.4.2 Codec

A codec (COmpressor/DECompressor) is a chip or algorithm
which compresses data or speech and allows decompression of
the same data or speech at the other of the connection. Various
codecs have been standardized which compress speech data with
different levels of quality loss in order to be able to transmit
speech over channels with a narrower bandwidth or to transmit
more channels over a fixed bandwidth. The following codecs are
implemented in ECOTEL®:

— G.711 PCM at 64 kbit/s

— G.726 and G.727 E-ADPCM at 16 to 40 kbit/s
— G.729/Annex A CS-ACELP at 8 kbit/s

— G.723.1 MP-MLQ/ACLEP at 6.3/5.3 kbit/s

Each codec can be activated or deactivated using the
configuration software.
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8.4.3 VolIP and Security

By its very nature, telephony over the Internet requires
transmission of signaling and speech data from a private IP
network to the public IP network and vice versa. For technical
reasons and also due to the security requirements of the private
network, this has certain limitations.

Some important issues come up here in relation to the NAT
problem (see above) and firewalls. This manual will not consider
these problems in detail. We recommend that you study this issue
in the context of VolP.

ECOTEL® VolP/ISDN2-1/ISDN2-2 Edition 3.2-EN — 20060530 Page 263



VIERLING

9 Special hardware-related issues
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9.1 Display elements on the housing

9.1.1 Display elements on the housing: ECOTEL VolP

The LEDs on the housing indicate the overall status of the device
as well as the ISDN (BRI) and GSM interfaces

In the maximum configuration, eight GSM modules are installed in
the ECOTEL®. Four LEDs are available for displaying the status
of these GSM channels, i.e. each LED indicates the status of two
GSM channels.
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LED Status Meaning
ON Off Device powered down (no voltage)
ON Green Device ready for operation
ON Flashing green Device booting up

ECOTEL® VolP/ISDN2-1/ISDN2-2 Edition 3.2-EN — 20060530 Page 265



VIERLING

BRI 1
BRI 1

BRI 1
BRI 1
BRI 1

BRI 2
BRI 2

BRI 2
BRI 2
BRI 2
GSM x/y’

GSM x/y’

GSM x/y’

GSM x/y’
GSM x/y’

GSM x/y’

Off
Flashing yellow

Flashing green
Yellow
Green

Off
Flashing yellow

Flashing green
Yellow

Green

Off

Flashing yellow

Flashing green

Flashing red
Yellow

Green

ISDN port 1 is deactivated

Port is in TE mode, is activated and L1
is not active

Portis in NT mode, is activated and L1
is not active

Port is in TE mode, is activated and L1
is active

Portis in NT mode, is activated and L1
is active

ISDN port 2 is deactivated

Port is in TE mode, is activated and L1
is not active

Portis in NT mode, is activated and L1
is not active

Port is in TE mode, is activated and L1
is active

Portis in NT mode, is activated and L1
is active

GSM modules x and y are registered
or deactivated

GSM module x not registered
GSM module y is registered or
deactivated

GSM module y not registered
GSM module x is registered or
deactivated

GSM modules x and y are not
registered

GSM module x and GSM module y are
busy

GSM module x or GSM module y is
busy

*x = GSM module 1 to 4, y = GSM module 5to 8

Note that flashing overrides continuous light. For example, if GSM
module 1 is registered and GSM module 5 is not registered and GSM
module 1 is busy, LED 1 will flash yellow (it will not show green!).
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9.1.2 Display elements on the housing: ECOTEL

ISDN2-1

The LEDs on the housing indicate the overall status of the device
as well as the ISDN (BRI) and GSM interfaces

i
I

LED
ON
ON
ON

ON

GSM1/2

GSM1/2
GSM1/2

ECOTELISDN <= 0 ¢

T L (] [ [l i L
S S S R o N A
o s R e = R B R
e - I B OB
S I R S o B R

7l

]

| < 1 1 ( i

- ] o O [
—_—_— {_7—_\,_

Status

Off

Lit

Flashing

Flashing quickly

Off

Lit

Flashing slowly

ECOTEL® VolP/ISDN2-1/ISDN2-2

Meaning

Device powered down (no voltage)
Device ready for operation

Device ready for operation, but the
basic setting for Sp-TE or Sp-NT is not
available.

System error

GSM module is registered and not
busy

GSM module is registered and busy

GSM module is not registered
(antenna missing, SIM card not
plugged in, PIN for SIM card is
incorrect, start up phase is running)
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GSM1/2
BRI1/2
TE
TE

TE

NT
NT

NT

Page 268

Flashing quickly

Off
Lit

Flashing quickly

Off
Lit

Flashing quickly

Hardware error in GSM module

Port is deactivated or in NT mode

Port is in TE mode, is activated and L1
is activated

Port is in TE mode, is activated and L1
is deactivated

Port is deactivated or in TE mode

Port is in NT mode, is activated and L1
is activated

Port is in NT mode, is activated and L1
is deactivated
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9.1.3 Display elements on the housing: ECOTEL
ISDN2-2

The LEDs on the housing indicate the overall status of the device
as well as the ISDN (BRI) and GSM interfaces

= —
1230 D0l )
g2
g2 -
B $5ee 4odt
f— —

LED Status Meaning

ON Off Device powered down (no voltage)

ON Green Device ready for operation

ON Flashing green Device booting up

BRI 1 Off ISDN port 1 is deactivated

BRI 1 Flashing yellow Port is in TE mode, is activated and L1
is not active

BRI 1 Flashing green Port is in NT mode, is activated and L1
is not active

BRI 1 Yellow Port is in TE mode, is activated and L1
is active

BRI 1 Green Port is in NT mode, is activated and L1
is active

BRI 2 Off ISDN port 2 is deactivated

BRI 2 Flashing yellow Port is in TE mode, is activated and L1
is not active

BRI 2 Flashing green Port is in NT mode, is activated and L1

ECOTEL® VolP/ISDN2-1/ISDN2-2

is not active
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BRI 2 Yellow Portis in TE mode, is activated and L1
is active

BRI 2 Green Portis in NT mode, is activated and L1
is active

GSM x Off GSM module is registered or
deactivated

GSM x Flashing GSM module is not registered

(antenna is missing, no SIM card is
plugged in, PIN for SIM card is
incorrect, start up phase is running)

GSM x Lit GSM module is busy
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9.2 Interfaces on the housing

The ECOTEL® housing allows the device to be used as a desk-
top model or it may be mounted on a wall.

ECOTEL®s interfaces are implemented on the sides of the
housing.

ECOTEL®voip

7_\'_' I
Ant 1 Ant2 BRI1 BRI2

e 100
- \J

DC [L":J r\_/ D 1o BB NT
L © =) T Tl C 0 e
L= 0L .

”_I !I |] T

Interface jacks on ECOTELVolP

ECOTEL®isbn2-1

I

BRI1 BRI2 }HHHHHHH
1000
v [0
V.24 Configuration '%B‘;‘!;'T

\(\ R ) -
e L L S|l

f 1L JI

Interface jacks on ECOTEL®ISDN2-1

ECOTEL® VolP/ISDN2-1/ISDN2-2 Edition 3.2-EN — 20060530 Page 271



VIERLING

ECOTEL isbN2-2
7_\ borts . J @M ’ /_Y
I_BRI2 BRI uss

L O O ~ J

Interface jacks on ECOTEL”ISDN2-2

BRI 1, BRI 2

The two ISDN interfaces BRI1 and BRI2 are used to connect
ECOTEL® to the PBX or to the ISDN fixed network.

RJ45 connecting cables are used.
For more details, see:
== 9.3 Interfaces BRI1, BRI2

1/0
(upon request)

RJ-45 jack with six input/output contacts which can be
programmed independently

LAN
In ECOTEL®volp, the LAN interface is used for VolIP telephony.
In all types, it can be used for configuring the device.

Connection to the network (Ethernet) is via a standard RJ45
network cable.

l@ Note: The factory default IP address for the configuration
interface of ECOTEL? is 192.168.10.10
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USB (not in ECOTELIspnz-1 1)
The USB interface (type B) is used to configure the device.
It is connected via a standard USB cabile.

V.24 (only in ECOTEL ispnz-1 1)
The serial interface V.24 (RS232) is used to configure the device.
It is connected via a standard serial cable.

DC

The supglied power supply is connected to the DC jack of
ECOTEL".

AN Warning: The guarantee for ECOTEL? is nullified if you
i ' % use a power supply which is not approved by VIERLING!

i_® % Different ECOTEL? types need different power supplies
since their power consumption is different!

Ant 1, Ant 2

Connectors for GSM antennas. On ECOTEL®isbnz-1, the left jack
is Ant 1 and the right jack is Ant 2.

For additional information, see:
—= 9.4 Antennas

SIM 1, SIM 2
In ECOTEL®ispnz-1: Slots for SIM cards.

ECOTEL® VolP/ISDN2-1/ISDN2-2 Edition 3.2-EN — 20060530 Page 273



VIERLING

SIM Slot 1, SIM Slot 2

In ECOTEL®volr, ECOTELispn2-2: Slots for SIM cardholders. See
the following section for more details:

—= 9.5 SIM cardholder installation
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9.3 Interfaces BRI1, BRI2

ECOTEL® is preconfigured to support the following ISDN interface
configurations:

BRI 1: TE/PTP (default setting) or TE/PTMP;
Without 100 Ohm terminating impedance
BRI 2: NT/PTP (default setting) or NT/PTMP;

With 100 Ohm terminating impedance

If an interface is configured in TE mode, then the RJ-45 connector
must be inserted in the corresponding TE jack of the interface. For
NT operations, the ISDN cable is inserted into the NT jack. The
current operating status of ports BRI1 and BRI2 is displayed using
the TE/NT LEDs.

BRI1 BRIZ

1 G
I I R N

'TE

| (40 for NT)

T — 1 [

Interface jacks (BRI)

l@ Note: Some device types have only one single jack per BRI
interface instead of separate NT or TE jacks (e.g.
ECOTEL@/SDNz-z). You will need to use this jack
- along with a crossed cable (gray) in NT mode, or
- along with an uncrossed cable (black) in TE mode.
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l@ Note: Improperly connected ISDN lines cannot damage the
ISDN interfaces. Prerequisite: The ISDN terminal device
that is connected must conform to TBR 3/TBR 3A1.

In rare instances, plug positions can deviate from the schematic
shown here due to faulty wiring. In such a case, the wiring should
be corrected.

Hub function during power outages

If the ECOTEL® controller or the power supply should fail, then
the BRI1 and BRI2 ports are automatically connected with each
other. In the event of failure when utilizing ECOTEL® as a least
cost router (ECOTEL® is connected via the BRI1 port to the fixed
network and via BRI2 to the PBX), the cost-saving function will
fail. However, telephone calls can still be made over this
connection.
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9.3.1 BRI1 connection

In the factory default setting, BRI1 is in the TE PTMP mode. This
connection behaves like an ISDN telephone. In order to test this
connection, it must be connected to an NT port (internal port) of a
PBX or to an NT that is connected to a public network.

l&g Note: If ECOTEL? is connected to the ISDN Bus as the
last device, then the connection plug must be equipped
with two 100 Ohm terminating impedances.

These impedances are used to adapt to the line so that no
reflections or resonances can arise. Without adaptation,
the bit error rate can create considerable interference and
protocol errors.
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Configuring an S0 connection socket with 100 Ohm
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9.3.2 BRI2 connection

The BRI2 connection is set to the NT PTP mode at the factory and
configured with a 100 Ohm terminating impedance. This
connection behaves like an internal port of an ISDN PBX. This
port is suitable for connecting ISDN telephones. Please be aware
that ECOTEL® does not supply power to the terminal devices that
are connected to it. Thus, telephones that are connected must
have their own source of power, e.g. a suitable power supply unit.

Alternatively, devices connected to the bus can be supplied by a
40 V power supply unit (order no. 47591.359) which is available
as an accessory. In this case, the Sy supply is plugged into the TE
jack of the BRI2 connection.
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9.4 Antennas

Depending on the device type, ECOTEL® has either one or two
antenna connectors.

The antennas are not included. You can purchase the antennas
from a dealer. The dealer should also help you to pick the best
antenna for your current installation (depending on the installation
site, the current field strength, frequency etc.). Depending on the
received field strength of the GSM signal, you can use a mini-
antenna, rod antenna or other directional antenna.

Antenna adapters from SNA to FME are included with the device.
This means you can also connect antennas with FME connectors
to ECOTEL®.

Antenna installation

During installation, care must be taken that the antenna base is
grounded (usually the mounting bracket). Grounding improves
antenna reception. At the same time, the antenna is indirectly
protected from the effects of lightening. Lightening which strikes in
the vicinity could otherwise induce very high voltages in the
antenna that would destroy ECOTEL®. If the antenna is installed
directly on a roof, then a surge protector should also be installed.
Information in this regard can be found in the antenna assembly
instructions.

You can determine the current field strength at the installation site
using the configuration software provided for ECOTEL® (Firmware
Tools module).

Antenna connections

In the variant with two GSM modules, connect the antennas to
connectors Ant 1 and Ant 2.

Variants with more than two GSM modules have built-in antenna
splitters which connect a maximum of four GSM modules to the
Ant 1 or Ant 2 connector. Ant 1 supplies GSM modules 1 to 4 and
Ant 2 GSM modules 5 to 8.
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9.5 SIM cardholder installation

To operate the ECOTEL®, you will need SIM cards from one or
more GSM providers in order to be able to route calls and SMS
messages to GSM networks.

Installation types

ECOTEL®isbN2-1 has simple card slots in the housing, each for
one single SIM card.

In ECOTEL®volr and ECOTEL®ispn2-2, several SIM cards are
installed on a PCMCIA SIM cardholder which is then inserted into
one of the cardholder slots (see further below).

If ECOTEL®voir or ECOTEL®ispn2-2 is to be operated using an
external SIM server instead of locally installed SIM cards, a SIM
emulation board must be inserted into the cardholder slot. This
board will connect to the SIM server and emulate the SIM cards
installed there with respect to the ECOTEL®. For further
information, please see:

= 9.5.4 SIM emulation board
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SIM cardholders
l@g Note: This section does not apply to ECOTELIspNnz-1.

The slots for the SIM cardholders are located on the rear of the
housing (SIM slot 1, SIM slot 2).

Press the Eject button to open them.

Slots for SIM cardholders in ECOTEL®VoIP
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Slots for SIM cardholders in ECOTEL®ISDN2-2

In ECOTEL®voip, the SIM cardholder with the SIM cards for GSM
modules 1 to 4 is installed in SIM slot 1 and the SIM cardholder
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with the SIM cards for GSM modules 5 to 8 is installed in SIM slot
2.

In ECOTEL®ISDN2-2, there is one SIM cardholder for each of the
semi-devices which holds the SIM cards for the GSM modules 1
to 4 of this semi-device.

A PCMCIA cardholder can hold up to 32 SIM cards. This means
that it is possible to have up to 8 different SIM cards for each of
the four GSM modules.

The cardholders are not included.

A Y Warning: Since the SIM cards and cardholders are
f_;:i"’ ' 1‘%.‘_ electronic components, they can be damaged or destroyed
# = % by electrostatic discharge. To prevent this, you should

install the SIM cards at an ESD workstation.
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9.5.1 SIMS8 cardholder

The SIM8 cardholder can be fitted with two SIM cards per GSM
channel. To operate ECOTEL®, at least slots 1A and 2A (for the
2-channel ECOTEL® variants) and also 3A and 4A (for the 4-
channel ECOTEL® variants) must be fitted with SIM cards. The
second SIM card can be fitted if you wish to be able to
automatically switch the SIM card for the associated GSM module
during live operation.

The SIM cardholder is labeled as follows:
GSM channel 1: 1A, 1B
GSM channel 2: 2A, 2B
GSM channel 3: 3A, 3B
GSM channel 4: 4A, 4B
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9.5.2 SIM16 cardholder

The SIM16 cardholder can be fitted with four SIM cards for each
GSM channel. Install the SIM cards as follows:

— Fit the cover of the SIM16 cardholder (printed inside and
outside) with the SIM cards (contact surface facing up).

— Place the printed circuit board on the SIM cards and screw
it to the cover.

— Fit the lower part of the SIM16 cardholder (printed inside
only) with the SIM cards (contact surface facing up).

— Screw the pre-mounted unit consisting of the lower part
and the printed circuit board to the lower part.
The SIM cardholder is labeled as follows:
GSM channel 1: 1A, 1B, 1C, 1D
GSM channel 2: 2A, 2B, 2C, 2D
GSM channel 3: 3A, 3B, 3C, 3D
GSM channel 4: 4A, 4B, 4C, 4D
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9.5.3 SIM32 cardholder

The SIM32 cardholder offers eight SIM slots for each GSM
channel The SIM cards are fitted in standard SIM cardholders
which are labeled as follows:

GSM channel 1: 1A, 1B, 1C, 1D, 1E, 1F, 1G, 1H
GSM channel 2: 2A, 2B, 2C, 2D, 2E, 2F, 2G, 2H
GSM channel 3: 3A, 3B, 3C, 3D, 3E, 3F, 3G, 3H
GSM channel 4: 4A, 4B, 4C, 4D, 4E, 4F, 4G, 4H
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9.5.4 SIM emulation board

To operate the SIM emulation board, please make the following
settings in the SIM Management module under SIM Cardholder.

Normal operation: Usage of external SIM cards

Under SIM slot1 and/or SIM slot2 (depending on the
configuration), select the entry SIM emulation board.

Under IP address, enter the IP address of the SIM server on
which the SIM cards to be used are located.

Special case: Usage of the SIM slots on the SIM emulation
board

On the SIM emulation board, there are slots for SIM cards which
can be used, for example, as a temporary replacement for the
SIM server.

ECOTEL® does not use these SIM cards automatically. It must be
configured to do so:

Under SIM slot1 and/or SIM slot2 (depending on the
configuration), select the entry SIM 8 board (not SIM emulation

board!). Configure it like a normal SIM 8 cardholder that only has
slots 1B, 2B, 3B and 4B.
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9.6 Peculiarities of ECOTEL ISDN2-2 and other
models with a dual design

l@ Note: This section applies to the following ECOTEL?
models:
ECOTEL“ISDN2-2xx
ECOTEL“ISDN2-14x

Certain ECOTEL® models (see above) have a different design
that needs to be taken into account. In this manual, we refer to
ECOTELispn2-2 when we need to reference such models.

Two devices in one housing

This design basically involves two ECOTEL® devices in a single
housing.

Almost all of the parts (including the interface jacks) are present in
duplicate (exception: power supply).

s Y Important: When you are setting up and configuring
7 ' £y ECOTEL®isDN2-2, you should always treat it like two
& = %  separate devices!

In particular, you should:
— Create two separate devices in the Service Gear module

— Connect each semi-device separately to the desired
networks (ISDN, PBX, LAN, etc.)

— Configure each semi-device separately via the respective
interface jack

— During any uploads and downloads, make sure that you
are connected to the correct semi-device
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Wiring the BRI interfaces

ECOTEL®isbnz2-2 has only one type of jack for the BRI1 and BRI2
interfaces. A distinction between TE jack and NT jack is realized
alternatively using different connecting cables.

Use the following connecting cables:

— Foruse as a TE jack:
Uncrossed cable (black)

— For use as an NT jack:
Crossed cable (gray)
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10 Technical Details
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10.1 Wave files for speech announcements

This table lists the file names and contents of all available WAVE
files for voice announcements in ECOTEL®.

The prefix XXX in the file name stands for the country code. Files
in different languages with the same content have the same
number but different prefixes. Files with the SYS prefix are
common to all languages.

If ECOTEL® needs a certain wave file, it will first look for the file
with the country code for the currently set language. If it does not
find this file, then it will use the SYS variant instead if it exists.

The letter a stands for A-Law coding.

DTMF tones 1000 ms

SYS000a.wav DTMF D (1000 ms)
SYS001a.wav DTMF 1 (1000 ms)
SYS002a.wav DTMF 2 (1000 ms)
SYS003a.wav DTMF 3 (1000 ms)
SYS004a.wav DTMF 4 (1000 ms)
SYS005a.wav DTMF 5 (1000 ms)
SYS006a.wav DTMF 6 (1000 ms)
SYS007a.wav DTMF 7 (1000 ms)
SYS008a.wav DTMF 8 (1000 ms)
SYS009a.wav DTMF 9 (1000 ms)
SYS010a.wav DTMF 0 (1000 ms)
SYS011a.wav DTMF * (1000 ms)
SYS012a.wav DTMF # (1000 ms)
SYS013a.wav DTMF A (1000 ms)
SYS014a.wav DTMF B (1000 ms)
SYS015a.wav DTMF C (1000 ms)
Tones

ECOTEL® VolP/ISDN2-1/ISDN2-2 Edition 3.2-EN — 20060530 Page 291



VIERLING

SYS016a.wav
SYS017a.wav
SYS018a.wav

Speech phrases

XXX032a.wav
XXX033a.wav
XXX034a.wav
XXX035a.wav
XXX036a.wav
XXX037a.wav
XXX038a.wav
XXX039a.wav
XXX040a.wav
XXX041a.wav
XXX042a.wav
XXX043a.wav
XXX044a.wav
XXX045a.wav
XXX046a.wav
XXX047a.wav
XXX048a.wav
XXX049a.wav
XXX050a.wav
XXX051a.wav
XXX052a.wav
XXX053a.wav
XXX054a.wav
XXX055a.wav
XXX056a.wav
XXX057a.wav
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Sinewave 425 Hz Dial tone
Sinewave 425 Hz Busy signal
Sinewave sweep 300 -3400 Hz

The phone number in memory location
is

has been deleted

Number

Memory number

The number is busy

If you want another extension, please dial
The call is completed

This is mobile number

Please enter the extension

The entry is confirmed

The entry is wrong

Alarm

Please wait

Please wait for a connection
The call could not be completed
Zero

One

Two

Three

Four

Five

Six

Seven

Eight

Nine
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Pauses etc.

SYS064a.wav Pause 1 s

XXX065a.wav Pause 1.5 s + This is mobile number
SYS066a.wav Hold music during call hold

DTMF tones 100 ms

SYS112a.wav DTMF D
SYS113a.wav DTMF 1
SYS114a.wav DTMF 2
SYS115a.wav DTMF 3
SYS116a.wav DTMF 4
SYS117a.wav DTMF 5
SYS118a.wav DTMF 6
SYS119a.wav DTMF 7
SYS120a.wav DTMF 8
SYS121a.wav DTMF 9
SYS122a.wav DTMF 0
SYS123a.wav DTMF *
SYS124a.wav DTMF #
SYS125a.wav DTMF A
SYS126a.wav DTMF B
SYS127a.wav DTMF C
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10.2 Package contents

10.2.1 Package contents ECOTEL VolP

Number / Name
1 ECOTEL®VolP

Article no.
70469.xxx
(depending on
type)

1 power supply unit 90-230 V AC/ 15V DC, 47591.586

max. 30 VA

FME/SMA antenna adapter: 47560.915

1 x for ECOTEL®VolP-14y

2 x for ECOTEL®VolP-12y, -16y and -18y

(see bottom of housing for name plate)

1 USB cable 45816.118

2 ISDN cables (not crossed) 45816.075

1 set of safety instructions, German/English 70469.201,
70469.201/20

1 Quick Start Guide, German/English 70469.204,
70469.204/20

1 CD-ROM ECOTEL®VolP/ISDN2-2 70469.901
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10.2.2 Package contents ECOTEL ISDN2-1

Number / Name Article no.

1 ECOTEL®ISDN2-1 70459.xxx
(depending on
type)

1 power supply unit 90-230 V AC/ 15V DC, 47591.499

max. 15 VA

FME/SMA antenna adapter: 47560.915

1 x for ECOTEL®ISDN2-11y, -14y
2 x for ECOTEL®isbN2-12y
(see bottom of housing for name plate)

2 ISDN cables, black (not crossed) 45816.075

2 ISDN cables, gray (crossed): 45816.076

Only with ECOTEL "ispN2-14y

1 set of safety instructions, German/English 70469.201,
70469.201/20

1 CD-ROM ECOTEL®isDN2-1 70459.909
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10.2.3 Package contents ECOTEL ISDN2-2

Number / Name Article no.

1 ECOTEL®IsDN2-2 70469.xxx
(depending on
type)

1 power supply unit 90-230 V AC/ 15V DC, 47591.586

max. 30 VA

2 FME/SMA antenna adapters 47560.915

1 USB cable 45816.118

2 ISDN cables black (not crossed) 45816.075

2 ISDN cables gray (crossed) 45816.076

1 set of safety instructions, German/English 70469.203,
70469.203/20

1 CD-ROM ECOTEL®VolP/iSDN2-2 70469.901
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10.3.1 Spare parts / Accessories ECOTEL VolP

ltem

Power supply unit for ECOTEL®volp
90-230 VAC /15V DC, max. 30 VA

Connecting cable for Sp bus, not crossed
USB connecting cable

Stationary antenna

Rod antenna

Mini-antenna

SMA-FME Adapter

Surge protector for antenna installation
SIM8 cardholder

SIM16 cardholder

SIM32 cardholder

Power supply unit for telephones,
230 VAC/40V DC 100 mA

CD-ROM ECOTEL®VolP/ISDN2-2

ECOTEL® VolP/ISDN2-1/ISDN2-2

Order no.

47591.586

45816.075
45816.118
47560.004
47560.010
70459.111
47560.915
47560.939
70461.402
70461.405
70461.408

47591.388
70469.901
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10.3.2 Spare parts / Accessories ECOTEL ISDN2-1

Iltem Order no.
Power supply unit for ECOTEL®volp 47591.499
90-230 VAC/15V DC, max. 15 VA

Connecting cable for Sp bus, not crossed 45816.075
Connecting cable for Sp bus, crossed 45816.076
Stationary antenna 47560.004
Rod antenna 47560.010
Mini-antenna 70459.111

SMA-FME Adapter 47560.915
Surge protector for antenna installation 47560.939
o supps o lephonas
CD-ROM ECOTEL®ISDN2-1 70459.909
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10.3.3 Spare parts / Accessories ECOTEL ISDN2-2

ltem

Power supply unit for ECOTEL®IsDN2-2
90-230 VAC/15V DC, max. 30 VA

Connecting cable for Sp bus, not crossed
Connecting cable for Sp bus, crossed
USB connecting cable

Stationary antenna

Rod antenna

Mini-antenna

SMA-FME Adapter

Surge protector for antenna installation
SIM8 cardholder

SIM16 cardholder

SIM32 cardholder

CD-ROM ECOTEL®volP/ISDN2-2

ECOTEL® VolP/ISDN2-1/ISDN2-2

Order no.

47591.586

45816.075
45816.076
45816.118
47560.004
47560.010
70459.111
47560.915
47560.939
70461.402
70461.405
70461.408
70469.901
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10.4 Specifications

Dimensions
Height x Width x Depth: 220 mm x 160 mm x 60 mm

Weight

ECOTEL®VolP with 2 GSM channels Approx. 850¢g
ECOTEL®VolP with 4 GSM channels Approx. 1000 g
ECOTEL®VolP with 6 GSM channels Approx. 1150 g
ECOTEL®VolP with 8 GSM channels Approx. 1200 g

ECOTEL®isbN2-1 with 1 GSM channel  Approx. 600 g
ECOTEL®IsDN2-1 with 2 GSM channels Approx. 1060 g

ECOTEL®IspN2-2 with 8 GSM channels  Approx. 1100 g

Power supply

Power supply unit: 230 VAC 50 Hz; 15V DC
Power consumption ECOTEL®volp: max. 30 VA

Power consumption ECOTEL®isDN2-1:  max. 15 VA

Power consumption ECOTEL®isbN22:  max. 30 VA

Power cable: 1.5m

Ambient conditions

Operating temperature: +5°C ... +440°C
Storage temperature: 0°C ... +70°C
Humidity: Non-condensing, 0 ... 95%
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10.5 Maintenance and Warranty

ECOTEL® is maintenance free. Should any problems occur,
please contact your sales representative.

The warranty period is 24 months.

Repairs will be made within the warranty period without charge
unless the device has been improperly operated.
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10.6 Conditions for using the software

Utilization rights: Program

With this software copy, VIERLING grants to you, as customer, utilization
rights that are both non-assignable and non-exclusive and that do not
expire. These stipulations also apply to any program changes or program
extensions that may become necessary.

Utilization rights in this context mean:

The user may utilize this software on any available hardware. However, if
the user changes the hardware being used, then the software in it must
be deleted and removed.

Simultaneously storing the software, either electronically or physically, or
using the software in more than one hardware device, is expressly
prohibited. If the user desires to utilize the software simultaneously in
several hardware configurations (for example among several employees),
then it is necessary to purchase the corresponding number of program
packages.

Utilization rights: User manual and operating instructions

All rights to the user manual and operating instructions, and in particular
photo-technical reproduction rights, remain the property of VIERLING.
Liability

VIERLING is not liable for any damages, either direct or indirect, whether

material or immaterial, that result from using this program, or from using
the user manual or operating instructions.

Liability for data loss and for resulting damages is excluded within lawful
limitations.

Changes

Any changes to these conditions and any collateral agreements must be
in writing in order to be valid.

Ebermannstadt, 17.06.2005
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